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1. Introduction

1.      Introduction

Welcome to the mc²56 MKII Technical Manual.

About this Manual

This document describes the installation, configuration and maintenance of the mc²56 MKII. The specification is

valid for mc2 Version 5.14.0.x.

For more on operation, please see the "mc²56 MKII Operators Manual". All Lawo manuals are available from the
Download-Center at www.lawo.com (after Login).

Look out for the following which indicate:

Notes - points of clarification.

Tips - useful tips and short cuts.

WARNINGS: Alert you when an action should always be observed.

Utility Software

A number of utility applications are packaged with the software release for your product. These include AdminHD
which can be used to edit the system configuration and for remote diagnostics.

In addition, the mxGUI installer is free to download from the Lawo website (after Login). Once installed, you can
launch the following applications:

· mxGUI - for offline setup or remote operation.

· CFCard Creator - to create backup CF Cards for the control system and, in a console, the bay server(s).

· mxUpdater - to update the software of the mc2/Nova control system, or backup and restore user data.

mxGUI is described in the "mc²56 MKII Operators Manual". 

AdminHD, mxUpdater and CF Cards are described later in this manual.

Lawo User Registration

For access to the Download-Center and to receive regular product updates, please register at:

www.lawo.com/user-registration.

Additional Information

The mc2/nova HTML documentation contains mechanical drawings, data sheets and further information on all
system components. This resource is available from the Download-Center at www.lawo.com (after Login).

We also recommend that you carefully observe the release notes delivered with your system.

http://www.lawo.com
http://www.lawo.com/user-registration
http://www.lawo.com
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2. Important Safety Instructions

2.      Important Safety Instructions

General Safety

Exposure to excessive sound pressure levels can lead to impaired hearing and cause damage to the ear.

Please read and observe ALL of the following notes:

· Check all of the hardware devices for transport damage. 

· Any devices showing signs of mechanical damage or damage from the spillage of liquids MUST NOT
be connected to the mains supply or disconnected from the mains immediately by pulling out the
power lead.

· All devices MUST be grounded. Grounding connectors are provided on all devices. In addition, all low-
voltage devices external to the system must also be grounded before operation.

· For Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from
being grounded through Ethernet or other signal connections.

· Do NOT use the system at extreme temperatures - observe the temperature range and humidity
specified in the installation instructions.

· Do NOT expose devices to liquids which may drip or splash. 

· Do NOT place objects filled with liquids, such as vases, upon a device.

· Only service staff may replace batteries.

· CAUTION: Danger of explosion if battery is incorrectly replaced - Replace only with the same or
equivalent type.

Servicing of components inside a device MUST only be carried out by qualified service personnel according to
the following guidelines:

· Before removing parts of the casing, shields, etc. the device MUST be switched off and disconnected
from all mains.

· Before opening a device, the power supply capacitor MUST be discharged with a suitable resistor.

· Components that carry heavy electrical loads, such as power transistors and resistors, should NOT
be touched until cool to avoid burns.

Servicing unprotected powered devices may only be carried out by qualified service personnel at their own
risk. The following instructions MUST be observed:

· NEVER touch bare wires or circuitry.

· Use insulated tools ONLY.

· DO NOT touch metal semi-conductor casings as they can bear high voltages.

Eye Safety

This equipment may use Class 1 Laser products which emit invisible laser radiation that may lead to eye
injury.

· NEVER look directly into optical components or optical fibre cables.

· Fit protection caps to close any unused optical components.

· Connect all optical fibre cables BEFORE turning on the equipment.
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2. Important Safety Instructions

Defective Parts/Modules

mc²56 MKII contains no user-serviceable parts. Therefore DO NOT open the devices other than to perform the
procedures described in this manual.

In the event of a hardware defect, please send the system component to your local service representative
together with a detailed description of the fault. We would like to remind you to please check carefully
whether the failure is caused by erroneous configuration, operation or connection before sending parts for
repair. Please contact our service department before sending parts for repair.

First Aid (in the case of electric shock)

DO NOT touch the person or his/her clothing before power is turned off, otherwise you risk sustaining an
electric shock yourself.

Separate the person as quickly as possible from the electric power source as follows:

· Switch off the equipment.

· Unplug or disconnect the mains cable.

· Move the person away from the power source by using dry insulating material (such as wood or
plastic).

If the person is unconscious:

· Check their pulse and reanimate if their respiration is poor.

· Lay the body down and turn it to one side. Call for a doctor immediately.

Having sustained an electric shock, ALWAYS consult a doctor.



mc²56 MKII Technical Manual Version: 5.14.0/1 7/298

3. The Hardware

3.      The Hardware

This chapter describes the hardware including all options and accessories.

Topics include:

· System Components

· The Control Surface

· Nova73

· Remote IO Devices

· DALLIS

· Compact IO

· Virtual Devices

· Remote Control Devices & Protocols

· Recording Com Kit
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3. The Hardware

3.1 System Components

A complete system consists of the following hardware components:

· Control Surface (essential) - available in a range of frame sizes.

· Nova73 (essential) - fitted with plug-in Router, DSP and IO Modules.

· Remote IO (optional) - providing further IO breakouts. Options include DALLIS, Compact IO and "Virtual
Devices" such as Lawo's A__line.

Each Remote IO device connects to the Nova73 via either MADI or RAVENNA. Note that not all devices support
both connection types. These interconnects carry audio + control, thereby providing remote adjustment of IO
parameters from the console. To interface third-party IO devices, you can configure MADI, RAVENNA/AES67 or
DANTE Tie-Lines. In this instance the connection to the Nova73 carries audio only.

The Nova73 Router Module includes two TCP/IP Ethernet ports which carry control system data:

· ETHERNET A always connects to the control surface (directly). 

· ETHERNET B connects to the Control System Network. 

By connecting devices to the Control System Network you can remotely operate, configure or maintain the
system. Operational tools include mxGUI and the Lawo Remote App. System configuration is handled by
AdminHD. Diagnostic tools include the Web Browser Interface. A range of TCP/IP protocols are also supported to
provide further integration with other devices. Protocols include Lawo's Remote MNOPL, ROSS Audio Protocol,
Ember+ and RTP MIDI.

Two identical control surfaces can connect to the same Nova73, to allow mixing from two different locations.
See Installing a Mirror Desk.

Control surfaces of different sizes/types cannot share the same Nova73. However, multiple systems can be
networked to share IO resources. See Networking Multiple Systems.

This document describes the control surface, Nova73, DALLIS and Compact IO. It also covers AdminHD and the
Web Browser Interface.

For information on mxGUI or the Lawo Remote App, please refer to your Operator's Manual. 

For information on other options, such as Lawo's A__line, refer to the separate manuals for those products.
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3. The Hardware

3.2 The Control Surface

The control surface comes in a range of predetermined frame sizes scaling from 16 up to 80 faders. The frame
includes built-in local IO and dual redundant power supplies. The frame is fitted with low noise fans which are
usually switched off. They will switch on automatically if the temperature inside the frame exceeds 30° C.

3.2.1 Frame Variants

The predetermined frame options are shown below. Each 16-fader channel bay adds 560mm to the width of the
console. Note that you cannot vary the layout and so the position of the centre section is as shown.

A frame can be expanded by adding 16-fader stand-alone extenders (up to the maximum of 80 faders).

mc256 Standard Frame Options

Note that the dimensions of the XC and XT frames are identical to those shown above. However, the weights vary
due to the different fader panels.

For more on dimensions, weights and mechanical drawings, see the HTML documentation.

For a list of the standard frame part numbers, see the Part Numbers appendix.
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3. The Hardware

3.2.2 Mounting Options

Each frame can be ordered for either Studio or OB-Van (Mobile) mounting.

The Studio version comes with wider side panels and is ready for table-top mounting. Optionally, you can order
the console stand (for a free-standing frame).

The OB-Van version is fitted with narrow aluminum side plates and is designed for crossbar mounting (i.e. no feet
or legs are supplied).

Option Part Number

Studio Side Panels 959/30

OB Van Side Panels 959/31

Console Stand 959/32
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3. The Hardware

3.2.3 Channel Bay Controls

As standard, each channel bay is fitted with the following control panels:

1 x Channel Display (958/13)

A high resolution, touch-screen TFT display.

1 x Fader Panel (958/10)

with 16 x 100mm motorised faders and 48 rotary encoders.

All faders and rotary encoders are touch-sensitive.

Internally, each bay is fitted with an Ethernet Bay Server (mounted behind the Channel Display). Its "Address"
determines the channel bay index (i.e. which bay controls faders 1-16, 17-32, etc).
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3. The Hardware

XC Consoles

Optionally, the 958/10 can be replaced by the Fader Panel 4FC (958/12) globally across the surface. The 958/12
provides extra rotary controls at the expense of the BANK / ISO BAY switching (which move to the touch-
screen). 

Fader Panel 4FC (958/12)

with 16 x 100mm motorised faders and 80 rotary encoders.

Note that the 958/12 must be fitted to all channel bays of the console; you cannot mix the 958/10 and 958/12
within the same surface. This option is supported from version 5.8 software onwards.

Dual-Fader Bays (XT)

Optionally, the Fader Panel Dual Faders (958/11) can be fitted to any channel bay within either a standard or XC
surface. The 958/11 provides a second row of faders at the expense of the Free Controls, and BANK / ISO BAY
switching (which move to the touch-screen).

Fader Panel Dual-Faders (958/11)

with 16 x 100mm motorised faders, 16 x 60mm motorised faders
and 16 rotary encoders.

Note that the 958/11 can be fitted to individual bays as required, allowing you to combine single and dual-fader
bays within the same surface. This option is supported from version 5.8 software onwards. 
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3. The Hardware

The graphics below compare all the three different fader panels:

Standard (958/10) XC (958/12) Dual-faders, XT (958/11)

Further Information

You can find more information about the individual panels in their data sheets.
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3. The Hardware

3.2.4 Centre Section Controls

The centre section is fitted with the following control panels:

1 x Channel Display (958/13)

Identical to the ones used in the channel bays.

Overbridge Options

Space is available on the right of the overbridge to
fit either RTW metering and/or a Lawo User
Panel. The options are described later.

Unless otherwise specified, the console ships
with a blanking panel (958/90).

1 x Central Panel (958/20)

with 16 x 100mm motorised faders.

All faders and rotary encoders are touch-sensitive.

Internally, the bay is fitted with an Ethernet Bay Server (mounted behind the Channel Display). Its "Function"
defines the display's mode of operation: Channel or Central GUI.

Further Information

You can find more information about the individual panels in their data sheets.
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3. The Hardware

3.2.5 Overbridge Options

Space is available in the Overbridge to fit either RTW metering (shown above) and/or a Lawo User Panel. 

The permitted variations are:

Part Number RTW User Panel Fitted

958/90 No No Blank Panel

958/91 Yes No TM 9 (shown above)

958/92 Yes Yes TM 7 + User Panel

958/93 No Yes Blank Panel + User Panel

When the RTW TM7 or TM9 are fitted, they connect to the AES3 In/Out 5-8 of the local IO.

The default configuration usually sets the RTW to automatically follow the CRM 1 monitor source selector.

The Overbridge User Panel options are as follows. A drawing of each panel is included on the next page.

Part Number User Panel Description

962/29 REVEAL FADER 5 dedicated faders for revealing surround slaves.

962/14 USER KEYS 40 user buttons configured from the Custom Functions display.

962/16 INTERCOM integrated loudspeaker and internal talkback microphone.

962/18 AUTOMATION timecode automation controls.

962/15 USER CONTROLS 8 rotary controls defined by the factory configuration.
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REVEAL FADER USER KEYS

INTERCOM AUTOMATION

USER CONTROLS
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3. The Hardware

3.2.6 Front Buffer Connections

The following connections can be found on the front buffer (beneath the trackball):

1 x ETH A Network Port

Connects to the ETHERNET A "internal" network.

4 x USB 2.0 Ports

· 3 x USB - connect to the Lawo control system. The ports can be used to connect a USB memory stick
(to save and load user data).

· 1 x USB (marked RTW) - connects to the TM7 or TM9 meter if fitted. Please refer to the RTW user
manual.

1 x Stereo Phones (HP 1)

This stereo phones output can be used to connect a pair of stereo headphones. The socket is wired from the
Headphone 1 output which, by default, follows the CRM 1 source selector.

1 x Stereo Phones (HP 2)

A second stereo phones socket (Headphone 2) can be found further along the arm rest. By default, this is follows
the CRM 2 source selector.

2 x Stereo Phones (HP 3 & HP 4)

On larger frames, two additional phones connectors operate in parallel with Headphones 1 & 2.
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3. The Hardware

3.2.7 Local IO

Every control surface includes built-in IO known as the "Local IO". This is designed for local connections such as
loudspeakers, metering, talkback and headphones. The local IO frame is located inside the control surface
(beneath the centre section). All connectors are accessed from the console's rear panel, except for the
headphones which breakout on the front buffer.

The local IO provides 16 x Line in, 16 x Line out, 8 x AES3 IO, 2 x Phones, 8 x GPI and 8 x GPO for connection
to external devices. Line out 1-8 are usually reserved for console monitoring. If the RTW TM7 or TM9 overbridge
options are fitted, then they connect via AES3 In/Out 5-8.

There is also either 1 x RAVENNA or 1 x MADI (AES10) interface, specified at the time of order. This connects
the local IO to the Nova73. You will need to reserve one RAVENNA, or one MADI, port in the Nova73 for this
connection. A RAVENNA interconnect can operate as either RAVENNA Link or RAVENNA Net (as defined by
AdminHD).

Users can make connections to and from the local IO signals using the Signal List display (on the Central GUI).
The location and naming of the signals is defined by AdminHD. Note that it is possible to protect certain Local IO
connections - for example, to prevent users from changing the routing to the loudspeakers! GPIOs can also be
addressed from the Custom Functions and/or Command Triggers displays.

Local IO Connections

Console Rear Panel

The following can be used connect external audio and GPIO devices:

· 16 x Line IN - wired to 2 x 37-pin, D-type (female).

· 16 x Line OUT - wired to 8 x XLR (male) + 1 x 37-pin, D-type (male).

· 8 x AES3 In - wired to 2 x 15-pin, D-type (female).

· 8 x AES3 Out - wired to 4 x XLR (male) + 1 x 15-pin, D-type (male).

· 8 x GPIO - wired to 2 x 25-pin, D-type (female).

Either the MADI or RAVENNA port should be used to connect the local IO to the Nova73.

Note that:

· The TBK connector provides a line level output from the integrated talkback mic preamp. See Configuring
Talkback.

· By default, Line IN 16 is fed from the integrated talkback mic preamp (according to the Local IO board
jumper switch positions). 

· By default, Line OUT 1-8 are routed from the CRM 1 monitor output.

· AES3 IN 5-8 and AES3 OUT 5-8 connect to the RTW meter in the Overbridge (if a meter is fitted).

· You will find the two stereo headphone sockets on the console's front buffer.

See Local IO Wiring for pin-outs and jumper switch positions.
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Connecting the Local IO to the Nova73

The local IO board is available in two versions which affects how the board connects to the Nova73.

Option Part Number Connector Type

Local IO (RAVENNA) 958-50 CAT5, RJ45

Local IO (MADI) 958-55 Optical, SC

Depending on the board type, you will need to reserve either one MADI, or one RAVENNA, port in the Nova73 for
the local IO.

If you choose a RAVENNA interconnect, then this can operate as either RAVENNA Link or RAVENNA Net (as
defined by AdminHD).

Note that both ports, RAVENNA and MADI, are always present on the console rear connector panel. However,
only one of the ports will be active depending on the internal board type!

Wiring the Connections

When using MADI or RAVENNA Link, the connection to the Nova73 IO port must be directly wired.

When using RAVENNA Net, the connection to the Nova73 IO port must be made via the streaming network.

In each case, the physical connections must match the AdminHD configuration.

Note that redundancy is not supported (as there is only one active interface); in the event of a link failure, you will
lose the connection to the local IO.
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3.2.8 Control Surface Internal Wiring

Within each channel and central bay, individual panels and displays connect to an Ethernet Bay Server (mounted
behind the display). Control surface panels connect via USB. Channel Displays (including the Central GUI)
connect via LVDS for high resolution graphics and USB for touch control.

Each individual Bay Server connects to an Ethernet switch (mounted inside the main frame). The network
connections from switch appear on the rear panel as ETHERNET A. 

By fitting a second Router Module to the Nova73, you can run two ETHERNET A connections between the
Nova73 and control surface. The operator will then be presented with an error message should the active
connection fail, and decide whether they wish to switch to the redundant connection/module.

Internally, point-to-point connections provide fault tolerance, and allow any bay or panel to be isolated from the
rest of the console. This allows panels and displays to be replaced during operation.
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3. The Hardware

3.2.9 Control Surface Accessories

Included

The following items are included with the control surface. You will find them in the "Accessories" box:

· 1 x dust-cover - to protect the console when not in use.

· 1 x tool case + tools - for performing service procedures.

· 1 x USB memory card - containing the latest software and configuration files.

· 1 x USB keyboard - to be installed as the console keyboard.

· 2* x 2m IEC power cable (country-specific) - to connect mains power to the frame.

*For larger control surfaces, fitted with more than one set of PSUs, additional IEC power cables will be supplied.

Optional

The following accessories must be ordered separately:

· Console Stand (959/32): 2 x detachable legs + mounting plates - to mount the frame.

· Removable Script Tray (959/41).

· Recording Com Kit (958/80) - to provide Sony 9-pin (P2), LTC and MIDI ports.
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3.3 Nova73

The Nova73 forms the "heart" of the system and is fitted with plug-in Router, DSP and IO modules. It exists in its
own right as a routing matrix, and can operate stand-alone or as part of a networked installation.

3.3.1 Frame Variants

The Nova73 is available in two frame sizes - Nova73 HD (10RU) and Nova73 Compact (7RU):

Nova73 HD (10RU) Nova73 Compact (7RU)

Operationally, the two cores are identical, and share the same plug-in Router, DSP and IO modules.

To achieve its smaller footprint, the Nova73 Compact utilizes a different frame (980/06), which is fitted with
different PSUs (980/27) and fan units (980/28). Due to the mounting of the PSUs, there are less slots available for
DSP and IO modules. Thus, the maximum amount of DSP resource and routing matrix capacity are reduced.

The table below summarizes the key features and differences.

Nova73 HD Nova73 Compact

Width 19”, 483mm (front plate), 440mm (chassis)

Height 10RU 7RU

Weight 16.25 Kg (one PSU fitted) 14.5 Kg (two PSUs fitted)

Depth 510mm 489mm

Max. number of DSP + IO Modules 16

(8k2 capacity router at 48kHz)

10

(5k2 capacity router at 48kHz)

Max. number of DSP Modules 8 5

Max. number of AES Modules 8 2 (fitted in slots 2 and 6)

Redundant Power Supplies optional standard

Redundant Router Module (980/33) optional optional

Configured using AdminHD Yes Yes
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3.3.2 Controls, Connectors & Indicators

Front View

Nova73 HD Nova73 Compact

 1   Router Module(s) MKII

Two central slots are reserved for the Router Module MKII (980/33). A single module must be installed and
powered for the system to operate. A second module can be fitted for redundancy.

The active Router Module handles both the summing matrix AND the control system.

The summing matrix offers a 8k2 capacity* router at 48kHz, or 4k2 capacity* at 96kHz (*Nova73 HD). The control
system runs on an embedded Linux operating system, and stores both the application software and user data.

Connections to the control system are made via the two TCP/IP Ethernet ports:

· ETHERNET A – connects to the console control surface.

· ETHERNET B – connects to other devices for remote operation, configuration and networking.

 2   DSP & IO Modules

16* slots are available for DSP and/or IO modules. (*The Nova73 Compact supports 10 slots).

The DSP modules define the amount of signal processing resource. Each module can be pre-configured for either
mixing console channels or mxDSP resources (matrix DSP). DSP redundancy can then be defined by operator
(via the DSP Configuration display).

The IO modules define the number and type of audio connections. Options include AES3, MADI,
RAVENNA/AES67 and DANTE. Additional breakouts are realized by connecting partnering devices such as
DALLIS, Compact IO or A__line. 

The Router, DSP and IO modules include an ACTIVE LED. During normal operation, these should blink in
time with each other (at 1Hz). This shows that the module is synchronous to the rest of the system.

 3  PSU 1 & 2

Two slots are available for the power supplies. A single PSU is required for the system to operate. The second
PSU provides redundancy. Note that on the Nova73 HD, the second PSU is optional, while the Nova73
Compact is always installed with two supplies.

To ensure the proper airflow, both PSU slots MUST be occupied when the Nova73 is operational:

· Nova73 HD: if only one PSU is installed, cover the empty slot with a blanking plate (980/21). 

· Nova73 Compact: if a PSU is faulty, leave both units in the frame until a replacement can be fitted.
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For redundancy, it is recommended to connect both PSUs, each to a separate phase of the AC mains circuit.

Each PSU can be switched on and off from the front panel, and includes a status LED. This should illuminate as
soon as mains power is supplied.

The mains connectors include a locking mechanism for security. Please unlock before removing a connector. Be
sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: The Nova73 frame MUST be connected to the mains using the IEC power cables supplied with
the system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

All Router, DSP, IO and PSU modules are hot-pluggable. This allows them to be be replaced without affecting
other parts of the system.

Rear View

Nova73 HD Nova73 Compact

 4   Fans

The frame is actively cooled by five* built-in fans.  (* The Nova73 Compact is fitted with four cooling fans). The
fans can be replaced during operation.

 5   AES3 Connector Panels

If the front of the Nova73 is fitted with AES3 IO modules (of type 981/02 or 981/04), then the signals break out via
rear-mounted connector panels.

On the Nova73 HD, a choice of breakout options are supported: D-type or BNC. Multiple connector panels can be
fitted (up to 8 x D-type or 4 x BNC).

On the Nova73 Compact, 2 x D-type connector panels are fitted as standard.

Note that the position of the rear connector panels determines how the front-mounted AES3 IO modules must be
fitted.
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 6  Sync IN & OUT

The INPUT 1 and INPUT 2 connectors can be used to connect an external sync reference. The inputs are auto-
detecting and accept Wordclock, Video Black Burst (PAL or NTSC) or AES 3-id:

· When running the system referenced to Wordclock, the frequency of the sync source MUST match the
operating sample rate of the system.

· The Nova73 supports only one video format at a time. Therefore, if both inputs are supplied with Video
Black Burst, only signals of the same type can be used (either PAL or NTSC).

The THRU 1 and THRU 2 connectors provide an output of the sync signals connected to INPUT 1 & INPUT 2.
Note that these ports provide a "looped-through" signal, and do NOT follow the system clock selection. 

The WCLK OUT connector provides an output of the current system clock (as defined using the Wordclock
options in the System Settings display).

WARNING: If no further components are connected to the THRU ports, then it is essential to terminate each
port using a 75 Ω resistor. Terminating resistors, designed as BNC connectors are included in the delivery.

A star-like clock distribution, via a distribution amplifier, offers better signal quality and should be preferred to
that of passive daisy chaining.

 7  Alarm & Control Signals

The two 25-pin D-type connectors (GPI 1 & 2) carry various alarm and control signals. The BNC carries the global
alarm (if the global alarm status monitoring is enabled).

 8  CASE

The CASE grounding screw (M4 x 8mm) should be used to ground the frame.
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3.3.3 Nova73 Plug-in Modules

The tables below describe all the plug-in modules supported in this release of software. For more information,
please refer to the module's data sheet available from the Download-Center at www.lawo.com (after Login).

Nova73 Module Options

Not every IO or DSP module can be used in every slot, so it is best to check if the configuration is supported
by AdminHD before fitting the physical modules.

Central Router Modules

980/33 ROUTER MKII Routing matrix (8k² at 48kHz, or 4k² at 96kHz) and integrated control system.

IO Modules

981/02 AES3 + MADI 32 inputs and 32 outputs AES/EBU (via D-type or BNC rear connector panel)

1 port MADI (optical, multi-mode fibre)

981/04 AES3 + MADI 32 inputs and 32 outputs AES/EBU (via D-type or BNC rear connector panel)

4 ports MADI (via SFPs)

981/14 MADI 4 ports MADI (via SFPs)

981/18 MADI 8 ports MADI (via SFPs)

981/31 MADI 2 ports MADI (optical, multi-mode fibre)

981/38 MADI 8 ports MADI (optical, multi-mode fibre)

981/32 MADI 2 double ports MADI, main + redundant (optical, multi-mode fibre)

981/36 MADI 6 double ports MADI, main + redundant (optical, multi-mode fibre)

981/41 MADI 2 ports MADI (optical, single-mode fibre)

981/61 RAVENNA 4 ports RAVENNA (GB Ethernet Cat5/6/7 and SFP option for single or multi-mode
optical fibre)

981/65 DANTE 4 ports DANTE (GB Ethernet Cat5/6/7)

http://www.lawo.com
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DSP Modules

983/03 DSP 48/24 *

983/04 DSP 48/24 *

48/24 DSP channels for the mc2 series mixing consoles: 48 channels at 48kHz; 24
channels at 96kHz. 

The 983/04 is a later revision of the 983/03 supporting identical features.

983/06 DSP IOSONO For project-specific applications.

* The 983/03 (or 04) DSP module can be configured for different applications by changing the AdminHD
configuration and updating the module’s firmware:

· 983/03 DSP 48/24 - DSP channels for the mc2 series mixing consoles (defined by the DSP
Configurations display).

· 983/03-077 mxDSP - DSP paths for the routing matrix (defined by the mxDSP display).

· 983/03-060 DSP WFS (mix), 983/03-061 DSP WFS (filter) and 983/03-062 DSP spatial mixer - for
project-specific applications (must be factory-configured).
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3.3.4 Nova73 Front Slot Allocations

Nova73 HD Nova73 Compact

The diagrams above show the front module slots available within the Nova73:

· Slot A – must be used for the main Router Module.

· Slot B – is reserved for a redundant Router Module. 

· Slots 1-16* – available for DSP or IO modules. (*The Nova73 Compact supports 10 slots).

For details on all possible options, see Nova73 Plug-in Modules.

General Conditions

A single Router Module (980/33) must be fitted to slot A and powered for the system to operate. When fitting a
redundant Router Module, it must be of the same type fitted to slot A.

To ensure efficient cooling, you should spread the modules evenly within the Nova73.

Not every IO or DSP module can be used in every slot, so it is best to check if the configuration is supported
by AdminHD before fitting the physical modules.

Conditions for AES3 Modules

The position of the rear connector panels determines the slot numbers which MUST be used for front-mounted
AES3 modules. Therefore, it is important to fit the rear panels BEFORE front-mounting the AES3 IO. 

In the Nova73 HD, AES3 modules of type 981/02 or 981/04 should be mounted so that they are right-aligned to
the rear connector panel (when viewed from the front of the frame). For example, if the first and second rear
connector panels are D-type and the third is BNC (working from right to left), then the AES3 modules must be
mounted in front slot 2 (D-type1), slot 4 (D-type2) and slot 8 (BNC).

In the Nova73 Compact, AES3 modules MUST be mounted in slots 2 and 6 so that they align to the
corresponding rear connector panels.

If a module has been fitted incorrectly, then you will see its AES3 LOCK 1 LED blink.

Conditions for DSP Modules

DSP modules of type 983/03 or 983/04 should be front-mounted from right to left filling up the odd slots - 15, 13,
11, 9, 7, 5, 3, 1 in the Nova73 HD or 9, 7, 5, 3, 1 in the Nova73 Compact.

Note that the logical numbering of the DSP boards follows the mounting order described above:
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3.3.5 Router Module MKII: LEDs & Switches

The front of the Router Module MKII (980/33) provides the following LEDs and switches:

ACTIVE LED

Illuminates in green (blinking) once the control system is booted and operating correctly.

STANDBY LED

Illuminates in yellow if the module is in standby (redundant). If there are two Router Modules fitted
to the Nova73, then one module will be ACTIVE while the other is in STANDBY.

CHARGE LED

Illuminates when the backup power unit is charging. Off = the unit is fully charged.

ALARM LED

Illuminates in red if the global alarm is active.

SYNC LEDs

These four LEDs provide information about the sync source:

· Green, blinking = this input is the active sync source.

· Green, static = a valid sync signal is connected but the input is not active.

· Off = there is no valid sync signal connected.

PREPARE COLDSTART

Press this recessed button (the LED illuminates) to prepare a cold start. The cold start will occur
following the next power cycle / reboot.

LAMP TEST

Press this recessed button to test all the LED lamps across all the Nova73 modules.

MODULE TAKEOVER 

If you have main and redundant Router Modules fitted to the Nova73, then this button can be used to force a
manual takeover to the redundant module.

ETHERNET A & ETHERNET B

These two TCP/IP Ethernet ports carry control system data:

· ETHERNET A always connects to the control surface (directly). 

· ETHERNET B connects to the Control System Network.

The 100 and 1000 LEDs indicate the speed of the network connection. The ACTIVITY LEDs flash in green when
data is being transferred.

POWER Button (above the Silk Screening)

Press this recessed button to power cycle the Router Module. The button should only be used as a last resort if
all other restart methods fail to work.

Silk Screening

Here you will see the name and part number of the module.
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3.3.6 Nova73 Accessories

Included

The following items are included with the Nova73. You will find them in the "Accessories" box:

· 2 x 2m IEC power cable (country-specific) - to connect mains power to the frame.

· 2 x 75Ω terminating resistors (designed as BNC connectors) - to terminate the Wordclock ports.

· 1 x network switch - to connect the Lawo network.

Optional

All other accessories, such as SFP modules for MADI and/or RAVENNA ports, must be ordered separately.
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3.4 Remote IO Devices

The system supports three types of remote IO device which can connect to the Nova73: DALLIS, Compact IO and
Virtual Devices. In each case, the Nova73 interconnect carries both audio and control, thereby providing remote
adjustment of IO parameters.

DALLIS Compact IO A__line

DALLIS

A modular IO system that can be fitted with a choice of plug-in cards for flexible IO breakouts. DALLIS is available
in two frame sizes: 3RU or 6RU.

Frame size 19" / 3RU or 6RU

Connection to Nova73 RAVENNA Net, RAVENNA Link or MADI

Redundant Power Supplies Yes

Flexible IO Yes, via plug-in IO cards

IO Card Options Mic/Line, Line, AES3, SDI, GPIO, Serial, ADAT, Intercom, Headphones

Compact IO

A self-contained stagebox that comes with a fixed complement of IO.

Frame size 19" / 5RU

Connection to Nova73 RAVENNA Net or RAVENNA Link

Redundant Power Supplies Yes

Flexible IO No, IO configuration is fixed

IO Configuration 32 Mic/Line in, 32 Line out, 8 AES3 in, 8 AES3 out, 8 GPIO, 1 MADI

Virtual Devices

A range of "virtual devices" that connect via RAVENNA Net. Options include the A__mic8, A__dig8, the Lawo
Commentary Unit (LCU) and Neumann DMI-8.

Frame size 19" / 1RU

Connection to Nova73 RAVENNA Net 

Redundant Power Supplies No

Flexible IO No, IO configuration is fixed

IO Configuration: A__mic8 8 Mic/Line in, 4 Line out, 8 GPIO

IO Configuration: A__digital8 8 AES3 in, 4 AES3 out, 8 GPIO
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3.5 DALLIS

DALLIS is Lawo's modular IO system. It is designed for 19" rack-mounting and can be fitted with a choice of plug-
in IO cards. DALLIS can connect to the Nova73 using RAVENNA Net, RAVENNA Link or MADI.

3.5.1 Frame Variants

DALLIS is available in two frame sizes - 3RU or 6RU.

DALLIS 3RU, Perspective DALLIS 6RU, Front View

Operationally, the two frames are identical, and share the same plug-in master boards and IO cards.

The 3RU frame is smaller and ideal for single-width IO cards (4HP), while the 6RU frame is larger and better
equipped for double-width IO cards (8HP).

The table below summarizes the key features and differences.

DALLIS 3RU Frame DALLIS 6RU Frame

Width 19”, 483mm (front plate), 440mm (chassis)

Height 3RU 6RU

Weight 7.15 Kg (without cards) 11 Kg (without cards)

Depth 510mm 510mm

Number of IO Card Slots 18 x single-width (4HP)

Double-width cards occupy two slots

18 x double-width (8HP)

Double-width cards occupy one slot

A slot can be fitted with one single-
width card + blanking plate

Slot19 is reserved for phantom power

Redundant Master Board optional optional

Redundant Power Supplies fitted as standard fitted as standard

Configured using AdminHD Yes Yes
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3.5.2 Controls, Connectors & Indicators

Front View

DALLIS 3RU DALLIS 6RU

 1   Master Board(s)

Two central slots are reserved for the DALLIS master board. A single master board must be installed and powered
for the system to operate. A second can be fitted for redundancy. 

The master board determines how the DALLIS connects to the Nova73, via either MADI or RAVENNA. Note that
the dual format master board (947/22) supports both MADI and RAVENNA; in this instance, the AdminHD
configuration determines which interface is in use.

The Nova73 interconnect determines how many mono audio channels are supported by the DALLIS: up to 60
(MADI) or 128 (RAVENNA).

The connections and status LEDs are described later.

 2   IO Cards

18 slots are available for IO cards, and options include Mic/Line, Line, AES3, SDI, GPIO, Serial, ADAT, Intercom
and Headphones.

Note that slot 19 on the 6RU frame is reserved for Phantom Power.

Every card includes an ACTIVE LED. During normal operation, these should blink in time with each other (at
1Hz). This shows that the card is synchronous to the rest of the system. 

For details on other LEDs, connectors and switches, please refer to the card's data sheet.

The master boards and IO cards are hot-pluggable. This allows them to be be replaced without affecting other
parts of the system.
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Rear View

DALLIS 3RU DALLIS 6RU

 3  PSU 1 & 2

Two internal slots are available for the power supplies. A single PSU is required for the system to operate. The
second PSU provides redundancy. Depending on your system specification, either one or both supplies will be
installed.

There is no on/off switch, and so the DALLIS will boot as soon as mains power is supplied.

For redundancy, it is recommended to connect both PSUs, each to a separate phase of the AC mains circuit. 

The mains connectors include a locking mechanism for security. Please unlock before removing a connector. Be
sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: The DALLIS frame MUST be connected to the mains using the IEC power cables supplied with
the system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

 4  Alarm & Control Signals

The 15-pin D-type connector (ALARM FORCE M2) and two BNCs (FORCE M2 & ALARM) carry the DALLIS local
alarm and other control signals.

 5  CASE

The CASE grounding screw (M4 x 8mm) should be used to ground the frame.
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3.5.3 DALLIS Plug-in Interfaces

The tables below describe all the plug-in master boards and IO cards supported in this release of software. For
more information, please refer to the individual data sheets.

 3RU DALLIS (example configuration)

Not every IO card can be used in every slot, so it is best to check if the configuration is supported by 
AdminHD before fitting the physical cards.

The Nova73 interconnect determines how many mono audio channels are supported by the DALLIS: up to 60
(MADI) or 128 (RAVENNA).

The maximum analog level of the whole system is defined by the DALLIS card with the lowest GDA (General
Device Address) - this is the card with the lowest address fitted to the DALLIS frame connected to the lowest
port number of the first Nova73. (If a different fixed level analog card is fitted elsewhere within the system,
then a warning appears in the log file; however, the card with the lowest GDA still wins.)

DALLIS Master Boards Connects to:

947/05 MADI 1 port MADI (optical, multi-mode fibre) 981/02, 04, 14,
18, 31, 38

947/07 MADI 2 double ports MADI, redundant fibre (optical, multi-mode fibre) 981/32, 36

947/15 MADI 1 port MADI (optical, single-mode fibre) 981/41

947/21 RAVENNA 1 port RAVENNA (GB Ethernet Cat5/6/7 and SFP option for single or
multi-mode optical fibre).

981/61

947/22
MADI/RAVENNA

1 port RAVENNA (GB Ethernet Cat5/6/7 and SFP option for single or
multi-mode optical fibre)

1 port MADI (via SFP)

981/61

981/31, 32, 36,
38, 41
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DALLIS IO Cards Part Number & Connector Type

 Inputs  OutputsAnalog D-type XLR BNC

Mic/Line (trafo-balanced) 941/52 941/62 - 4 mono -

Line in (trafo-balanced) 941/02, 04, 06 941/12, 14, 16 - 4 mono -

Line out (trafo-balanced) 942/02, 04, 06 942/12, 14, 16 - - 4 mono

Mic/Line (elect-balanced) 941/51, 53, 55 - - 8 mono -

Line in (elect-balanced) 941/84, 86 - - 8 mono -

Line in/out (elect-balanced) 941/83, 85 - - 8 mono 8 mono

Line out (elect-balanced) 942/84, 86 - - - 8 mono

DALLIS IO Cards Part Number & Connector Type

 Inputs  OutputsAES3 D-type XLR BNC

AES3 in (SRC) 943/02, 03 943/12, 13 - 4 stereo -

AES3 in (SRC) Hi-Z/Thru 943/01, 84, 85 - - 4 stereo 4 thru

AES3 in/out (SRC in) 943/52, 53 - 943/72, 73 4 stereo 4 stereo

AES3 in/out (SRC in/out) 943/54, 55 - 943/74, 75 4 stereo 4 stereo

AES3 out 944/01, 02 944/11, 12 - - 4 stereo

DALLIS IO Cards

Part Number Description Connector TypeSpecial

Headphones 942/61 4 stereo headphone outputs 1 x D-type

Intercom (Riedel interface) 943/81, 82 4 AES3 in/out 4 x BNC (bi-directional)

Optical Switch 945/61 Optical to BNC change-over
switch for MADI.

2 x BNC: 1 in, 1 out

3 x MT-RJ

ADAT in/out 946/31 8 channel ADAT interface 2 x ADAT: 1 in, 1 out

RAVENNA (Audio over IP) 946/41 8 channel RAVENNA interface. 1 x RJ45 (Ethernet)

1 x SFP (optical fibre)

RAVENNA (Audio over IP) &
MADI

946/42 8 channel RAVENNA interface
plus

64 channel MADI

1 x RJ45 (Ethernet)

1 x SFP (optical fibre)

Phantom Power 947/10 48 V supply for transformer-
balanced Mic/Line cards

n/a

DALLIS IO Cards

Part Number Description  Connector TypeGPI

GPI/Opto Relays 945/01 8 opto-coupler in; 8 relay out 1 x D-type

GPI/Opto/VCA Relays 945/05 8 opto-coupler in; 8 relay out; 4
VCA in

1 x D-type
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DALLIS IO Cards

Part Number Audio de-embedder /
embedder

Connector Type
SDI

3G/HD/SD SDI 946/17 up to 8 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

2 x D-type: metadata

HD/SD SDI

SD SDI

946/13

946/09

up to 4 AES3 in/out (stereo) 4 x BNC: in, thru, 2 out

HD/SD SDI

SDI SDI

946/05

946/01

up to 4 AES3 in/out (stereo) 3 x BNC: in, thru, out

DALLIS IO Cards

Part Number Description Connector TypeDSP

Summing matrix 947/41, 42 8 in/out internal summing matrix
with signal generator

n/a

DALLIS IO Cards

Part Number Description Connector TypeData

RS422 945/21 4 bi-directional data ports for
RS422 

4 x RJ45

Serial Data 945/22 4 bi-directional data ports for
RS232, RS422 or MIDI

4 x RJ45
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3.5.4 DALLIS Front Slot Allocations

DALLIS 3RU Frame

DALLIS 6RU Frame

The dagrams above show the front slot positions available within each DALLIS frame.

Equipping the 3RU Frame

18 single width DALLIS IO card slots are supported. Double width IO cards (8HP) occupy two slots; single width
IO cards (4HP) occupy one slot.

Equipping the 6RU Frame

18 double width DALLIS IO card slots are supported, plus a single width slot reserved for Phantom Power. Double
width IO cards (8HP) occupy the whole slot. Single width IO cards (4HP) must be fitted on the left of the slot, with
a blanking plate fitted to the right to close the gap.

Slot Positions

· Slot M1 – must be used for the main master board.

· Slot M2 – is reserved for a redundant master board.

· Slots 1-18 – are available for IO cards.

· Slot 19 (6RU frame only) – is reserved for the 947/10 Phantom Power card (if required).

For details on all possible options, see DALLIS Plug-in Interfaces.
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Conditions

A single master board must be fitted to slot M1 and powered for the system to operate. When fitting a redundant
master board, it must be of the same type fitted to slot M1.

If are installing the optional Fan Unit, then note that cards 941/53, 945/61, 946/09, 946/13 and 946/17 produce the
most heat and, thus, must not be installed next to each other.

Not every IO card can be used in every slot, so it is best to check if the configuration is supported by 
AdminHD before fitting the physical cards.

The Nova73 interconnect determines how many mono audio channels are supported by the DALLIS: up to 60
(MADI) or 128 (RAVENNA).
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3.5.5 DALLIS Master Board: LEDs & Switches

The DALLIS master board (947/22) provides the following LEDs and switches:

ACTIVE LED

Lights in green (blinking) once the control system is booted and operating correctly.

SYNC OK LED

This LED provides information about the sync source:

· Green, static = the DALLIS is receiving a valid sync signal.

· Green, blinking = the DALLIS control system is locking.

· Off = there is no valid sync signal.

POWER OK LED

This LED provides information about the internal power supplies:

· Green, static = the DALLIS PSUs are operating normally.

· Green, blinking = the operating temperature of a PSU has been exceeded.

· Off = there is a PSU failure.

ALARM OK LED

Illuminates in red (static) if the DALLIS local alarm is active.

SYNC IN/OUT

This BNC port is usually left unconnected, as all external sync reference signals should be
connected to the Nova73 (as described later).

It can be used to connect an external sync reference if the DALLIS is operating as a stand-alone device.

ETH x 2 (RAVENNA)

If using either RAVENNA Link or RAVENNA Net, these two ports should connect the DALLIS to the Nova73. The
connection can be made via copper and/or optical fibre (via SFP). See RAVENNA IO. The LOCK/ERR LED
indicates:

· Green, static = the link is active, and the signal and streaming are ok.

· Red, static or blinking = the link is active but has one of the following errors: streaming format error,
streaming lock error or stream is asynchronous.

· Off = no signal.

MADI

If using MADI, this port should connect the DALLIS to the Nova73. The connection type is flexible depending on
the SFP option. See MADI IO. The LOCK/ERR LED indicates:

· Green = a valid MADI signal is connected.

· Red = MADI link error.

· Off = no signal.

ETH CTRL

This TCP/IP Ethernet port can be used to connect a service computer for configuration and maintenance.

Silk Screening

At the top and bottom of the interface, you will see the name and part number of the master board.

For information on other DALLIS master board types, please refer to the relevant data sheets.
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3.5.6 DALLIS to Nova Interconnects

DALLIS can connect to the Nova73 using MADI, RAVENNA Link or RAVENNA Net. The connection type is
determined firstly by the type of DALLIS master board, and secondly by the AdminHD configuration.

3.5.7 DALLIS Accessories

Included

The following items are included with each DALLIS. You will find them in the "Accessories" box:

· 2 x 2m IEC power cable (country-specific) - to connect mains power to the frame.

· 1 x Cable Duct (940/21) - to organize the cabling.

Optional

The following accessories must be ordered separately:

· Front Plates (940/31 or 940/32) - to close any empty IO card slots.

· Recessed Frame Conversion Kits (940/28 or 940/29) - to recess the DALLIS frame.

· DALLIS Fan Unit (940/20) - to provide forced cooling for up to three 3RU DALLIS frames.
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3.6 Compact IO

The Compact IO is a portable 5RU stagebox. It is delivered as self-contained unit with a fixed complement of IO.
The Compact IO can connect to the Nova73 using either RAVENNA Net or RAVENNA Link.

3.6.1 Controls, Connectors & Indicators

The Compact IO comes in one frame size: 5RU:

 1   IO Breakouts

Each unit provides:

· 32 x Mic/Line In - wired to 32 x XLR (female)

· 32 x Line Out - wired to 32 x XLR (male)

· 8 x AES3 In - wired to 8 x XLR (female)

· 8 x AES3 Out - wired to 8 x XLR (male)

· 8 x GPIO - wired to 1 x 37-pin, D-type (female).

· 1 x 64-channel MADI - available via SFP. To use this port, you must fit a Lawo-certified SFP module.

 2   LINK Port (1 x RAVENNA Interface)

The RAVENNA interface connects the Compact IO to the Nova73. The connection is available on copper or
optical fibre.

 3   Power

The Compact IO is powered by dual-redundant power supplies which are mounted internally within the frame. A
single PSU is required for the system to operate. The second PSU provides redundancy. 

The mains connectors are located at the rear of the frame.

3.6.2 Compact IO to Nova73 Interconnects

The Compact IO can connect to the Nova73 using either RAVENNA Link or RAVENNA Net. The type of
connection is defined by the AdminHD configuration.

3.6.3 Compact IO Accessories

The following items are included with each Compact IO. You will find them in the "Accessories" box:

· 2 x 2m IEC power cable (country-specific) - to connect mains power to the frame.
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3.7 Virtual Devices

This term refers to a special range of IO devices that connect to the Nova73 via RAVENNA Net. Note that a single
RAVENNA Net port can support up to 16 devices.

3.7.1 Supported Products

In the current mc2/Nova release, the following products can be configured as Virtual Devices:

· Lawo A__mic8 - a 19", 1RU unit with 8 Mic/Line in, 4 Line out and 8 GPIO.

· Lawo A__dig8 - a 19", 1RU unit with 8 AES3 in, 4 AES3 out and 8 GPIO.

· Lawo Commentary Unit (LCU) - a table-top commentary unit with 4 mono in and stereo PGM out.

· Neumann DMI-8 - a 19", 1RU unit from Neumann with 8 Mic in.

Lawo A__mic8 & A__dig8 Lawo Commentary Unit (LCU)

For more details on the hardware, please refer to the individual product manuals.

For all devices, the streaming port connections carry audio + control. This allows you to remotely adjust

parameters, such as mic input gain, from the mc2/Nova system. The available parameters and their method of

control is explained in your mc2/Nova Operators Manual.

The streaming connections to and from A__line devices can be configured for redundancy using SMPTE 2022-7
(SPS).

3.7.2 Conditions & Requirements

Each Virtual Device must connect to the Nova73 via RAVENNA Net.

All network components must comply with the RAVENNA data network requirements.

Each Virtual Device must operate at the same sample rate as the mc2/Nova system.

All RAVENNA streaming ports must use static IP addresses and be correctly configured.
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3.8 Remote Control Devices & Protocols

In addition to the main system components, the mc²56 MKII supports a number of remote control options. All
devices must connect to the Control System Network via ETHERNET B:

The options include a range of software-based tools from Lawo and, for integration with non-mc2 or third-party
devices, a number of control protocols.

Lawo Tools & Options

mxGUI - is a free-of-charge application which provides offline setup or remote operation of any mc2/Nova system.

Lawo Remote App - is a free-of-charge app providing remote control of parameters from an iOS device.

Remote Desktop - is a function programmed from the Custom Functions display which can switch any console
TFT to a remote server. This allows you to view and control other applications from the mixing position - for
example: KICK, the Waves plug-in server, an external DAW, etc.

KICK - is a chargeable option designed for automated "close-ball" mixing. The software uses data from an
external graphics tracking system to follow the position of the ball and other points of interest. It then produces an
automatic mix of the close-ball action by controlling the relevant audio channels within the console.

Waves SoundGrid Plug-in Server - is a chargeable option requiring additional hardware. It allows Waves plug-
ins to be controlled directly from the Central GUI and reset by snapshots and productions.

For more information on mxGUI, the Lawo Remote App or Remote Desktop, please refer to your Operator's
Manual. KICK and the Waves SoundGrid Plug-in Server are covered in their own dedicated manuals.

Control Protocols

Remote MNOPL - is Lawo's freely available TCP/IP control protocol. It provides access to virtually any system

parameter. Typically, it can be used to control crosspoints within the mc2/Nova routing matrix from an external
control system, such as VSM, Evertz, Quartz, BFE or Pharos. The configuration is handled by AdminHD, see
Mapping tables.

ROSS Audio Protocol (RAP) - mc2/Nova systems offer native support for the ROSS Audio Protocol. Applications
are similar to Remote MNOPL. RAP must be factory-configured.

Ember+ - is a non-proprietary TCP/IP control protocol, supported by a range of devices including Lawo's radio and
production consoles. Ember+ allows devices to remotely control parameters within the mc²56 MKII, or the mc²56
MKII to control parameters within an external device. For example, to configure virtual control panels using
VisTool MK2. For more information, visit https://github.com/Lawo/ember-plus/wiki.

RTP MIDI - mc2/Nova systems offer native support for RTP MIDI. Applications include using General Purpose
Channels (GPCs) to control an external DAW or Camera Control Unit (CCU). Or, triggering MIDI event changes
from a console command. The configuration is handled by .tcl files and the Command Triggers display.

https://github.com/Lawo/ember-plus/wiki
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3.9 Recording Com Kit

The optional Recording Com Kit provides Sony 9pin (P2), LTC and MIDI ports to connect an external playback
device.

Machine control functions can be mapped onto user buttons from the Central GUI's Custom Functions display,
or handled from the optional machine control panel, mounted externally from the console. 

Option Part Number

Recording Com Kit (P2, LTC, MIDI) 958-80

For details on how to install the kit, please see the separate Technical Documentation "TD 958/80 Rec Com Kit", 
available from the Download-Center at www.lawo.com (after Login).

Note that, from Version 5.4, mc2 systems support native RTP MIDI (MIDI over Ethernet). Thus, control of up to 32
channels (four conventional MIDI devices) can be achieved using an Ethernet connection to the Lawo network.
RTP MIDI support is native within MAC computers and can be achieved on PCs using dedicated software tools.
Note that the Recording Com Kit is still required for Sony 9pin and LTC connections.

http://www.lawo.com
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4.      Redundancy Features

This chapter describes the redundancy features of the system.

Topics include:

· Star2 Technology

· Link & Port Redundancy

· DSP Redundancy

· Redundant Power Supplies

· Redundant Router Module

· The Control System

· Updating a Redundant System

· SMPTE 2022-7 Seamless Protection Switching (SPS)
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4.1 Star2 Technology

All components within the system utilise Lawo’s Star2 technology:

· Point-to-point connections – internal point-to-point connections ensure that a fault only affects that part
of the system, unlike a TDM bus architecture where a fault may disrupt everything connected to the bus.

· Dual star topology – with redundant Router Modules fitted to the Nova73 and redundant Master Boards
in every DALLIS, components can connect in a dual ‘star’ mode. This protects signal paths from any
single point-of-failure. See Link & Port Redundancy.

· Hot-swappable Modules/Cards – every plug-in module can be hot-swapped without affecting the rest of
the system enabling online maintenance of the system.

· Redundant Power Supply Units – dual redundant power supplies allow components to withstand a
PSU or mains connection failure.

· Passive backplanes – the frame backplanes are entirely passive. With no active components, this
increases reliability.



mc²56 MKII Technical ManualVersion: 5.14.0/148/298

4. Redundancy Features

4.2 Link & Port Redundancy

For crucial interconnections between the Nova73 and a DALLIS you can specify either link, or link and port,
redundancy:

· Link Redundancy – two physical connections (MADI or RAVENNA) are made from the DALLIS master
board to the Nova73 IO module. If the active link fails, then the redundant link ensures an automatic
recovery. 

· Port Redundancy - two master boards are fitted to each DALLIS, and connect to different Nova73 IO
ports (preferably on a different module). Port redundancy provides automatic recovery from a:

o Failure of the active physical link (MADI or RAVENNA).

o Malfunction of the active DALLIS master board.

o Malfunction of the Nova73 IO module.

Ø  To specify Link Redundancy:

MADI - order a double-port Nova73 module and DALLIS master board for each connection.

RAVENNA - install both the copper and fibre optic connections from the Nova73 IO module and DALLIS master
board.

Ø  To specify Port Redundancy:

MADI or RAVENNA - order two master boards per DALLIS plus enough single-port Nova73 IO modules to support
the connections. You can decide which ports are used for the main and redundant connections using AdminHD.
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4.3 DSP Redundancy

One or more DSP boards can be reserved to provide redundant processing in the event of a DSP board failure.
The allocation occurs automatically depending on the active DSP configuration. For example, if the system is
fitted with 4 DSP boards and the Active configuration uses only 2, then there will be 2 redundant DSP boards:

DSP Configuration Display

On a Nova73, you can see this by looking at the front panel. The STANDBY LED lights (yellow) on all redundant
DSP boards, while the ACTIVE LED lights (green, blinking) on all active DSP boards.

Note that in a Nova73, the DSP boards are utilized from right to left across the front of the unit. So if board 8 is
redundant, it is the DSP board on the left of the core (when viewed from the front). 

In the unlikely event of a DSP module failure, the system automatically switches all DSP resources and settings
from the faulty board to the spare; the faulty board can then be removed and replaced. 

Once the replacement is fitted, it will act as the spare board until either the system is restarted or a new DSP
configuration is loaded. The boards are then reset to their default mode of operation - for example, slots 1 to 7 for
main DSP resources and slot 8 in standby.
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4.4 Redundant Power Supplies

Each of the following components can be fitted with dual-redundant power supplies:

· Control surface frames

· Nova73 HD & Nova73 Compact

· DALLIS

· Compact IO

In all cases, only one PSU is required for operation; the second provides redundancy.

The status of all PSUs can be monitored from the Central GUI, via the status bar for the control surface
frames, and via the Signal Settings display for all other components.
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4.5 Redundant Router Module

By fitting two Router Modules (980/33) to the central slots of the Nova73, the system supports redundancy for
both the routing matrix AND control system.

When the system first boots, the module on the left is active, while the module on the right is redundant. This is
indicated by the ACTIVE and STANDBY LEDs. 

Main & Redundant Router Module LEDs

4.5.1 Automatic Takeover

If the active Router Module fails or there is a control system error, the system will automatically switch to the
redundant Router Module. This ensures a seamless recovery without any interruption to operation. 

Note that there will be a brief interruption to audio, of around 1 second, while routes are reconfigured.

4.5.2 Control Surface Connection Failure

If the ETHERNET A connection between the control surface and Router Module fails, then an automatic takeover
does not occur, as the failure could be deliberate (for example, you may have disconnected the network cable).

Instead the operator is presented with an error message on the Central GUI:

Click on the message - a confirmation pop-up appears:

Select Yes to switch to the redundant Router Module; this will result in a brief interruption to audio (as for an
automatic takeover).

Select No to ignore the error and close the pop-up. In this instance, there will be no interruption to audio, but you
will lose control from the console surface until such time as the missing ETHERNET A connection is re-instated.
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4.5.3 Manual Takeover

The system can be forced to switch to the redundant Router Module using any of the following methods: the
console GUI, the MODULE TAKEOVER button or the ROUTER TAKEOVER contact closure.

Using the console GUI

1. Open the System Settings display and select the Global topic.

2. Click on Redundancy takeover - a confirmation dialogue box appears:

3. Select Yes to confirm or No to cancel the operation. 

If you select Yes, then the system will switch to the redundant Router Module; this will result in a brief
interruption to audio (as for an automatic takeover).

Using the MODULE TAKEOVER Button

1. On the front of the Nova73, identify the redundant Router Module - this is one with the STANDBY LED lit
(yellow).

2. On this module, press the recessed MODULE TAKEOVER button.

The system will switch to the redundant Router Module; a brief interruption to audio will occur while routes are
reconfigured (as above). 

Once the takeover is complete, you will see the ACTIVE and STANDBY LEDs update accordingly.

Using the ROUTER TAKEOVER Contact Closure

A manual takeover can also be forced by triggering a positive edge at the ROUTER TAKEOVER (IN) input of the
Nova73's GPI 1 connector.
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4.6 The Control System

The control system resides on the Router Module MKII (980/33). 

It runs on an embedded Linux operating system for increased speed and
reliability.

Two Compact Flash (CF) cards are included to store the application software
and user data separately. You can create a backup copy of the CF cards so
that they can be replaced if necessary.

Note that the Router Module contains a backup power unit which provides up
to 3 seconds of power (to deal with short interruptions to the AC supply).

CF Card Data Structure

During operation, any errors generated by the control system are stored in the message logfile. This can be
copied to USB via the File display, or monitored remotely via the Web Browser Interface.
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4.7 Updating a Redundant System

For redundancy to work, both main and redundant control systems must hold identical information and mirror
each other. 

User data (productions and warm start data) is mirrored at all times. However, the cold start configuration and
system software are only synchronized when the control system boots up. This has implications if you wish to
upload a new AdminHD configuration or update the system software.

Let’s take an example where the main control system is called A and the redundant control system is called B. If
you upload a new configuration or software to control system A and then perform a cold start, the following will
occur:

· The system responds to the cold start of the main control system (A) by automatically switching to the
redundant control system (B).

· At the end of the cold start, data from the active control system (B) is copied back to the redundant
control system (A). In other words, any new data will be overwritten!

To avoid this, and upload a new configuration or update software successfully:

1. Disable the redundant control system.

This can be achieved by releasing the locking catches, fitted to the top and bottom of the redundant Router
Module (in STANDBY):

This unlocks the module from the Nova73 and automatically disables it; the module's LEDs should be off. Note
that it is not necessary to pull out or remove the module completely.

2. Now upload your new AdminHD configuration, or new software version, and perform another cold start -
the system restarts using the new configuration files or software.

3. Once the control system is running (ACTIVE LED flashing), lock the redundant Router Module back into
place to reactivate it - the redundant Router Module boots up, and all data from the main control system is
copied across.

4. Cold start the system once more to confirm that step 3 was successful.
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4.8 SMPTE 2022-7

SMPTE 2022-7 is a method of recovering lost data packets when streaming data over an IP network. The
technology is also known as Seamless Protection Switching (SPS). Within a RAVENNA installation, it can be
used to provide main and redundant paths for audio/video streams and PTP synchronization.

Compatible Devices

Lawo devices that support SMPTE 2022-7 (SPS) are:

· 981/61 RAVENNA IO module - fitted to the Nova73, Nova37, mc236 and mc2 Micro Core.

· mc296 Local IO.

· A__line devices: A__mic8, A__digital8, A__madi4. 

SMPTE 2022-7 (SPS) is supported from mc2/Nova Version 5.14.0 and Image Version 10.0.0.x.

Concept

The diagram below illustrates the concept in a standard data network:

A SMPTE 2022-7-enabled transmitter duplicates the input stream and sends it via two different paths to the
destination receiver. The receiver (also SMPTE 2022-7 enabled) combines the streams from both paths and
reconstructs the original stream. If a packet was lost on path 1, the packet is taken from path 2. If path 1 is lost
completely, then the entire stream is taken from path 2, and vice versa. The result is that the receiver can switch
from one path to the other without impacting upon the stream content.

Configuration

To configure SMPTE 2022-7 (SPS), will need to create the two separate network paths for each data stream. This
means doubling the network's infrastructure and then connecting each sending and receiving device to both paths.
Within Lawo systems, the two paths are usually known as the red and blue networks.

For partnering connections between a 981/61 RAVENNA IO module and a remote IO device, the two streaming
paths are created automatically according to the system configuration defined by AdminHD. See Configuring
SMPTE 2022-7 (SPS). Therefore, once the streaming ports are connected and the system configuration is
uploaded, there is nothing further to do.

For RAVENNA Net Tie-lines, the AdminHD configuration defines 128 input and 128 output channels per port.
These will appear in the Signal List display as mono sources and destinations providing you have added them to
the Signal List (gui_config.tcl). In order to send and receive audio, you will need to set up the required TX and RX

streams using the RAVENNA Web UI. Please refer to the separate "RAVENNA for mc2/Nova User Guide" for
details.

In all cases, you must use an odd/even pair of ports to configure SPS. So, for example, on the 981/61 RAVENNA
IO module, this can be ports 1+2 or 3+4, but not 2+3!

All ports must connect via the streaming network and conform to the qualifying data network requirements.
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5.      Installation

This chapter describes how to install a complete system.

Topics include:

· Installing the Control Surface

· Installing the Nova73

· Installing a DALLIS

· Installing a Compact IO

· SFP Modules

· Synchronization

· Configuring Talkback

· Wiring

· Checking the System

Further Information

The mc2/nova HTML documentation contains mechanical drawings, data sheets and further information on all
system components. This resource is available from the Download-Center at www.lawo.com (after Login).

We also recommend that you carefully observe the release notes delivered with your system.

http://www.lawo.com
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5.1 Installing the Control Surface

5.1.1 Preparation

Unpacking

Each control surface frame is delivered separately. All included accessories can be found in the "Accessories"
box. Any optional components, such as the script tray, are delivered in their own packing box.

Please check the contents of the shipping boxes, and in the event of any transport damage, contact your local
Lawo representative or email support@lawo.com.

Mounting

The Studio version comes ready for table-top mounting. If you have ordered the Console Stand, then the legs are
packed separately and come with wooden mounting plates to attach the legs to the frame.

The OB-Van version is designed for mounting onto a crossbar (not supplied). Note that a separate OB-Van
mounting kit is not required as the screw threads are integrated into the frame.

In both cases, you will find mechanical drawings and further information for installers in the HTML documentation.

WARNING: The frame must be mounted so that the faders work in a horizontal manner. It is forbidden to use
the device in any other position, due to the convection airflow through and along the device.

All plug-in connectors are located at the front or rear of the unit. Therefore, please leave enough room for the
cables. You must also make sure that there is sufficient airflow around the device for cooling.

Dimensions and Weight

The dimensions and weight vary depending on the frame variant and the choice of fader panels: standard, XC or
XT. Drawings for the 16 + 16C Studio console (959/10) are shown below.

Studio Frame Profile

Weight (standard console) = 47.3 kg

16 + 16C Studio Overhead

mailto:support@lawo.com
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Temperature and Cooling

Proper operation of the control surface can only be guaranteed at an ambient temperature between 10° C and  35°
C and a relative humidity between 15% and 85% (not condensing).

To keep the control surface cool in extreme conditions, the front panel is fitted with low noise fans. A sensor
within the console activates the cooling fans if the temperature rises above 30° C. At temperatures below 30° C
the cooling fans are switched off, enabling the installation of the frame within noise critical environments. 

When relying on convection cooling, it is vital to observe the minimum distances around the frame. The sticker on
the rear of the frame summarises the requirements.

WARNING: ALWAYS observe the minimum distances around the console frame to allow for ventilation and
cable ducting. Take care that no devices or cables obstruct the flow of air and, thereby, hinder cooling.

Power Consumption

The maximum power consumption, per mains connection, for a fully loaded frame is:

· Current (max): 1.4 A to 3.4 A (depending on the voltage)

· Power (max): 340 Watts

A control surface with fewer panels requires less current and power.

Due to the power supply inrush current, no more than three PSU blocks should be used per 16 A circuit breaker.

Frame Spec & (Part Number) No. of PSU blocks per phase

16C (959-09) 1

16 + 16C (959-10) 1

16 + 16C + 16 (959-11) 1

32 + 16C + 16 (959-12) 2

32 + 16C + 32 (959-13) 2

16 Fader Extender (959-22) 1

Electrical Voltage

The specification for each PSU block is:

· Input: 100-240 VAC (PFC)/ 47–63 Hz

· Output: 13 VDC / 18 A (max)/ 234 Watts (max)

Note that depending on the frame variant, more than one PSU block may be installed.
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5.1.2 Minimum Distances for Control Surface Mounting

16+16C Studio Frame 

16+16C OB Van Frame
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5.1.3 Control Surface Power

The control surface is powered by dual-redundant power supplies which are fitted internally within the frame. 

Depending on the frame size, more than one PSU block may be required. Each block provides two power
supplies (main + redundant). To operate the frame, only one of the supplies is required. When both supplies are
operational, the load is shared.

The diagrams below show the possible locations of each PSU block.

The status of all PSU blocks can be monitored from the Central GUI (via the status bar).

For details on how to change a faulty PSU, see Replacing a Console Power Supply.

MAINS Connections

The MAINS connectors are located on the frame's rear panel (beside the heat sink for the PSU block). There are
two connectors, one for each of the internal supplies.

For redundancy, it is recommended to connect both MAINS 1 and MAINS 2, each to a separate phase of the
AC mains circuit. The same two phases should be used for other PSU blocks within the same frame.

There is no on/off switch, and so the frame will boot as soon as mains power is supplied. It is recommended that
you install a master power switch to control all the power supplied to the frame.

The MAINS connectors include an IEC locking mechanism for security. Please unlock before removing a
connector. Be sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: Each frame MUST be connected to the mains using the IEC power cables supplied with the
system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

PSU Block Locations

Depending on the frame size, either one or two PSU blocks are fitted to each control surface frame. 

There is always one PSU block fitted to the central bay:
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For larger frames, the second PSU block is fitted to the left-most channel bay:

Extenders are also fitted with their own PSU block:
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5.1.4 Control Surface Grounding

Although operator protection is guaranteed (the control surface is connected to the ground of the power supply
system via the IEC power connectors), it is best to establish an additional ground for EMC reasons.

1. Fasten the grounding cable to the rear of the frame using the CASE grounding screw (M5 x 12mm):

WARNING: The control surface must be on the same potential as all other system devices/modules. For
Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.
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5.1.5 Fitting the Script Tray

Optionally, one or more removable script trays (959-41) can be ordered. 

The script tray is designed to be easily lifted on and off the console, and so it may be removed when not required.
Please note that there is no locking mechanism to anchor the script tray to the console, and so it must be
removed for transportation.

When fitted, the tray glides to the left or right. The maximum load of the script tray is 4kg. 

WARNING: DO NOT press down, sit on or place objects > 4kg onto the script tray, as to do so may damage
the script tray and console surface.

Mechanical Drawings (Rear View & Side Profile)



mc²56 MKII Technical ManualVersion: 5.14.0/164/298

5. Installation

5.1.6 Installing Extender Frames

The control surface main frame includes two Ethernet extension ports to connect Extender frames.

If more Extender connections are required, then a Fast Ethernet switch must be installed. If the Extender frames
have been delivered with the console, then a suitable switch will be supplied. If you are adding Extenders to an
existing console, then you will need to purchase a switch before continuing. For advice, please contact your local
Lawo representative or email support@lawo.com.

Installation

Extender frames should be mounted, powered and grounded as for the main frame.

Wiring (for up to two Extender Frames)

Use a straight (1:1) network cable, of the type CAT 5e with RJ45 connectors. The maximum cable length = 80m.

1. Connect one of the ETH Extension ports on the main frame to the ETH Extension port on the Extender
frame.

Take care to connect the ETH Extension port (and not ROUTER 1 or ROUTER 2).

Main Frame Rear Connector Panel

2. Repeat, using the spare port, to connect a second Extender frame.

Wiring (for additional Extender Frames)

Use a straight (1:1) network cable, of the type CAT 5e with RJ45 connectors. The maximum cable length = 80m.

1. Connect one of the ETH Extension ports on the main frame to a Fast Ethernet switch (described above).

2. From the switch, connect each of your Extender frames.

Setting the Address of an Extender Frame

If you are adding a new extender, then you will need to adjust the Bay Server "Address" to determine the channel
bay index of the frame (i.e. whether it controls faders 1-16, 17-32, etc).

mailto:support@lawo.com
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5.2 Installing the Nova73

5.2.1 Preparation

Unpacking

The Nova73 is delivered in its own box. All included accessories can be found in the "Accessories" box. Any
optional components, such as spare IO modules, are delivered in their own packing box.

Please check the contents of the shipping boxes, and in the event of any transport damage, contact your local
Lawo representative or email support@lawo.com.

Rack-Mounting

Both the Nova73 HD and Nova73 Compact are designed to be mounted in a 19” rack.

WARNING: Use the rack-rails supplied to mount the Nova73. The 19” frame MUST NOT carry the complete
weight of the unit.

If you have plug-in modules or rear connector panels to install, then these should be fitted BEFORE installing the
unit into the rack.

All plug-in connectors are located at the front or rear of the unit. Therefore, when using 19’’ racks with doors
please leave enough room for the cables. Cables plugged into the front of the unit can be ducted backwards
underneath the unit for distribution within the rack. You must make sure that there is sufficient airflow around the
device for cooling.

Dimensions and Weight

Nova73 HD Nova73 Compact

Width 19”, 483mm (front plate), 440mm (chassis)

Height 10RU 7RU

Cable Duct 1RU below the frame is required for cable ducting and ventilation.

Depth (including connectors and
locking devices)

510mm 489mm

Weight 16.25 Kg (one PSU fitted)

Each PSU weighs 4.25 Kg

14.5 Kg (two PSUs fitted)

Each PSU weighs 2.86 Kg

Temperature and Cooling

Proper operation of the Nova73 can only be guaranteed at an ambient temperature between 10° C and 35° C and
a relative humidity between 15% and 85% (not condensing). When the Nova73 is out of action, it can be stored at
a temperature between 0° C and 40° C and a relative humidity between 10% and 85% (not condensing).

The frame is actively cooled by five* built-in fans. (*The Nova73 Compact has four fans). The life cycle of a fan is
typically 70.000 operating hours at a maximum ambient temperature of 40° C. The fans can be replaced during
operation.

The frame housing is perforated at the top and bottom to guide the air flow in and out of the unit. The air stream
flows from bottom front to top rear. You must ensure that the air stream is guided to cool the unit efficiently. The
air-flow rate depends on the mounted components. To calculate the air conditioning required, assume a maximal
air-flow rate of approximately 200 m³/h.

WARNING: Take care that no devices or cables obstruct the flow of air and, thereby, hinder cooling.

mailto:support@lawo.com
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Power Consumption & Electrical Voltage

The power consumption of the Nova73 varies from a minimum of 60W to a maximum of 1000W, depending on the
voltage and number of modules and PSUs fitted.

Nova73 HD Nova73 Compact

PSU Type 980/25 (1000W Power Supply) 980/27 (500W Power Supply)

PSU
Specification

Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 13,5 A

Output: 48 VDC / 23 A

Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 5,5 A

Output: 48 VDC / 10,5 A
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5.2.2 Mechanical Drawings: Nova73 HD

Frame 980/02, Front View 

Frame 980/02, Side View 
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5.2.3 Mechanical Drawings: Nova73 Compact

Frame 980/06, Front View 

Frame 980/06, Side View 
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5.2.4 Nova73 Power

The Nova73 is powered by dual-redundant power supplies which are fitted to the slots at the front of the frame. On
the Nova73 HD, the second PSU is optional. The Nova73 Compact is always installed with two supplies.

A single PSU is required for the system to operate. The second PSU provides redundancy. When both supplies
are operational, the load is shared.

To ensure the proper airflow, both PSU slots MUST be occupied when the Nova73 is operational:

· Nova73 HD: if only one PSU is installed, cover the empty slot with a blanking plate (980/21). 

· Nova73 Compact: if a PSU is faulty, leave both units in the frame until a replacement can be fitted.

The status of the PSUs can be monitored from the Central GUI (via the Signal Settings display).

The PSUs are hot pluggable, see Replacing a Nova73 Power Supply.

MAINS Connections

The mains connectors are located on the front of the frame.

For redundancy, it is recommended to connect both PSUs, each to a separate phase of the AC mains circuit.

Each PSU can be switched on and off from the front panel, and includes a status LED. This should illuminate as
soon as mains power is supplied.

The mains connectors include a locking mechanism for security. Please unlock before removing a connector. Be
sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: The Nova73 frame MUST be connected to the mains using the IEC power cables supplied with
the system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

5.2.5 Nova73 Grounding

Although operator protection is guaranteed (the Nova73 is connected to the ground of the power supply system
via the IEC power connectors) it is best to establish an additional ground for EMC reasons. 

1. Fasten the grounding cable to the rear of the frame using the CASE screw (M4 x 8mm):

WARNING: The Nova73 must be on the same potential as all other system devices/modules. For
Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.
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5.2.6 AES3 Rear Connector Panels

 Nova73 HD

Optionally, the Nova73 HD can be fitted with D-type and/or BNC AES3 rear connector panels. These provide
connections for any front-mounted AES3 modules (of type 981/02 or 981/04). The two panel types can be mixed
allowing up to 8 x D-type or 4 x BNC connector panels to be fitted:

· D-type, 8HP (980/14) - AES3, balanced 110 Ω

· BNC, 16HP (980/15) - AES3-id, unbalanced 75 Ω

The breakouts are on either 25-pin D-type or 75 Ω BNC connectors. See Connector Pin-Outs for pinning
information.

The position of the rear connector panels determines the slot numbers which MUST be used for front-mounted
AES3 modules. Therefore, it is important to fit the rear panels BEFORE mounting the AES3 IO modules. 

Ø  To fit the rear panels:

1. Establish the first free slot (working from right to left) at the rear of the frame.

2. Remove the existing blanking plate if fitted.

Note that the blanking plates are 8HP wide. Therefore, if you are mounting a 16HP connector panel, you will need
to remove two blanking plates.

3. Position the connector panel so that the inscription is legible!

4. Fasten the connector panel into place using its 4 screws.

5. Repeat for every connector panel/blanking plate.

WARNING: Where no connector panel is required, please cover the frame with blanking plates (980/13).
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Nova73 Compact

The Nova73 Compact comes with rear-mounted AES3 connectors as standard. These provide balanced 110 Ω
D-type connections for up to two front-mounted AES3 modules (of type 981/02 or 981/04). Note that the AES3
modules MUST be fitted to slots 2 and 6 at the front of the core.

The breakouts are on 25-pin D-type connectors. See Connector Pin-Outs for pinning information.
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5.2.7 Fitting the Nova73 Plug-in Modules

Usually the Nova73 is delivered with all plug-in modules fitted to the frame. If you need to add a module or re-
arrange the layout, then please use the following instructions. 

Not every IO or DSP module can be used in every slot, so it is best to check if the configuration is supported
by AdminHD before fitting the physical modules.

WARNING: The Nova73 plug-in modules carry highly sensitive electronic components, and therefore should
only be handled by authorized personnel, and with the utmost care. 

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in module.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic charging.

3. DO NOT bend the modules.

4. Make sure that all rear connector panels are mounted before inserting the respective plug-in module.

5. To remove an existing module, unfasten the front panel screws, release the locking catches (as shown
below) and pull out the module.

Some modules include DIP switches to set certain features. Therefore, check the DIP switch settings before
inserting a replacement! For details please refer to the module's data sheet.

6. When fitting a module, make sure that it glides smoothly into the top and bottom guide-rails - when fitted
correctly, it will lock into place.

7. ALWAYS fasten the front panel screws in order to fix the module in place. 

This protects the operator from contact with live parts; protects the module from being pulled out unintentionally;
and reduces the emission of electro-magnetic radiation.

Tighten the screws carefully to a maximum torque of 0.25 Nm; we recommend using a dynamo-metric
screwdriver.

8. When you have fitted all the plug-in modules for your system, close any empty slots with blanking plates.
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5.3 Installing a DALLIS

5.3.1 Preparation

Unpacking

Each DALLIS is delivered in its own box. All included accessories can be found in the "Accessories" box. Any
optional components, such as the DALLIS Fan Unit, are delivered in their own packing box.

Please check the contents of the shipping boxes, and in the event of any transport damage, contact your local
Lawo representative or email support@lawo.com.

Rack-Mounting

Both the 3RU and 6RU frames are designed to be mounted in a 19” rack. Recessed kits can be ordered to recess
the frame by 75mm, see Rack-Mounting Options.

WARNING: Use the rack-rails supplied to mount the DALLIS. The 19” frame MUST NOT carry the complete
weight of the unit.

All plug-in connectors are located at the front or rear of the unit. Therefore, when using 19’’ racks with doors
please leave enough room for the cables.

All frames are supplied with a 1RU cable duct, either standard or recessed. This must be fitted below each
DALLIS frame unless you are installing the optional DALLIS Fan Unit. The cable duct provides the 1RU gap
beneath the frame required for ventilation. Cables plugged into the front of the unit should be ducted backwards
underneath the unit for distribution. You must make sure that there is sufficient airflow around the device for
cooling.

Optionally, a DALLIS Fan Unit can be installed to cool up to three 3RU DALLIS frames. In this instance, the
frames must be placed directly on top of each other. See the DALLIS Fan Unit.

If you have plug-in cards to install, then these should be fitted BEFORE installing the unit into the rack.

Dimensions and Weight

DALLIS 3RU Frame DALLIS 6RU Frame

Width 19”

483mm (front plate)

440mm (body)

19”

483mm (front plate)

440mm (body)

Height 132.5mm 265mm

Cable Duct 1RU below the frame is required for cable ducting
and ventilation (unless cooled by a DALLIS Fan
Unit)

1RU below the frame is required for cable ducting
and ventilation

Depth (of unit) 433mm 433mm

Weight (without
cards)

7.15 Kg 11 Kg

mailto:support@lawo.com
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Temperature and Cooling

DALLIS units require a constant air stream with a maximum exhaust air temperature of 32° C. 

The housing of the frame is perforated at the top and bottom to guide the air flow in and out of the unit. The air
stream flows from bottom front to top rear. You must ensure that the air stream is guided to cool the unit
efficiently. The air-flow rate depends on the mounted components. To calculate the air conditioning required,
assume a power consumption of 200 Watts.

If are installing 3RU DALLIS frames, then the optional DALLIS Fan Unit can be installed to providing forced air
cooling. See the DALLIS Fan Unit.

WARNING: ALWAYS leave 1RU below the DALLIS frame (unless installing the DALLIS Fan Unit). ALWAYS
observe the minimum distances at the front and rear of the unit. Take care that no devices or cables obstruct
the flow of air and, thereby, hinder cooling.

Power Consumption

The power consumption of a DALLIS varies from a minimum of 70W to a maximum of 180W, depending on the
number and type of IO cards fitted, and whether there are dual power supplies.

Electrical Voltage

DALLIS 3RU Frame DALLIS 6RU Frame

PSU Specification Input: 100-240 VAC (PFC)/ 48-62 Hz/ 1.6-2 A

Output: 12 VDC / 8.3-11 A

Input: 100-240 VAC (PFC)/ 48-62 Hz/ max. 2A

Output: 12 VDC / 11 A



mc²56 MKII Technical Manual Version: 5.14.0/1 75/298

5. Installation

5.3.2 Mechanical Drawings: DALLIS 3RU Frame

Frame 940/30, Dimensions

Frame 940/30, Side View
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5.3.3 Mechanical Drawings: DALLIS 6RU Frame

Frame 940/60, Dimensions

Frame 940/60, Side View
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5.3.4 Minimum Distances for DALLIS Installation

You must leave 1RU beneath each DALLIS frame for ventilation and cable ducting, unless you are installing the
optional DALLIS Fan Unit.

In all cases, you must observe the minimum distances at the front and rear of the frame.
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5.3.5 DALLIS Rack-Mounting Options

Cable Duct

The 940-21 Cable Duct is a 19” / 1RU blind panel, with cable grooves corresponding to the card slots in a DALLIS
frame. 

It should be fitted below each DALLIS frame, unless you are installing the optional DALLIS Fan Unit. Note that
there is a recessed version (940-26) for recessed DALLIS frames (see below).

Dimensions & Weight

Height 1RU, 43mm

Width 19", 483mm

Ducting holes 21 x 16mm

Recessed Frames

The following options allow a DALLIS frame to be recessed by 75mm.

· 940-28: DALLIS Recess Kit - 3RU Frame. Conversion kit for recessed installation of 940-30.

· 940-29: DALLIS Recess Kit - 6RU Frame. Conversion kit for recessed installation of 940-60.

· 940-25: DALLIS Recessed Blind Panel, Top. 19", 1RU blind panel to close the gap for non-recessed
devices in the rack. To be fitted above the uppermost recessed DALLIS frame.

· 940-26: DALLIS Recessed Cable Duct, Middle. Like the 940-21. 19", 1RU blind panel with cable ducting
holes to be fitted between two recessed DALLIS frames.

· 940-27: DALLIS Recessed Cable Duct, Bottom. Like the 940-21. 19", 1RU blind panel with cable ducting
holes to close the gap for non-recessed devices in the rack. To be fitted below the lowest recessed
DALLIS frame.
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5.3.6 DALLIS Fan Unit

The DALLIS Fan Unit can be used to cool up to three 3RU DALLIS frames. The unit can be ordered in either
standard or recessed versions:

940-20: DALLIS Fan Unit 940-24: DALLIS Fan Unit, recessed

Specification

Height 1RU, 43mm

Width 19", 483mm (front plate) / 448mm (chassis)

Depth (without connector) 415mm (+ 76.5mm for recessing "ears")

Weight (without cables) 3.4Kg

Number of Fans 4

Cooling Airflow Forced, from front to top

Power Consumption 6.5W



mc²56 MKII Technical ManualVersion: 5.14.0/180/298

5. Installation

Installation

When installing DALLIS frames which are to be cooled by the DALLIS Fan Unit, the frames must be placed
directly on top of each other, with the Fan Unit directly below the DALLIS you wish to cool (as shown in the
picture below).

For correct airflow, all DALLIS slots must be closed either by a plug-in card or blanking panel. The space above
the uppermost DALLIS frame must not be blocked by cables.

Note that the DALLIS cards 941/53, 945/61, 946/09, 946/13 and 946/17 produce the most heat and, thus, must
not be installed next to each other.

Installation of Fan Unit (below 3 x 3RU DALLIS Frames)

Operating Modes

The Fan Unit can run in a choice of modes determined by the rotary switch positions and flip switch: "Silent" or
"AUTO/MAX".

To run in manual mode, turn the rotary switch to position 0. Then set the flip switch to "AUTO/MAX". The fans will
now run at their maximum speed which is fixed.

To run in auto mode, turn the rotary switch to position 1, 2 or 3 according to the number of stacked DALLIS
frames. Then set the flip switch to "AUTO/MAX". The fan speed will now be adjusted automatically, according to
the outside temperature and selected number of DALLIS frames. Note that the outside temperature should not
exceed 40°C. 

In either mode, you can force the unit to run silently by changing the flip switch to position "Silent". In this mode
the fans operate at their minimal speed.

Rotary switch position Flip switch position = “Silent” Flip switch position = “AUTO/MAX”

0 Silent mode Maximum speed (fixed)

1 Silent mode Auto mode for 1 DALLIS frame

2 Silent mode Auto mode for 2 DALLIS frames

3 Silent mode Auto mode for 3 DALLIS frames
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5.3.7 DALLIS Power

The DALLIS is powered by dual-redundant power supplies which are fitted to two internal slots (with service
access via the rear door). A single PSU is required for the system to operate. The second PSU provides
redundancy. 

Depending on your system specification, either one or both supplies will be installed. When both supplies are
operational, the load is shared.

The status of the PSUs can be monitored from the Central GUI (via the Signal Settings display).

The PSUs are hot pluggable. For details on how to change a PSU, see DALLIS PSU replacement.

MAINS Connections

The mains connectors are located on the rear of the frame.

There is no on/off switch, and so the DALLIS will boot as soon as mains power is supplied.

For redundancy, it is recommended to connect both PSUs, each to a separate phase of the AC mains circuit. 

The mains connectors include a locking mechanism for security. Please unlock before removing a connector. Be
sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: The DALLIS frame MUST be connected to the mains using the IEC power cables supplied with
the system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

5.3.8 DALLIS Grounding

Although operator protection is guaranteed (the DALLIS is connected to the ground of the power supply system
via the IEC power connectors) it is best to establish an additional ground for EMC reasons. 

1. Fasten the grounding cable to the rear of the frame using the CASE screw (M4 x 8mm):

WARNING: The DALLIS must be on the same potential as all other system devices/modules. For
Scandinavian countries, ALWAYS use a grounded mains connection, to prevent the device from being
grounded through Ethernet or other signal connections.

Grounding of Audio Interfaces

For compliance with AES3, digital interfaces should be connected to a field ground.

When connecting microphones, the ground connection from the DALLIS should be guided directly to the
microphone via the cable shielding, otherwise phantom power cannot be transferred. Take care that the shielding
does not lie on the field ground (to prevent interference and loss of signal quality).
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5.3.9 Fitting the DALLIS Plug-in Interfaces

Usually the DALLIS is delivered with all plug-in master boards and IO cards fitted to the frame. If you need to add
a card or re-arrange the layout, then please use the following instructions.

Not every IO card can be used in every slot, so it is best to check if the configuration is supported by 
AdminHD before fitting the physical cards.

WARNING: The DALLIS plug-in cards carry highly sensitive electronic components, and therefore should only
be handled by authorized personnel, and with the utmost care. 

To avoid any unpleasant clicks or pops, the system resets when a Phantom Power card is replaced.
Therefore, you should only replace a Phantom Power card if the system is off air!

ALWAYS observe the following procedures:

1. Discharge yourself before touching a plug-in card.

2. Wear conductive safety-shoes and grounding wristbands to reduce the risk of electrostatic charging.

3. DO NOT bend the cards.

4. To remove an existing card, unfasten the front panel screws and pull out the card.

Take note of any existing DIP switch settings; for details please consult the relevant data sheet.

5. When fitting a new card, make sure that it glides smoothly into the top and bottom guide-rails - when
fitted correctly, it will lock into place.

6. ALWAYS fasten the front panel screws in order to fix the card in place. 

This protects the operator from contact with live parts; protects the card from being pulled out unintentionally; and
reduces the emission of electro-magnetic radiation.

Tighten the screws carefully to a maximum torque of 0.25 Nm; we recommend using a dynamo-metric
screwdriver.

7. When you have fitted all the plug-in cards for your system, close any empty slots with blanking plates.

For single width slots use part number 940/31, and for double width slots use 940/33. 

Use part number 940/32 to blank the second master board slot.
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5.4 Installing a Compact IO

5.4.1 Preparation

Unpacking

Each Compact IO is delivered in its own box. All included accessories can be found in the "Accessories" box.

Please check the contents of the shipping boxes, and in the event of any transport damage, contact your local
Lawo representative or email support@lawo.com.

Rack-Mounting

The Compact IO is designed to be portable, and can be lifted using the two handles mounted on the front of the
chassis.

All breakout connectors are located on the front panel, with mains power connectors at the rear. When installing,
please leave enough room for the cables.

Dimensions and Weight

Width 483mm / 19”

Height 5RU / 220mm / 8.7"

Weight

Temperature and Cooling

The unit is convection cooled. It is ideal for installation within noise critical environments. Proper operation can
only be guaranteed at an ambient temperature between 10°C and 35°C and a relative humidity between 15% and
85% (not condensing). 

WARNING: Take care that no devices or cables obstruct the flow of air and, thereby, hinder cooling.

5.4.2 Compact IO Power

The Compact IO is powered by dual-redundant power supplies which are mounted internally within the frame. A
single PSU is required for the system to operate. The second PSU provides redundancy. 

When both supplies are operational, the load is shared.

The status of the PSUs can be monitored from the Central GUI (via the Signal Settings display).

MAINS Connections

The mains connectors are located on the rear of the frame.

For redundancy, it is recommended to connect both PSUs, each to a separate phase of the AC mains circuit.

There is no on/off switch, and so the Compact IO will boot as soon as mains power is supplied.

The mains connectors include a locking mechanism for security. Please unlock before removing a connector. Be
sure to turn the mains power off BEFORE connecting or disconnecting a cable.

WARNING: The Compact IO MUST be connected to the mains using the IEC power cables supplied with the
system. When running with two mains supplies, make sure that both circuits lie on the same ground
potential. Otherwise, an internal bridge of two grounding wires can lead to a ground loop!

mailto:support@lawo.com
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5.5 SFP Modules

The following SFP modules are available for the relevant MADI and RAVENNA ports. Note that all SFPs must be
Lawo-certified (as listed below).

If fitting SFPs to both MADI and RAVENNA ports, take care not to mix up the module types!

MADI SFP Modules

Options include multi-mode and single-mode fibre, and standard coaxial cable. For more details, please refer to
the SFP module's data sheet.

SFP Module Description Part Number

MADI, multi-mode fibre 981/60-80

MADI, single-mode fibre 981/60-81

MADI, coaxial/electrical 981/60-82

RAVENNA SFP Modules

Options include multi-mode and single-mode fibre. For more details, please refer to the SFP module's data
sheet.

SFP Module Description Part Number

1000 BASE SX: 850nm, -7dBm, multi-mode fibre, 550m 981/60-10

1000 BASE LX: 1310nm, -3dBm, single-mode fibre, 10km 981/60-20

1000 BASE ZX: 1550nm, 0dBm, single-mode fibre, 80km 981/60-30

Installing the SFPs

The SFP modules are hot-pluggable. To install, remove the dust caps from both the port and SFP module. Then,
push the module into the rectangular slot. Press gently and firmly until the module locks into position.

CAUTION: Please unlock the SFP module before removing to avoid mechanical damage to the slot.

If a module is removed, please refit the port's dust cap to protect the internal components.

Make sure you use the correct fibre type for your device. Using the wrong fibre type or exceeding the
maximum optical input power can result in malfunction of, or damage to, the optical device.
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5.6 Synchronization

The system offers a fully redundant clock source structure and, when connected to a RAVENNA streaming
network, can transmit or receive PTP.

5.6.1 Sync Reference Options

For a Nova73, the sync reference options are:

· Multichannel – either PTP to/from the RAVENNA streaming network, or incoming sync from a MADI or
RAVENNA Link Port.

· Input 1 – sync connected to INPUT 1 on the Nova73 rear panel. This can be Wordclock, Video Black
Burst or AES3-id.

· Input 2 – sync connected to INPUT 2 on the Nova73 rear panel. This can be Wordclock, Video Black
Burst or AES3-id.

· Internal – the Nova73's own internal sync generator.

Note that the Mutichannel sync source (either PTP or Port) must be pre-defined using AdminHD.

5.6.2 Sync Signal Priorities

The sync signal priorities are set from the console GUI, using the Word Clock options in the System Settings
display.

The Active Source field is for display purposes only, and shows the active synchronization source:
Multichannel, Input 1, Input 2 or Internal.

Information about the Frequency, Input Type and Status of each external sync source is shown in the lower
part of the display; if a signal is not present or invalid, then you will see N/A.

The active sync source is selected automatically as follows: Multichannel - Input 1 - Input 2 - Internal. In each
case, the status of the sync source and the Ignore ... check boxes are taken into account.

For example, with a valid sync signal connected to all inputs and no Ignore ... check boxes selected, the system
will lock to the Multichannel sync source (pre-defined by AdminHD). If multichannel sync is lost or the signal is
invalid, then the system automatically switches to Input 1. Similarly, if sync is lost on this port, then the system
switches to Input 2. Finally, if sync is lost on all external ports, then the system switches to Internal. An
automatic return mode means that the system will switch back to Input 2, 1 or Multichannel once a valid signal
is detected.

To ignore an external sync source, enable its Ignore ... check box. For example, to skip the multichannel sync
source in the sequence, enable the Ignore Multichannel Input check box.

If the Error if Internal Sync check box is enabled, then the global alarm will be triggered when the system
switches to internal sync. Note that this option can also be configured using AdminHD (under Core -> Data).
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The Word Clock options are stored in productions. Therefore, if you have changed the sync priorities, you
will need to check and update any user productions.

The examples which follow describe some common requirements.

Ø  Sync to an incoming signal

To sync to external Wordclock connected to Input 1, enable the Ignore Multichannel Input check box. Input 1
should now become the Active Source.

To sync to a MADI or RAVENNA Link signal, first check that the correct port is specified in AdminHD, and then
make sure that the Ignore Multichannel Input check box is off. Multichannel sync should now become the
Active Source.

To sync to PTP from a RAVENNA streaming network, first check that the correct RAVENNA IO module is
specified in AdminHD, and then make sure that the Ignore Multichannel Input check box is off. Multichannel
sync should now become the Active Source. Note that all of the configured RAVENNA Net ports on the
selected module will "listen" for PTP. This means that you should have the correct synchronization as long as
one port remains connected to the network.

Ø  Sync to internal

To sync to the system's internal sync generator, turn on all of the Ignore ... check boxes to ignore all external
sync sources. Internal should now become the Active Source.

If the Error if Internal Sync check box is enabled, then the global alarm will be triggered when the system
switches to internal sync. Note that this option can also be configured using AdminHD (under Core -> Data).

Ø  Transmitting PTP to a RAVENNA Streaming Network

This mode requires some deeper knowledge, as the network's PTP master is dependent on the PTP priorities set
within the device itself and all other streaming nodes. For details, please refer to the separate "RAVENNA for

mc2/Nova User Guide".

5.6.3 External Sync Connections

The following external sync connections appear on the Nova73 rear connector panel:

The INPUT 1 and INPUT 2 connectors can be used to connect an external sync reference. The inputs are auto-
detecting and accept Wordclock, Video Black Burst (PAL or NTSC) or AES 3-id:

· When running the system referenced to Wordclock, the frequency of the sync source MUST match the
operating sample rate of the system.

· The Nova73 supports only one video format at a time. Therefore, if both inputs are supplied with Video
Black Burst, only signals of the same type can be used (either PAL or NTSC).

The THRU 1 and THRU 2 connectors provide an output of the sync signals connected to INPUT 1 & INPUT 2.
Note that these ports provide a "looped-through" signal, and do NOT follow the system clock selection. 
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The WCLK OUT connector provides an output of the current system clock (as defined using the Wordclock
options in the System Settings display).

WARNING: If no further components are connected to the THRU ports, then it is essential to terminate each
port using a 75 Ω resistor. Terminating resistors, designed as BNC connectors are included in the delivery.

A star-like clock distribution, via a distribution amplifier, offers better signal quality and should be preferred to
that of passive daisy chaining.

5.6.4 Checking the Sync Status

The active sync source can be checked from the console GUI: open the System Settings display, select the
Wordclock options and check the Active Source field.

Alternatively, look at the four SYNC LEDs on the front of the Nova73 Router Module:

· Green, blinking = this input is the active sync source.

· Green, steady state = a valid sync signal is connected but the input is not active.

· Off = there is no valid sync signal connected.

The sync status can also be interrogated using the Web Browser Interface.

If the sync source is Multi-channel = PTP, then its status and priority settings can be
interrogated using the RAVENNA Web UI. For details, please refer to the separate

"RAVENNA for mc2/Nova User Guide".
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5.7 Configuring Talkback

Talkback Connector & User Buttons

Depending on your system specification, talkback can be connected in one of the following ways:

· To the integrated talkback mic preamp - described below.

· To the optional INTERCOM user panel (962/16).

· Externally, to any matrix source - for example, to connect talkback from an external communications
system.

The factory default is to use the integrated talkback mic preamp. For details on other options, please see the 
Local IO: Jumper Switch Positions.

Integrated Talkback

The female XLR connector on the front panel feeds a talkback mic preamp mounted inside the control surface.
This, in turn, feeds Line IN 16 of the local IO (according to the local IO board jumper switch positions).

The XLR socket is wired directly to the microphone preamplifier, and provides 48V phantom power. The mic
preamp gain is adjusted by a trim potentiometer; the trimmer is accessible via a small access hole next to the
XLR connector. The mic preamp contains a compressor/limiter; the output gain of the limiter is fixed to +15dBu.

Note that if your system operating levels are set for a Maximum analog Level > +15dBu, then the output level
from the talkback mic preamp can seem low (due to the analog limiter). If this is the case, then you should
increase the level by adjusting the IO DSP Volume for Line input 16 of the local IO.

A line level output from the mic preamp, prior to A-D conversion, is provided via the TBK connector on the console
rear panel. 

Talkback Switching

Talkback switching is programmed from the Custom Functions display. It can be switched from the fader strip
using a Fader User Button, or from a central user button (on either the TALKBACK or CENTRAL USER BUTTON
panels). Please refer to the following Custom Functions (described in your Operators Manual) for more details:

· Fader User Button, Talkback to Channel 

· Central User Button, Talkback to Access Channel

· Central User Button, Talkback to DSP Channel
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5.8 Wiring

This section describes all possible connections.

Note that to boot the system the following connections are essential:

· ETHERNET A - connects the control surface to the Nova73 Router Module.

· Control Surface Power - mains connections to the console frame.

· Nova73 Power - mains connections to the Nova73 frame.

Other connections can be made as they are required.
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5.8.1 ETHERNET A

"Internal" Network Connection

The ETHERNET A port on the Nova73 Router Module MKII (980/33) connects the control system to the console
control surface. Connections are made via TCP/IP Ethernet. 

Only one connection to the active Router Module is essential for operation. If a second Router Module is fitted,
then a second connection should be made to support redundancy (as shown above). 

WARNING: the connection(s) must be directly wired without any other network equipment between the ports.

Cable Specifications

· CAT 5e; straight (1:1) Ethernet cable.

· Connector Type: RJ45.

· Cable Length: up to 80m.

Wiring the Connections

Console Rear Connector Panel Nova73 Router Module

1. Connect one of the ETH A ROUTER ports on the console's main frame to the first Nova73 Router Module.

On the control surface, you can use either of the ETH A ports: ROUTER 1 or ROUTER 2.

On the Nova73, make sure you connect to ETHERNET A (and not ETHERNET B).

2. If a redundant Router Module is installed, then run a second network cable from the spare control surface
port (ROUTER 1 or ROUTER 2) to the second Router Module (ETHERNET A).

The operator will then be presented with an error message should the active connection fail, and decide whether
they wish to switch to the redundant connection/module.
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5.8.2 ETHERNET B

"External" Network Connection

The ETHERNET B port on the Nova73 Router Module MKII (980/33) connects the control system to external
devices for remote operation, configuration and system networking. Connections are made via TCP/IP Ethernet.

A single computer or device can connect directly. However, it is more common to install a network switch.

Depending on the number of network connections, one mc2/Nova system can support up to 16 clients.

If a second Router Module is fitted, then a second connection to the switch should be made to support
redundancy (as shown above).

WARNING: You must use a network switch and NOT a hub, and keep the Lawo network separate from
other network traffic within the installation. The switch should support 1GB for best performance.

For more information on installing a suitable network switch, please contact your local Lawo representative or
email support@lawo.com.

Cable Specifications

· CAT 5 or better (CAT 5e/6/7); straight (1:1) or crossed Ethernet cable.

· Connector Type: RJ45.

· 1000, 100 and 10 Base-TX LAN speeds are supported; 1000 Base-TX (Gigabit Ethernet) is
recommended.

· Cable Length: up to 100m.

Connecting via a Network Switch (recommended)

1. Connect your computer/device to the network switch.

2. If not already installed, connect the ETHERNET B port from the first Router Module (980/33) to the
network switch.

If a redundant Router Module is installed, run a second ETHERNET B connection as shown above. This will
ensure continued access to the control system should a takeover occur.

Direct Connection

1. Connect your computer/device directly to the ETHERNET B port on the active Router Module (980/33).

If the system switches to the alternate Router Module, then will need to re-connect your device manually.

mailto:support@lawo.com
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TCP/IP Configuration

To establish communication, you will need to configure the TCP/IP settings of the computer's Network Interface
Card.

IP Address

The IP address must be unique, and lie within the same IP address range as that of the mc2/Nova control
system (i.e. the first three fields must match). 

For example, if the Lawo control system's IP address = 192.168.102.56, then set your computer's IP address to
192.168.102.101.

You can check the Lawo system IP address from the console GUI: open the System Settings display and
select Global - the IP Address Primary = the main control system IP address.

For a list of the default IP addresses for all products, see Default TCP/IP Settings.

Subnet Mask

The Subnet Mask must match that of the mc2/Nova control system. In all Lawo systems, the default Subnet
Mask = 255.255.255.0.

Default Gateway

A Default Gateway setting is required if data packets are to be redirected. For example, if you are connecting via
a network switch with Layer 3 routing capability. If redirection is not required, then the Default Gateway can be
left blank.

If you are connecting via a wider network, please ask your network administrator for further assistance.

Check the IP settings carefully. If there is an IP conflict, then the network will not operate correctly.

Testing the Connection

The simplest way to check the connection is to open the Web Browser Interface as follows: open your browser
software and enter the IP address of the Lawo system into the URL field - the System Overview page should
appear. If not, try the trouble-shooting tips.
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5.8.3 MADI IO

The MADI IO ports can connect the Nova73 to a partnering device or third-party device via MADI Tie-lines. In each
case, the functionality is determined by the AdminHD configuration when you define the IO port. The following
functionality is supported:

· DALLIS or Local IO can connect via MADI.

· Port redundancy can be configured for a DALLIS with two MADI master boards.

MADI Specification

All MADI interfaces provide:

· AES10: Multi-channel Audio Digital Interface.

· Port port: up to 64 bi-directional channels at 48kHz, or 32-channels at 96kHz.

Cable Specifications

Connectors and cable types vary depending on the IO module/card. 

If a port is available via SFP, then you must fit one of the Lawo-certified SFP Modules. 

For details on non-SFP connectors and cables, please refer to the IO card's data sheet.

Wiring the Connections

MADI connections should be directly wired using point-to-point connections. The maximum connection length
depends on the cable type.

When connecting to a DALLIS, a minimum of 4-channels are used to transport DSP resources. This leaves
up to 60-channels at 48kHz, or 28-channels at 96kHz, for plug-in IO cards.

Status LED

Each MADI interface provides a LOCK / ERR LED:

· Green = valid MADI signal detected.

· Red = MADI signal or link error.

· Off = no signal detected.
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5.8.4 DANTE IO

The DANTE IO ports can connect the Nova73 to a third-party device via DANTE Tie-lines.

DANTE Specification

The 981/65 IO board provides:

· 4 x DANTE Brooklyn II modules with 4 main + 4 redundant ports.

· Per port: up to 64 bi-directional channels at 48kHz, or 32-channels at 96kHz.

· Sample Rate Converters (SRCs) configured per port by AdminHD.

The configuration of the DANTE Brooklyn II modules depends on their firmware version. Please refer to your Lawo
software release notes for the latest information.

Cable Specifications

Choose an Ethernet cable that meets the following specification:

· CAT 5 or better (CAT 5e/6/7); straight (1:1) or crossed Ethernet cable.

· Connector Type: RJ45.

· 1000 or 100 Base-TX LAN; 1000 Base-TX (Gigabit Ethernet) is recommended.

· Cable Length: up to 100m.

Wiring the Connections

For further details on DANTE networking, please refer to https://www.audinate.com

https://www.audinate.com
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5.8.5 RAVENNA IO

The RAVENNA IO ports can connect the Nova73 to a partnering device, or stream audio to and from the network
via RAVENNA Net Tie-lines. In each case, the connection type (RAVENNA Link or RAVENNA Net) and function
(remote IO device or tie-line) is determined by the AdminHD configuration when you define the IO port. The
following functionality is supported:

· DALLIS, Local IO and Compact IO can connect via RAVENNA Link or RAVENNA Net.

· Virtual Devices always connect via RAVENNA Net.

· Port redundancy can be configured for DALLIS frames with two RAVENNA master boards.

· SMPTE 2022-7 can be configured for compatible partnering devices and/or RAVENNA Net Tie-lines.

The connection type affects the physical wiring: RAVENNA Net devices must connect via the Streaming
Network; RAVENNA Link devices must be directly wired (point-to-point).

For RAVENNA Net Tie-lines, once the AdminHD configuration is in place the TX and RX streams must be set up
manually using the RAVENNA Web UI.

RAVENNA Link

All RAVENNA Link interfaces provide:

· RAVENNA Link 1.0: multi-channel digital audio-over-IP.

· Per port: up to 128 bi-directional channels at 48kHz AND 96kHz.

RAVENNA Link connections must be directly wired. 

Providing the physical connections match the AdminHD configuration, the interface is self-configuring. Thus,
once you have connected the ports, no further network configuration is necessary.

To guarantee low latency, reliability and easy setup, do NOT connect any other network equipment between
RAVENNA Link connections. 

RAVENNA Net

All RAVENNA Net interfaces provide:

· AES67/RAVENNA: multi-channel digital audio-over-IP.

· Per port: up to 128 bi-directional channels at 48kHz AND 96kHz.

· Per port: up to 128 TX and 128 RX streams.

RAVENNA Net connections must be made via the streaming network (i.e. to and from a RAVENNA-compatible
network switch). This ensures that the network's PTP clock signal is available to all streaming ports. 

RAVENNA streaming requires proper configuration and management of the data network. The network must
use a suitable architecture; all components must support multicast (as opposed to unicast); a proper
Quality of Service (QoS) must be configured; and so on. 

Please DO NOT attempt to connect RAVENNA interfaces using an unqualifying IP network, as correct
streaming operation cannot be guaranteed.
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Cable Specifications

Each RAVENNA interface (Link or Net) can connect via copper and/or optical fibre, unless otherwise specified.

Copper

Choose an Ethernet cable that meets the following specification:

· CAT 5 or better (CAT 5e/6/7); straight (1:1) or crossed Ethernet cable.

· Connector Type: RJ45.

· 1000, 100 or 10 Base-TX LAN; 1000 Base-TX (Gigabit Ethernet) is recommended.

· Cable Length: up to 80m.

Optical Fibre (via SFP Modules)

To use the optical fibre ports, please fit one of the Lawo-certified SFP Modules. Note that the SFPs must be
Lawo-certified. Options include mulit-mode and single-mode fibre, supporting a choice of maximum cable
lengths.

If Both Copper and Fibre are Connected

If both copper and fibre are installed at start-up, fibre is the preferred medium. In either case, the second medium
can be hot-plugged without disturbing the current operating connection. If a connection breaks, then the interface
automatically switches to the second medium (if installed). Note that there will be an audible audio interruption
until the automatic stream setup re-establishes the connection. Therefore, the second medium should not be
used to provide redundancy.

Status LEDs

Each dual-media RAVENNA interface provides the following status LEDs:

LOCK / ERR

· Green, static = the link is active, and the signal and streaming are ok.

· Red, static or blinking = the link is active but has one of the following errors: streaming
format error, streaming lock error or stream is asynchronous.

· Off = no signal.

STDBY

· Yellow = the port is configured as a redundant port and is in standby.

· Off = the port is active.

5.8.6 RAVENNA SERVICE Ports

Both the Nova73 981/61 RAVENNA IO module and DALLIS 947/21 & 22 Master Boards include a service port.

The Nova73 981/61 SERVICE ports must connect to the Router Module's ETHERNET B port via the Service
Network. This connection is required to support the forwarding of control, configuration and software updates
from the Router Module MKII to the 981/61 RAVENNA IO modules and their partnering devices: DALLIS, Local
IO, Compact IO and A__line.

The DALLIS 947/21,22 CTRL ports can be left unconnected, as all control, configuration and software updates
arrive, physically, via the streaming ports. (Note that the CTRL ports can still be addressed "virtually" by
connecting to their IP address).

Both ports use a standard RJ45, CAT5 Ethernet connection. The cable length can be up to 100m.
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5.8.7 MIC, LINE, AES3, SDI, GPIO, etc.

All other audio and GPIO devices can be wired to the:

· Nova73 - see Nova73 Plug-in Modules.

· DALLIS - see DALLIS Plug-in Interfaces.

· Compact IO - see Compact IO.

· Local IO - see Local IO.

5.8.8 SYNC IN & OUT

See Synchronization.

5.8.9 Nova73 Global Alarm & Control Signals

On the rear of the Nova73 are the following GPI and Global Alarm connectors:

· GPI 1 & 2 - two 25-pin D-type connectors carrying various input and output signals.

· GLOBAL ALARM - a BNC carrying the global alarm; closed = the global alarm is active.

The GPI inputs are opto-couplers; accept voltages of 3V..20V; draw a typical current of 8 mA; and are floating and
galvanically isolated. 

The GPI outputs are relays; output a maximum of 30V / 500 mA; and are floating and galvanically isolated.

On both D-type connectors, you can pick up a short-circuit proof voltage feed (+5V, max 150mA).
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GPI 1

Ø  Inputs

· GENERAL PURPOSE IN 1 & 2 – can be used for project-specific applications (factory-configured).

· ROUTER TAKEOVER (IN) – will force a manual takeover to the redundant Router Module if one is fitted.
The takeover is triggered by a positive edge at the input.

· PREPARE COLDSTART (IN) – will force a cold start when the Nova73 powers on. The cold start is
triggered if a voltage is supplied to the input.

Ø  Outputs

· 2nd ROUTER ACTIVE – reports the status of the redundant Router Module. Contact closed = redundant
Router Module is active.

· GENERAL PURPOSE OUT 1 & 2 – can be for project-specific applications (factory-configured).

GPI 2

Ø  Inputs

The ALARM 1 to 4 inputs can be used to monitor peripheral devices which are external to the main system.
These inputs MUST be factory-configured. 

Each alarm is triggered by an applied voltage. When the input is open or grounded, the alarm is canceled. 

Within AdminHD, you can assign a text error message to each input, and define whether the input activates the 
global alarm. The default configuration is:

· ALARM 1 IN = failure of external clock supply (activates the global alarm).

· ALARM 2 IN = failure of external power supply (activates the global alarm).

· ALARM 3 IN = failure of external IO system (activates the global alarm).

· ALARM 4 IN = the external device is exceeding its operating temperature (activates the global alarm).

Ø  Outputs

These outputs report the status of the mc2/Nova system components. Note that the TEMP and PSU ALARMS
will also activate the global alarm.

· TEMP ALARM – contact closed = a Nova73 Router Module is exceeding its operating temperature: > 45°
C (activates the global alarm).

· PSU ALARM – contact closed = a failure of either of the Nova73 PSUs (activates the global alarm).

· GLOBAL ALARM – contact closed = the global alarm is active.
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5.8.10 DALLIS Local Alarm & Force M2 Signals

On the rear of each DALLIS are the ALARM and FORCE M2 connectors.

The following contacts are accessible via the ALARM FORCE M2 (15-pin D-type) connector:

· Force second masterboard M2 (Pins 14&15) – use this input to force a redundant Master Board
takeover (if two master boards are fitted to the DALLIS). The takeover is triggered by a positive edge at
the input.

· Alarm (Pins 7&8) – this contact signals that the DALLIS local alarm is active (closed status).

· Alarm Inverted (Pins 5&13) – as above, but the status is inverted.

· PSU 1 (Pins 3&11; Pins 2&10) – these contacts report the failure of PSU 1 (closed status).

· PSU 2 (Pins 1&9) – this contact reports the failure of PSU 2, if fitted (closed status).

The two BNC connectors provide:

· FORCE M2 – use this input to force a redundant Master Board takeover (as above).

· ALARM – outputs the DALLIS local alarm.

ALARM FORCE M2 D-type & Block Diagram
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5.8.11 Wiring from the Control Surface

Main Frame, Rear Panel Connections

· MAINS 1 & MAINS 2 - see control surface power. Only one mains connection is essential for operation;
the second provides redundancy.

· CASE - see control surface grounding.

· ETH Extension (ETH A) - you can use these ports to connect extender frames.

· ROUTER 1 & ROUTER 2 (ETH A) - see ETHERNET A. Only one connection (to the active Router
Module) is essential for operation; the second is recommended if a redundant Router Module is fitted.

· MADI & RAVENNA - one of these ports connects the local IO to the Nova73. See Connecting the Local
IO.

· LINE, AES & GPIO - audio and GPIO breakouts for the local IO.

· TBK - provides a line level output from the integrated talkback mic preamp. See Configuring Talkback. 

Main Frame, Front Buffer Connections

See Front Buffer Connections.
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5.8.12 Wiring from the Nova73

Nova73 HD Front Nova73 HD Rear

Note that the wiring from the Nova73 Compact is identical to the Nova73 HD, other than there is no support for
the BNC AES3 Rear Connector Panel.

Front Connections

· PSU 1 & 2 - see Nova73 power. Only one PSU is essential for operation; the second provides
redundancy. 

· Router Module(s) MKII:

o ETHERNET A – connects to the control surface. 

o ETHERNET B – connects to the Lawo control system network.

· MADI, RAVENNA & DANTE - connect to remote IO options such as DALLIS or Compact IO, or to
external IO devices via tie-lines.

If two Router Modules are fitted, then run ETHERNET A and ETHERNET B connections from both the main and
redundant Router Modules.

Either one MADI, or one RAVENNA, port must be reserved for the connection to the local IO.

Rear Connections

· synchronization Ports - see Synchronization. If a sync reference is not connected, or invalid, then the
system switches automatically to internal sync.

· GPI 1 & 2, Global ALARM - see Nova73 Alarm & Control Contacts.

· AES3 Breakout Connectors - see Nova73 rear connector panels.
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5.8.13 Wiring from a DALLIS

DALLIS 3RU Front

DALLIS 3RU Rear

Note that the wiring from a DALLIS 6RU is identical to the 3RU, other than the different IO card breakouts.

Front Connections

· DALLIS Master Board(s):

o MADI or RAVENNA - connect to the Nova73, see DALLIS Interfaces.

o CTRL, WCLK, SYNC - on some master boards, you will find additional connections for a control

computer and local sync. Please refer to the master board's data sheet for details. 

· DALLIS IO Cards - connect to external IO devices. For breakout options, see DALLIS Interfaces.

Note that in mc2/Nova installations, external sync is usually connected to the Nova73 and not a DALLIS. See
Synchronization.

If two DALLIS master boards are fitted, then you can configure Link & Port Redundancy.

Rear Connections

· PSU 1 & 2 - see DALLIS power. Only one PSU is essential for operation; the second provides
redundancy.

· ALARM & FORCE M2 - see DALLIS Local Alarm & Force M2 Signals.
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5.9 Checking the System

The system starts automatically when power is supplied to the Nova73. If the control surface is not powered,
then you should also power up the surface.

Once boot-up is complete, the console displays refresh to show the Channel Display and Central GUI screens.
The console is now ready for operation. 

At the end of the boot sequence, the system loads its warm start data which includes the latest configuration
data (as defined by AdminHD).

Checking the Components

You can monitor the real-time status of the system's hardware components by opening the Signal Settings
display on the console GUI, or running AdminHD in online mode:

Signal Settings display AdminHD (online)

If all components are operating correctly, then they appear in grey.

If a component is not installed or connected, then it is highlighted in red.

If a component is not yet configured, then you will need to use AdminHD to modify the Core configuration.
AdminHD is described in the next chapter.

Checking the ACTIVE LEDs

The ACTIVE LEDs on all Nova73 modules and DALLIS cards should blink in time with each other at around 1Hz.
This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that the
card is fitted correctly. If the symptom persists, replace the plug-in card.

Checking the Audio Paths

If everything is correctly configured, open the Signal List display on the console GUI to line-check each of your
Sources and Destinations.

If the Signal List is not yet configured, then this can also be edited using AdminHD.

Useful Tools for Diagnostics

Please see Software Tools & Diagnostics.
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6.      Configuration (AdminHD)

This chapter covers AdminHD, Lawo's software tool for remote configuration of all mc2/Nova systems.

Topics include:

· Introduction

· Prerequisites

· Installation

· Basic Operations

· Working with the Configuration Windows

· How to Modify the System Configuration

· Updating the Cold Start Configuration

· Saving the Configuration (as AdminHD Files)

· Editing the Core Configuration

· Editing the Signal List Configuration

· Online Operations

· Documenting the Configuration

· More About the Configuration Files

· Using AdminHD with mxGUI

· Core Configuration Parameters
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6.1 Introduction

AdminHD is the Lawo software application used to configure all mc2/Nova systems. It can also be used as a
diagnostics tool and to document the configuration.

The software is responsible for generating the Core configuration (config.tcl) and Signal List configuration
(gui_config.tcl), which define the system components and organization of the Signal List display.

AdminHD: System Configuration AdminHD: Signal List Editor

The .tcl files created by AdminHD are an essential part of the system. If a hardware component is not defined
within these files, then it will not be visible to the user even if it is powered and connected. In other words, the
configuration is always the ‘master’ of the system, regardless of what physical components are added or
removed. This brings a number of advantages:

· The configuration is always controlled by AdminHD. 

· You can configure components which may not be permanently connected, such as Stageboxes, so that
routes can be made to/from these devices without relying on a physical hardware connection.

· You can easily check if a configuration change is supported. If a component or parameter is not available
within the AdminHD software, then it is ‘illegal’. This allows you to prepare configuration updates offline,
and upload them to the system with confidence.

· AdminHD can connect to the control system of mxGUI. This allows you to open mxGUI using a pre-
prepared configuration in order to create user settings ahead of an event.

Configuration Files & Editing

The config.tcl and gui_config.tcl files are stored on the mc2/Nova control system, and are read following a cold
start. The configuration then forms part of the online data which is loaded following a warm start. 

AdminHD cannot edit the .tcl files directly, but can download the online configuration from the mc2/Nova control
system, and save it locally as a .csv and .slx. These file types can then be opened and edited by any AdminHD
(running a compatible software release).

Once editing is complete, you can choose to update the online configuration, or export and upload new versions
of the cold start .tcl files. For permanent changes to the configuration, you should always upload new versions of
the cold start files, as this will ensure that any changes are not lost following a cold start.

The table below summarises the files read by the system and by AdminHD:

Cold Start File (read by the system) AdminHD File

Core configuration config.tcl config.csv

Signal List configuration gui_config.tcl signal_list.slx

Note that the config.tcl and gui_config.tcl must not be renamed (otherwise they will be ignored by the system).
The AdminHD files can be given any name as long as they keep their .csv and .slx suffix.
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6.2 Prerequisites

Compatibility

AdminHD can connect to any mc2 or Nova system. 

It is mandatory that the system software version matches that of AdminHD to ensure proper functionality. 

All Lawo products use a consistent software release numbering system to indicate compatibility. In each case,
the first three digits of the software versions must match.  So, for example, to connect to and configure a
system running 5.14.0.0, you will need to run AdminHD 5.14.0.x. 

Note that configurations saved by an earlier version of AdminHD can be opened in a later release. However,
configurations saved by a newer release are not backwards compatible.

You can check your system's software version from the "Global Options" in the System Settings display,
and the AdminHD version from the Info main menu.

Host Computer System Requirements

To install and run AdminHD, your computer MUST meet or exceed the following system requirements:

Windows PC:

· Hardware: 500MHz.

· Operating System: Windows 7, 8, 8.1 or 10 (32-bit and 64-bit)

· RAM: 2GB.

· Hard Disc: minimum 200 MB free space.

· Operation: Keyboard and mouse.

· Interface: Ethernet 10/100Mbit.

MAC:

· Hardware: 500MHz.

· Operating System: MAC OS X 10.6 (Snow Leopard) or higher.

· RAM: 2GB.

· Hard Disc: minimum 200 MB free space.

· Operation: Keyboard and mouse.

· Interface: Ethernet 10/100Mbit.
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6.3 Installation

AdminHD is a free of charge application which does not require a software licence. 

The AdminHD installer is packaged with the software release for your product which is available from the
Download-Center at www.lawo.com (after Login). Take care to download the correct version - the first three

digits of the release must match that of your mc2/Nova system.

You can install multiple versions of AdminHD on the same computer; there is no need to uninstall older versions.
This is particularly useful if you need to connect to systems running different software versions.

1. Copy the AdminHD_Release_X-X-X-X.zip onto your computer and unpack the file.

2. Double-click on the relevant installer. 

AdminHD is delivered in a compressed format, so it can take a few seconds before you see the ‘Setup Wizard’:

When running Windows 7, you may be prompted to allow changes to your User Account; select Yes to
continue.

3. Follow the Wizard's instructions accepting the default options provided.

4. When you reach the 'Summary' window, check the options and click Install.

The software is installed onto your computer; this will take a few minutes. By default, files are installed in the
location: ‘C:\Program Files\Lawo/AdminHD X.XX’. where X.XX is the release version.

5. When the installation is complete, a confirmation window will appear.

6. Click on Finish to exit the ‘Setup Wizard’.

If you have any problems with the software installation, please contact your local Lawo representative or email
support@lawo.com.

http://www.lawo.com
mailto:support@lawo.com
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6.3.1 Additional Notes for MAC OS X Installation

If you are running MAC OS X 10.8.x.x (Mountain Lion), then you can see the following error message after
double-clicking on the "install.exe" file:

This error can appear if your "Gatekeeper.app" does not allow installation from downloads which are not from the
MAC App Store. To change this setting:

1. Select "System Preferences -> Security & Privacy" and set the "Allow applications downloaded
from:" as follows: 

2. Then retry opening the AdminHD "install.exe" file.

6.3.2 Uninstall & Update

Uninstalling AdminHD

On Windows 7, use the “Uninstall a program” option within the Control Panel to uninstall AdminHD.

On MAC OS X, remove the program from your "Applications" folder.

Updating AdminHD

To update to a newer version of AdminHD, simply run the installer; there is no need to uninstall older versions.
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6.3.3 Connecting Your Computer to the Lawo Control System

In order to transfer configuration data, or run AdminHD online, you will need a valid network connection between

your computer and the mc2/Nova control system.

1. Connect your computer to the Lawo control system, either directly or via a network switch. See
ETHERNET B.

2. Configure the TCP/IP settings of the computer's Network Interface Card.

Note that it is possible to open and edit existing .csv and .slx files without a network connection to the system.
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6.4 Basic Operations

6.4.1 Starting the Application

Start the program by selecting AdminHD from the START menu (Windows) or Applications folder (MAC):

It is important to choose the correct version of AdminHD: the first three digits must match those of the
system you wish to configure.

AdminHD starts up and opens the last Core configuration file (.csv) you were working on:

The following dialogue pop-up appears if there is a mismatch between the AdminHD software version and the
configuration file you are trying to open:

Select Yes to convert the file to the newer AdminHD release. Or, select No to leave the file unchanged and open
AdminHD without any configuration data.

If this is the first time you have started AdminHD, or a file could not be opened, then AdminHD opens with an
empty operating window.

To start working with the software, you can either start a new session, or open an existing .csv file.
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6.4.2 File -> New

This operation creates a new AdminHD session.

1. Select File -> New from the main menus, and choose the system you wish to configure.

There are two possible menu branches: Mixing Console or routing Matrix:

File -> New -> Mixing Console File -> New -> Matrix

To configure a mc256, mc266 or mc296, select mc2 console. 

Otherwise, select the correct option for your product: mc236 console, mc2 Micro Core, Nova73 HD or
Nova37. For the mc236, Micro Core and Nova37, take care to choose the correct maximum sampling rate
(either 48kHz or 96kHz), as this cannot be changed later. Note that, for a mc2 console or Nova73 HD, the
maximum sampling rate is set later when you define the system Core.

2. If changes have been made to the current AdminHD session, then you are asked if you wish to save
before proceeding:

Select Yes to save the configuration (as a .csv file), or No to continue without saving. (Alternatively, click on the
red/white cross to cancel the dialogue box and the operation.)

The new session opens.

If you selected mc2 console or Nova73 HD, then you will see the entry System in the ‘Core Browser’ and
confirmation of the system type in the status bar:

mc2 Console (new configuration)



mc²56 MKII Technical ManualVersion: 5.14.0/1112/298

6. Configuration (AdminHD)

If you selected one of the mc236 console, Nova37 or Micro Core options, then you will see the standard
configuration for the selected system:

mc236 Console (new configuration)

The Preferences -> Startup options can be used to automatically open the 'Core Browser' and/or 'Remote
Log'  whenever you create a new configuration.

Next Steps

From here you can either download the existing configuration data from the remote system or build a new Core
configuration.
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6.4.3 File -> Open

To open an existing Core configuration (.csv file) stored on your computer:

1. Select File -> Open from the main menus, or click on the  Toolbar icon, or use the keyboard
shortcut (CTRL + O).

2. If changes have been made to the current AdminHD session, then you are asked if you wish to save
before proceeding:

Select Yes to save the configuration (as a .csv file), or No to continue without saving. (Alternatively, click on the
red/white cross to cancel the dialogue box and the operation.)

3.  A file explorer window now appears - select a file to open and click on Open.

If the file was saved using an older version of AdminHD, then you will be asked if you wish to convert it:

Select Yes to convert the file to the newer AdminHD release. (Or, No to leave the file unchanged and open
AdminHD without any data.)

The file opens, with the file path and name at the top of the window:

If there is a problem opening the file, then check the file type and the AdminHD version:

· AdminHD can only open .csv files (not .tcl). 

· .csv files saved using a newer release of AdminHD are not backwards compatible.

The Preferences -> Startup options can be used to automatically open the 'Core Browser' and/or 'Remote
Log'  whenever you open a configuration.

You can use File -> Open recent to open a recent configuration.
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6.4.4 The Main Operating Areas

There are five main operating areas:

 1   Headline

Here you will see the file name and path of the Core configuration (.csv). If no path is present, then this is a new
session. If the file name is followed by an asterisk (*), then changes have been made since the last save. 

 2   Main Menus

The five main menus are described later.

 3   Toolbar

These buttons provide fast access to common functions. They are described later.

 4   Status Bar

Here you will see information about AdminHD, such as the current configuration type (e.g. mc2 console), and
the online/offline status.

 5   Configuration Windows

In the central working area you can open a mixture of configuration windows. In our example, the 'Core Browser',
'Hardware Panel', 'Parameter Box' and 'Remote Log' are all in view.

To show or hide a window, use its Toolbar icon, Window menu option or keyboard shortcut:

If an option is greyed out, then it is not currently available. For example, the 'Hardware Panel' can only be
opened once a valid component is selected in the 'Core Browser'.
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The main function of each configuration window is as follows:

Core Browser

Displays the Core configuration in a tree-like structure. 

From here you can navigate around the system, and add or remove components. When
running online, components are color-coded to provide system diagnostics.

Hardware Panel

Provides a graphical view of the selected component. 

From here you can also add or remove components, and check their real-time status
(when running online).

Parameter Box

Shows the parameters for the selected component. 

From here you can view and edit the parameters stored in the Core configuration. This
includes system-wide parameters such as sync settings and signal parameters for each IO
card.

Signal List Editor

Provides everything required to modify the Signal List configuration. 

From here you can download, edit, export and upload the cold start Signal List
configuration file (gui_config.tcl). And, save a copy on your AdminHD computer (as a .slx
file).

Remote Log

Logs all the messages generated by AdminHD and, when running online, the connected
control system.

It is a good idea to open this window, especially when transferring data to or from a
system.

6.4.5 Arranging the Workspace

The configuration windows are rarely used in isolation. For example, to edit the Core configuration, you will need
to open the 'Core Browser', 'Hardware Panel' and 'Parameter Box'.

Note that, when open, the 'Core Browser' always appears on the left and the 'Remote Log' at the bottom of the
workspace. These windows cannot be minimized or repositioned.

The 'Hardware Panel', 'Parameter Box' and 'Signal List Editor' can be arranged as follows:

1. Click on  to close a window.

2. Click on  to minimise a window.

Minimised windows are reduced to a button - click on the button to restore the window to its original size and
position.

3. To change the size of a window, point to the relevant margin or corner, and drag left/right or up/down
accordingly.

Note that the ‘Hardware Panel’ cannot be resized.

4. To move a window, place the mouse pointer over the title bar of the window. Then drag and drop the
window to its new position.
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6.4.6 The Main Menus

File

Use the File menu to:

· New – create a new AdminHD session.

· Open – open a Core configuration file (.csv).

· Open recent – open a recent .csv file.

· Close – close the current AdminHD session. You will be prompted to save before closing.

· File info - open a dialogue box with information about the AdminHD file.

· Save and Save as – save the Core configuration as a .csv file.

· Export file - export the following file types:

o Core cold start config (config.tcl) – the cold start Core configuration (for upload to the system).

o RAVENNA IP List (ravenna_ip_list.csv) – a list of the Device IDs and IP settings for all RAVENNA

nodes (for documentation purposes).

o Component List – a component parts list (for documentation purposes).

o BFE controller – a BFE controller file (for project-specific applications).

o Remote log - the contents of the ‘Remote Log’ (for diagnostic purposes).

· Exit – close the AdminHD software. You will be prompted to save before exiting.
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Remote

Use the Remote menu to:

· Online to remote system – enable (or disable) the online connection to the remote control system.

· Reconnect mode – when enabled, AdminHD attempts to automatically reconnect to the remote control
system if network communication is interrupted.

· Upload all data to remote HD – update the online Core configuration. This method should only be
used for testing purposes or to make temporary changes to the configuration.

· Upload file - upload the following cold start files to the remote system:

o Core cold start config (config.tcl) – the Core configuration.

o GUI cold start config (gui_config.tcl) – the Signal List configuration.

· Download all data from remote HD – download the online Core configuration from the remote
system.

· Download file – download the following cold start files from the remote system:

o Core cold start config (config.tcl) – the Core configuration.

o GUI cold start config (gui_config.tcl) – the Signal List configuration.

o System log messages - the control system log file.

· Reset system (cold send) – cold start the remote control system (available in online mode only).
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Extras

· Lock config - when enabled, the configuration cannot be edited. You can use this option to prevent
accidental changes while running AdminHD online (for system diagnostics).

· Parameter Box

o Comfort text edit mode or Stereo text edit mode - enable these options to use the naming short

cuts in the Signal 'Parameter Box'.

o Replace all signal labels with default name - use this option to replace all Signal Label fields

with the defaults.

o Replace all default HLSD classes with new Nework index - use this option to reset the HLSD

classes to the system network index (in a multi-system network). 

For example, if the index = 2, then the resulting default HLSD classes (in/out) = B2R and B2S.

· Show mapping table – opens an overview of the mapping tables 1 to 16.

· Check configuration – checks the Core configuration for programming errors.

· Preferences – opens the AdminHD Preferences window.

Window

Use these options to show or hide each of the configuration windows.
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Info

Select Info to check the version of the AdminHD software release.
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6.4.7 The Main Toolbar

The main toolbar is always visible. The first six icons provide fast access to common functions:

Open existing config file - opens an existing Core configuration (.csv). The same as File -> Open.

Save changed config file - saves the current Core configuration (.csv). The same as File -> Save.

Download all data from remote HD - downloads the online Core configuration from the remote
system. The same as Remote -> Download all data from remote HD.

Upload all data from remote HD - updates the online Core configuration. This option is available in
online mode only, and is the same as Remote -> Upload all data from remote HD.

Online to remote host - enables (or disables) the online connection to the remote system. The same
as Remote -> Online to remote system.

Preferences - opens the AdminHD Preferences window. The same as Extras -> Preferences.

The remaining icons show or hide each of the configuration windows:

Core Browser - displays the Core configuration in a tree-like structure. 

Parameter Box - displays the parameter window for the selected component.

Hardware Panel - displays a graphical view of the selected component.

Signal List Editor - provides everything required to manage the Signal List configuration.

Remote Log - logs all status messages for AdminHD and, when online, the connected control system.
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6.4.8 Preferences

1. Select Extras -> Preferences from the main menus, or click on the  Toolbar icon, or press CTRL + P
to open the 'Preferences' pop-up window.

2. Use the tabs to select a page.

3. Select or unselect a preference.

4. Click OK to save your changes.

5. Restart AdminHD or re-open the relevant window for the changes to take affect.

Your preferences are stored in the setup files for the software. Therefore, they will remain as you last left
them each time you start the program.

Preferences -> Common

· Disable graphic frame pop-up after creating new hardware – tick this box if you wish to stop
AdminHD automatically displaying the ‘Hardware Panel’ when new hardware is added to the configuration.

· Display large graphics (for extended screens) – select this option if you are working with a larger
screen (e.g. 21”). The graphics are doubled in size.

· Disable auto reconnect – tick this box to prevent AdminHD automatically reconnecting to the online
system if network communication is interrupted.

Preferences -> Startup

The start-up options apply when you open or create a new configuration. 

· Hide Core Browser – tick this box if you do NOT want the ‘Core Browser’ to appear automatically. 

· Show remote log – tick this box if you DO want the ‘Remote log’ to appear automatically.
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Preferences -> Directories

From here, you can specify the default directory paths which will be used each time you save, open, export or
download a file:

1. Click on the folder button next to the entry you want to specify – e.g. beside Config files. A file dialogue
box appears.

2. Select the folder where you usually want to save your files and click on Open. The file dialogue closes
and the path is displayed in the Preferences field.

3. Repeat for all the AdminHD file types:

· Config files – AdminHD configuration files (config.csv).

· Remote logfiles – ‘Remote log’ text files.

· Coldstart config files – config.tcl and gui_config.tcl files.

· Core log message files – system log text files.
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Preferences -> Signal List Editor

These preferences affect how the ‘Signal List Editor’ creates new signal lists.

The first two options affect mc2 mixing systems only:

· Enable physical Inputs/Monitors in DSP profile – tick this option to add the physical inputs of the mc2

input and monitor channel DSP channel to the default directories of the Destination page.

· Disable A/B of Inputs/Monitors in DSP profile - untick this option if you do NOT wish to add the mc2

input and monitor channel DSP signals to the default directories of the Destination page.

Enable physical Inputs/Monitors in DSP profile (ticked) Disable A/B of Inputs/Monitor in DSP profile (ticked)

The second two options affect all mc2/Nova systems:

· Show foreign signals if already in matrix list – affects networked systems. For further advice, please
contact your local Lawo representative or email support@lawo.com.

· Skip using device alias for directory auto creation - tick this option if you do NOT want to use the
Super-device alias names when directories are automatically added to the signal list.

mailto:support@lawo.com
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6.5 Working with the Configuration Windows

This section describes how to use each of the configuration windows.

6.5.1 The 'Core Browser'

The 'Core Browser' displays the system's hardware components in a tree-like structure. From here you can
navigate around the system, and add or remove components. When running online, it can also be used for
system diagnostics.

1. Select Window -> Core Browser from the main menus, or click on the  Toolbar icon, or use the
keyboard shortcut (CTRL + SHIFT + B) to show or hide the window.

The 'Core Browser' always appears on the left hand side of the central workspace.

2. Click on the + or – signs to open or close a branch of the system tree. Or, use the arrow keys on your
computer keyboard: Up/Down to navigate and Left/Right to open and close the selected branch.

3. Hover over an individual signal to display its parameters summary.

4. Right-click on a component to define its function or delete the resource.

Signal In Parameter Summary MADI Port Options

The System tree is arranged as follows:

System
Each configuration consists of a single System containing all the hardware components for your
installation.

Core Within the System, you define the Core.

Modules
The Core is then populated with Modules. For example, MADI, RAVENNA, DSP, etc. Standard
components, such as the Router module and PSUs are added automatically when you define the Core.

Ports

Each Module can then be opened to view its IO Ports.

In the case of a MADI or RAVENNA module, the ports can be defined for a number of options: for example,
to connect to a DALLIS, Compact IO, etc.

Cards If a remote IO device is added, then it can be populated with Cards - for example, MIC, LINE, etc.

Signals
At the lowest level of the system tree are the signals themselves - for example, Card 1 contains the
mic/line input signals: Signal In 1, Signal In 2, etc.
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Core Browser Toolbar

At the top of the 'Core Browser' is a toolbar which contains the following functions:

Collapse all sub nodes - collapses the selected branch.

Expand all sub nodes - expands the selected branch.

Copy - copies the selected component (including all sub nodes).

Cut - cuts the selected component (including all sub nodes).

Paste - pastes the copied component (including its sub nodes) to the selected branch.

Delete - deletes the selected component.

Alias - displays the device alias names rather than the Lawo system names.

6.5.2 The ‘Hardware Panel’

The ‘Hardware Panel’ provides a graphical view of the selected component, and can also be used to add or
remove components. When running online, it can also be used for system diagnostics.

1. First select a hardware component in the in the 'Core Browser'.

2. Then select Window -> Hardware Panel from the main menus, or click on the  Toolbar icon, or
use the keyboard shortcut (CTRL + SHIFT + F) to show or hide the window.

The ‘Hardware Panel’ can be positioned anywhere within the central workspace as described earlier.

Note that ‘Hardware Panel’ cannot be opened if System is selected in the 'Core Browser', as there is no valid
component to display!

3. Select a module in the 'Hardware Panel' and notice that the ‘Core Browser' selection follows. 

Similarly, select a different component in the ‘Core Browser' and notice that the 'Hardware Panel' updates.

4. Right-click on a component to reveal its configuration options.

Nova73 - Fit IO Module DALLIS - Fit IO Card
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6.5.3 The ‘Parameter Box’

The ‘Parameter Box’ is used to adjust settings for the selected component or signal. It works in conjunction with
the 'Core Browser' and 'Hardware Panel' to define the Core configuration.

1. Open the 'Core Browser' and double-click on a component or signal - for example, Signal In 1.

Or, select the component or signal in the system tree, and then select Window -> Parameter Box from the

main menus, click on the  Toolbar icon, or use the keyboard shortcut (CTRL + SHIFT + P) to show or hide
the window.

The 'Parameter Box' can be positioned anywhere within the central workspace as described earlier.

3. Select a different component or signal in the system tree and notice that the 'Parameter Box' updates.

4. Use the tabs in the window to page through the available options - for example: Signal, DSP and Map.

Note that:

· White parameter fields and drop-down menus can be edited.

· Grey parameter fields are usually for information purposes and cannot be modified.

· Check boxes can selected or deselected.

DALLIS Mic In - Signal Parameters Nova73 Core - System Settings
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6.5.4 The 'Remote Log'

The 'Remote Log' lists all the messages generated by AdminHD (and by the mc2/Nova control system when
running online). It is a good idea to open this window, especially when transferring data to or from a system.

1. Select Window -> Remote Log from the main menus, or click on the  Toolbar icon, or use the
keyboard shortcut (CTRL + SHIFT + L) to show or hide the window.

The 'Remote Log' always appears at the bottom of the central workspace.

The log displays all errors and queries since AdminHD was started - for example:

2. Scroll up to view the log history.

The ‘Remote Log’ stores all messages while AdminHD is running. If you exit AdminHD and re-open it, then the
previous log will be lost.

Ø  To save the log contents:

1. Right-click anywhere within the window, and select Export content.. (or select File -> Export File
from the main menus and choose Remote Log):

A "File -> Save" dialogue box appears.

2. Select a folder, enter a file name and click on Save.

The log is stored as a plain text file and can be opened by any common text editor.

You can specify a default directory for your logfiles under the Extras -> Preferences -> Directories.

Ø  To clear the log contents:

1. Right-click anywhere within the window, and select Clear content.. 

The existing contents of the ‘Remote Log’ are cleared.

6.5.5 The 'Signal List Editor'

See Signal List Configuration.
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6.6 How to Modify the System Configuration

You will need to modify the system configuration if you install a new device or change the hardware in any way. 

For the Core configuration, there are two possible methods: update the cold start configuration (config.tcl), or
upload the current AdminHD session to the online system. 

For the Signal List configuration, you must update the cold start configuration (gui_config.tcl), as an online
update of the Signal List is not possible.

WARNING: Following a cold start the system will always reset to the settings stored in the config.tcl and
gui_config.tcl files. So, for all permanent changes, you should always use the cold start update method.

Note that you only need to update the Signal List (gui_config.tcl) if you wish to add signals to, or rename
Directories or Subdirectories in, the console GUI's Signal List display.

From Version 5.14.0 and Image Version 1.10, every RAVENNA node runs a small tool that connects to the mc²56
MKII control system to get all of the information required to setup their streaming. This means that there is no
longer any need for the ravenna_config.zip file - everything is now included in the Core configuration
(config.tcl).

Updating the Cold Start Configuration

To modify the cold start configuration, please complete each of the following steps:

1. Install the AdminHD software.

2. Connect the AdminHD computer to the mc²56 MKII control system.

3. Backup the existing cold start configuration files (config.tcl and gui_config.tcl) from the remote system.

This step will ensure that the original .tcl files can be re-instated if required.

4. Cold start the mc²56 MKII control system (to reset the system to its cold start configuration).

5. Download the online configuration from the remote system into a new AdminHD session.

In this step, it is the online configuration which is downloaded. Therefore, by cold starting the system first, you will
ensure that the online configuration is identical to what is stored in the cold start files.

6. Edit the Core configuration (using the 'Core Browser', 'Hardware Panel' and 'Parameter Box').

7. Check the Core configuration for any programming errors.

8. Edit the Signal List configuration (using the 'Signal List Editor').

9. Export the Core and Signal List configuration cold start files (as a new config.tcl and gui_config.tcl).

10. Upload the .tcl files from your computer to the mc²56 MKII control system.

11. Cold start the mc²56 MKII control system and check the functionality.

Once you have tested the system, it is recommended to save the Core configuration as a .csv and the Signal List
configuration as .slx file. This will allow you to easily maintain the files in the future.

Updating the Online Configuration (Core configuration only)

For temporary changes or testing purposes, you can update the online Core configuration (stored in the warm
start data). This method does not require a cold start and, therefore, can be used for matrix installations where
continuous operation is required. See Updating the Online Configuration.

Preparing a Configuration (in advance)

If you are unable to connect to the mc2/Nova control system, then another option is to open an existing .csv
and/or .slx file. Take care that the .csv and .slx files are the latest versions for your system. If you are unsure,
then it is best to download the existing configuration, as described above, or request the latest files!

Creating a New Configuration (from scratch)

If you have neither a network connection or an existing .csv file and/or .slx file, then you will need to create a new
AdminHD session and build a configuration from scratch. Note that this method can be time consuming and is
not recommended for minor changes to an existing configuration!
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6.7 Updating the Cold Start Configuration

This section describes how to update the cold start configuration. We will assume that you have already installed

AdminHD and connected the AdminHD computer to the mc2/Nova control system.

6.7.1 Backing up the Cold Start Files

This step is optional but strongly recommended as it will allow you to reinstate the original .tcl files if necessary.

1. Select Remote -> Download file from the main menus, and choose Core cold start config
(config.tcl):

2. You are asked to specify a folder location and name for the file.

In our example, we have chosen the folder for the studio, and have renamed the file as BACKUP_config.tcl.

3. Click on Save.

AdminHD downloads the config.tcl file from the remote system and saves it in the specified folder using the
designated file name. Use the 'Remote Log' window to check the progress of the download.

4. Repeat steps 1 to 3, but this time choose GUI cold start config (gui_config.tcl) to make a backup
copy of Signal List configuration cold start file.
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6.7.2 Downloading the Online Configuration

This step downloads the online configuration data from the remote system. If you wish to work on the cold start
configuration, then make sure that you cold start the system before executing the download.

To download the Core configuration:

1. Select File -> New from the main menus to create a new AdminHD session. 

Take care to select the correct product option and, if you are downloading data from a mc236, Nova37 or Micro
Core, choose the correct maximum sampling rate (either 48kHz or 96kHz).

2. Select Remote -> Download all data from remote HD from the main menus, or click on the 
Toolbar icon, or use the keyboard shortcut (CTRL + D).

The following window appears requesting an IP address for the Remote connection:

3. Enter the IP address of your control system.

You can check the Lawo system's IP address from the console GUI: open the System Settings display and
select Global - the IP Address Primary = the IP address of the main control system.

If a single Router Module is fitted, then enter the main IP address only.

If main and redundant Router Modules are fitted, tick both boxes and enter both IPs; the redundant IP
address is always 1 higher than that of the main control system.

You can connect AdminHD to mxGUI by entering mxGUI's virtual IP address (192.168.56.101).

4. Now click on Connect.

AdminHD downloads the online Core configuration data from the remote system. Use the 'Remote Log' to check
the download progress.

If you have the 'Core Browser' or 'Hardware Panel' open, then you should see their contents update.

If there is a problem with the download, then:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system.

· See the trouble-shooting tips.



mc²56 MKII Technical Manual Version: 5.14.0/1 131/298

6. Configuration (AdminHD)

 To download the Signal List configuration:

The Signal List data can be downloaded in a similar manner, but this time from the 'Signal List Editor':

1. Select Window -> Signal List Editor from the main menus, or click on the  Toolbar icon, or use the
keyboard shortcut (CTRL + SHIFT + E).

A new default list of Directors & signals appears:

2. Click on the  button, from the 'Signal List Editor' toolbar.

AdminHD downloads the online Signal List configuration data from the remote system. Use the 'Remote Log' to
check the download progress.

After a successful download, the list of Directors & signals updates:

3. Click on the minimise button (top right) to hide the 'Signal List Editor' for now.

This window is described in more detail later.
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6.7.3 Editing the AdminHD Configuration

The Core configuration can be edited using the 'Core Browser', 'Hardware Panel' and 'Parameter Box' shown
below. The steps are described in more detail later. Once editing is complete, you can choose to update the
online configuration, or export and upload a new cold start config.tcl file (recommended).

'Core Browser' & 'Hardware Panel' - Fit IO Module 'Core Browser' & 'Parameter Box' - Edit Signal Parameters

The Signal List configuration can be edited using the 'Signal List Editor' shown below. The steps are described in
more detail later. Once editing is complete, you must export and upload a new cold start file (gui_config.tcl),
as an online update of the Signal List is not possible.

'Signal List Editor' - Adding Signals to a Source Directory
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6.7.4 Checking the Core Configuration

This step is optional but recommended, as it will check the Core configuration for any programming errors.

1. Select Extras -> Check Configuration from the main menus, or use the keyboard shortcut (CTRL +
K).

AdminHD analyses the configuration to check for the following errors:

· Signal HLSD Conflicts – if two signals have the same HLSD (Lawo system address).

· HLSD Syntax – if there is an invalid HLSD in the configuration.

· Signal Name Conflicts – if two signals have the same name.

· Mapping Table Address Conflicts – if you have assigned the same mapping table address to different
signals.

The result of the check is displayed within the status bar of the display:

If an error is reported, then try retracing your steps by opening an earlier saved version of the config.csv.
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6.7.5 Exporting the Cold Start Files

This step exports the configuration data from AdminHD, and stores it in a format which can be read by the

mc2/Nova control system.

You can specify a default directory for your cold start config files under Extras -> Preferences ->
Directories.

To export the Core configuration (config.tcl):

1. Select File -> Export file from the main menus, and choose Core cold start config (config.tcl):

2. You are asked to specify a folder location and name for the file.

Do NOT rename the file; it must be named config.tcl in order to be read by the mc2/Nova control system.

In our example, we have chosen the folder for the studio:

3. Click on Save - the Core configuration is exported and saved locally on your computer.
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To export the Signal List configuration (gui_config.tcl):

The Signal List configuration can be exported in a similar manner, but this time from the 'Signal List Editor':

1. Click on the  button, from the 'Signal List Editor' toolbar.

2. You are asked to specify a folder location and name for the file.

Do NOT rename the file; it must be named gui_config.tcl in order to be read by the mc2/Nova control
system.

In our example, we have chosen the folder for the studio:

3. Click on Save - the Signal List configuration is exported and saved locally on your computer.
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6.7.6 Uploading the Cold Start Files

Having exported the cold start files, you can now upload them from your computer to the mc2/Nova system.

Note that you can use this operation to upload any config.tcl or gui_config.tcl file. For example, a backup file,
or a file prepared on another AdminHD computer.

To perform a successful upload, you will need a valid network connection between your computer and the

mc2/Nova control system. AdminHD can remain offline to perform the upload.

1. Select Remote -> Upload file from the main menus, and choose Core cold start config (config.tcl):

A window appears asking you to select a file to upload.

2. Take care to select the correct file name - the config.tcl:

3. Click on Open - the file is uploaded to the remote system. Use the 'Remote Log' to check the upload
progress:

If there is a problem with the upload, then:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc²56 MKII system.

· See the trouble-shooting tips.

4. Repeat steps 1 to 3, but this time choose GUI cold start config (gui_config.tcl) followed by the
gui_config.tcl file to upload a new Signal List.
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6.7.7 Testing the Functionality

You will now need to cold start the system to test the functionality.

If the mc2/Nova system is fitted with a redundant Router Module, then you must disable the redundant
control system BEFORE cold starting. See Updating a Redundant System.

1. A cold start can be issued from AdminHD if you are running online - select Remote -> Reset system
(cold send) from the main menus:

2. Once the system has booted, open the console GUI's Signal Settings display - all configured
components should appear in the System tree.

If all components are powered and connected, then they will appear in grey.

If there is a problem, then you will see a red warning flag. See Diagnosing System Errors.

3. Open the Signal List display - any Signal List configuration changes should be reflected in the
Sources and Destinations structure.

If you have added signals from a new hardware device, then test the device by connecting its signals.



mc²56 MKII Technical ManualVersion: 5.14.0/1138/298

6. Configuration (AdminHD)

6.8 Saving the Configuration (as AdminHD Files)

At regular intervals you should save the configuration, and also use "save as" to keep a copy at different revision
stages. This will allow you to test the configuration and revert to an earlier version if necessary.

Note that you must do this separately for the Core and Signal List configurations if you are editing both aspects
of the system.

Saving the Core Configuration

The Core configuration can be saved locally on your computer as a .csv file.

Ø  File -> Save As

1. Select File -> Save As from the main menus, or use the keyboard shortcut (CTRL + SHIFT + S) - the
"Save" dialogue box opens:

2. Choose a folder location and enter a suitable file name.

You can use any name as long as it keeps the .csv suffix, but it is a good idea to keep the word "config" in the
name to distinguish it from other .csv files. See AdminHD Files.

3. Then click on Save to save the configuration.

Ø  File -> Save

From here on you can use File -> Save to overwrite the .csv file (specified in AdminHD's headline). 

Note that File -> Save can only be selected once there has been a change to the Core configuration (as
indicated by the * at the end of the file path):

1. Select File -> Save from the main menus, or click on the  Toolbar icon, or use the keyboard
shortcut (CTRL + S).

AdminHD saves the changes into the existing .csv file.
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Saving the Signal List Configuration

The Signal List configuration can be saved locally on your computer as a .slx file. This is handled in a similar
manner to the Core configuration but from the 'Signal List Editor'.

Ø  File -> Save As

1. Click on the  button from the 'Signal List Editor' toolbar - the "Save" dialogue box opens:

2. Choose a folder location and enter a suitable file name.

You can use any name as long as it keeps the .slx suffix, but it is a good idea to keep the words "signallist" in
the name for easy identification. See AdminHD Files.

3. Then click on Save to save the configuration.

Ø  File -> Save

From here on you can use File -> Save to overwrite the .slx file (specified in the 'Signal List Editor' headline). 

Note that File -> Save can only be selected once there has been a change to the Signal List (as indicated by
the * at the end of the file path):

1. Click on the  button from the 'Signal List Editor' toolbar.

AdminHD saves the changes into the existing .slx file.
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6.9 Editing the Core Configuration

The Core configuration defines the system core hardware, IO ports and all parameters. This includes system-
wide parameters such as sample rate, reference levels and sync; and individual parameters such as a signal's
HLSD address, name, etc.

The Core configuration can be edited using the 'Core Browser', 'Hardware Panel' and 'Parameter Box' windows.
All changes are made offline within the AdminHD session. Once editing is complete, you can choose to update
the online configuration, or export and upload a new cold start config.tcl file (recommended).

Defining the System

If you wish to add a component, such as a new remote IO device or plug-in card, then use the following steps.
Note that the same principles apply whether you are updating an existing configuration or building a new system
from scratch. The system is hierarchical, and therefore components must be added in the following order:

1. Define the Core.

2. Fit modules to the Core.

3. Define the IO ports: for example, add a DALLIS, Compact IO, Virtual Devices or Tie-Lines.

4. Configure the connected device: for example, fit cards to a DALLIS.

5. Define other options such as Link and Port redundancy, and DSP resources.

The steps are described in more detail over the next few pages. You should open the 'Core Browser' and
'Hardware Panel' to perform these tasks.

IMPORTANT: It is important that the configuration matches the physical installation. Otherwise
components may not operate correctly. Therefore, it is useful to have the specification details (part numbers
and options) to hand.

Editing Parameters

Once the hardware is defined, open the 'Core Browser' and 'Parameter Box' to check and edit the component's
parameters. In this section, we describe some of the most common tasks, such as editing the signal names.
For a description of all available parameters, please see Core Configuration Parameters.
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6.9.1 Defining the Core

For pre-configured systems, the Core should already be defined. If you are building a new configuration from
scratch, then the first step is to add the Core.

1. Right-click on System in the ‘Core Browser’:

2. Select an option to define the type of Core:

· HD Core (48kHz) - adds a Nova73 HD operating at sampling rates up to 48kHz.

· HD Core (96kHz) - adds a Nova73 HD operating at sampling rates up to 96kHz.

· Compact Core (48kHz) - adds a Nova73 Compact operating at sampling rates up to 48kHz.

· Compact Core (96kHz) - adds a Nova73 Compact operating at sampling rates up to 96kHz.

Take care to choose the correct maximum sampling rate as this cannot be changed later. Note that at higher
sample rates, the DSP resource and summing matrix capacity are halved. Therefore, you should only choose
96kHz if a higher sample rate is definitely required. Note that the operator can change the sample rate up to the
maximum from the System Settings display: Wordclock -> Sample Rate option.

The selected Core is added to the System tree, along with its standard components: Router module, PSU,
Redundant PSU and Resources.

Nova73 HD Nova73 Compact

Deleting the Core

If you want to change the Core, then you will need to delete it and make a new selection.

Note that deleting the Core will remove it, and all of its sub components, from the configuration, and so should
be used with caution.

1. Right-click on Core 1 in the 'Core Browser' and select Delete:

2. You are asked to confirm - select Yes to delete the Core, or No to cancel the operation.
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6.9.2 Fitting Modules to the Core

Next, add your IO and DSP modules to the Core as follows:

1. From the ’Hardware Panel’, right-click on a module slot and select a drop-down option:

Nova73 HD Nova73 Compact

The available options depend on the selected slot position. If an option is not permitted, then it will be "greyed
out".

To fit channel DSP modules (983/03 or 04), you must work from right to left across the core as described 
earlier. For example, in a Nova73 HD, assign slot 15 first, then slot 13, slot 11, and so on.

IMPORTANT: Take care to assign the modules to the slot positions so that they match the physical
installation.

Once assigned, the modules appear in the ‘Hardware Panel’ and ‘Core Browser’.

2. To remove a module right-click on the slot and select Empty. Or, go to the 'Core Browser', right-click on
the Module and select Delete.

Note that this will delete the Module, and all of its sub components, and so should be used with caution.

3. You are asked to confirm - select Yes to delete the Module, or No to cancel the operation.
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4. A redundant Router Module can be configured by right-clicking on the second Router Module slot in the
Core - select Available to add the module, or deselect Available to remove it.

Nova73 HD Nova73 Compact

Alternatively, right-click on the Core in the ‘Core Browser’ and select either add or remove redundant router
module. Or, open the 'Parameter Box' for the Core and edit the Redundant router module checkbox.

'Core Browser' 'Parameter Box'

5. For the Nova73 HD, you can add or remove the redundant power supply in a similar manner - open the
'Hardware Panel' for the Core and right-click on the second PSU slot to access the Available option.

Note that the second power supply cannot be removed from a Nova73 Compact.
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6.9.3 Defining the IO Ports

With the ‘Core Browser’, you can now open each IO module to view its individual ports.

In the case of an AES3 module, the port is predefined. In the case of a MADI, RAVENNA or DANTE module, the
ports require further configuration:

'Core Browser' - Define IO Port 'Core Browser' - Delete Device

1. Right-click on the port in the 'Core Browser' and select an option.

The available options vary depending on the module type and software release.

2. If you want to change the function of a port, then you will need to delete the current assignment. 

Right-click on the device (in our example, a DALLIS) and select Delete. Note that this will delete the current
device, and all of its sub components, and so should be used with caution.

You are asked to confirm - select Yes to delete the device, or No to cancel the operation. You can now return to
step 1 to make a new selection.
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6.9.4 IO Port Options

DANTE Ports

For DANTE ports there is only one option:

· Tie-Line - adds 64 tie-line channels for connecting to and from an external DANTE device.

MADI Ports

For MADI ports you can choose:

· DALLIS - adds a DALLIS frame. You can choose 3RU or 6RU, and 60 or 52 bi-directional channels. Any
spare link capacity is used for DSP resources.

· Tie-Line - adds a number of bi-directional MADI tie-line channels. You can choose 64 channels only, or
56 channels + DSP resources.

· Local IO mc256 - adds a connection to the mc256 Local IO frame + DSP resources.
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RAVENNA Ports

RAVENNA Link Port Options RAVENNA Net Port Options

For RAVENNA ports, the options are divided into two menu branches which specify the type of connection:
either RAVENNA Link or RAVENNA (Net), and then the port's function: DALLIS, Tie-Line, etc.

The options are similar to those available for a MADI port, with the following exceptions and additions:

· There are no DSP resources for RAVENNA IO ports.

· DALLIS and Tie-Line ports support 128 bi-directional channels (as opposed to 64).

· The Compact IO and Local IO mc296 are supported.

· Virtual Devices and Virtual DALLIS ports are supported by RAVENNA Net.

The ports can be assigned individually to either a RAVENNA Link or RAVENNA Net device.

For RAVENNA Link, you can configure port redundancy (for a DALLIS with two master boards).

For RAVENNA Net, an odd/even pair of ports (1+2 or 3+4) can be configured for redundant streaming (via SPS) if
the connecting device is SMPTE 2022-7 compatible.

In the 'Core Browser' an undefined RAVENNA port is indicated by the [MX] suffix ("mixed"). Once defined, the
suffix updates to [RVL], [RV] or [SPS] to indicate the type of connection.

IMPORTANT: Take care to assign the ports so that they match the physical installation.

The table below summarizes the port options. Note that SPS can be configured for RAVENNA Net only.

Port Option Description RVL RV SPS

DALLIS 3RU 3RU DALLIS frame with 128 bi-directional channels ü ü û
DALLIS 6RU 6RU DALLIS frame with 128 bi-directional channels ü û û
Tie-Line 128 bi-directional tie-line channels ü ü ü
Compact IO Compact IO stagebox ü ü û
Local IO mc256 Local IO frame for the mc256 MKII console ü ü û
Local IO mc296 Local IO frame for the mc296 console ü ü ü
Virtual Devices 16 x 8-channel Virtual Device slots û ü ü

Virtual DALLIS
3RU DALLIS frame with 64 bi-directional channels plus a "virtual"
port for a second 64-channel DALLIS

û ü û

In each case, the connection supports 128 bi-directional channels.
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6.9.5 IO Port Definitions

DALLIS

The DALLIS frame is added to the System tree along with its standard components. These include a single
Masterboard (947/22). You should configure port redundancy if a second master board is installed. Then
populate the DALLIS frame in the usual manner.

Local IO or Compact IO

The Local IO or Compact IO frame is added to the System tree along with its standard components. Note that,
unlike a DALLIS, you cannot adjust the IO card allocations!
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Tie-Line

The corresponding Tie-Line signals are added to the System tree and are now ready for use.

RAVENNA Link Tie-lines are often used as "Netlinks"' to share IO resources with other mc2/Nova systems. This
option requires some .tcl file configuration.

RAVENNA Net Tie-lines can be used to stream audio to/from a RAVENNA/AES67 network. Once the Core
configuration has been uploaded to the system, open a RAVENNA Web UI connection to the 981/61 IO module
to set up the TX and RX streams.
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>> DANTE SRCs

For each DANTE Tie-line port, you can choose to enable (or disable) the Sample Rate Converters:

When enabled, you can run your DANTE studio network independently from the broadcast clock, or bridge
between 96kHz DANTE and 48kHz RAVENNA networks (or vice versa):
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Virtual Devices (RV only)

Each Virtual Devices port can support up to 16 devices. To assign the devices:

1. Right-click on the Virtual Devices port, and assign a device to each Slot position:

Note that you can assign virtual devices to the 16 slots in any order, as it is the Device ID and Streaming unit
IP address which are important.

The first four options will specify a hardware device: A_mic8, A_dig8, LCU or DMI-8. Or, select Tie Line to
prepare a set of 8 streaming channels. These can be used to stream audio only, without parameter control, to
and from any RAVENNA-compatible node on the network.

In each case, the device or Tie-line is added to the 'Core Browser' and 'Hardware Panel':



mc²56 MKII Technical Manual Version: 5.14.0/1 151/298

6. Configuration (AdminHD)

Virtual DALLIS (RV only)

This port option can be used to connect two 64-channel DALLIS frames via a single 981/61 RAVENNA Net
interface.

1. First, right-click on the RAVENNA IO port and select the DALLIS 3RU RV + 1 x virtual port option:

This adds the first 64-channel DALLIS frame plus a new virtual port (Port 5 RV Virtual).

Note that the term "virtual" is used to indicate that port 5 only exists virtually - i.e. there is no actual physical
interface for port 5!

2. Right-click on the virtual port to add the second DALLIS frame:

You can now populate the frames in the usual manner.
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6.9.6 Fitting Cards to a DALLIS

Cards are fitted to a DALLIS in a similar manner to fitting modules to the Core:

1. Right-click on a card slot and select a drop-down option:

DALLIS (connected via MADI)

The available options depend on the DALLIS Masterboard, the selected slot and the capacity of the DALLIS. If a
card is not supported, then it will be "greyed out" to prevent you configuring an illegal option.

2. Right-click on PSU 2 to add or remove a redundant power supply:

You can check how many audio channels are left by looking in the title bar of the DALLIS frame.

The DALLIS master board type cannot be altered, as this is determined when you define the Core's IO Port.

IMPORTANT: Take care to assign the cards to the slot positions so that they match the physical
installation.



mc²56 MKII Technical Manual Version: 5.14.0/1 153/298

6. Configuration (AdminHD)

6.9.7 Copy, Cut & Paste

If you are fitting several components of the same type, then you can use copy and paste to speed up the
configuration.

Note that all sub components and parameters are copied. Therefore, it is best to configure the device completely
(including all parameters), before using copy, cut and paste.

Copy & Paste from the 'Hardware Panel'

The example below shows how to copy and paste a DALLIS MIC card, but the same principles can be applied to
any configurable component.

1. Right-click on the source DALLIS card and select Copy:

The card is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom of the display:

2. Then right-click on the destination card slot and select Paste:

The card, and all of its parameters, are pasted into the destination slot.

3. Repeat step 2 to quickly assign the same card to a number of slots.

4. Select Cut (in step 1) to move a card to a different slot.

Note that Paste is only available if you select a valid destination. For example, if the DALLIS runs out of
audio channels, then you will not be able to select Paste.
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Copy & Paste from the 'Core Browser'

1. Right-click on the source component - for example, a complete DALLIS - and select Copy:

The device is copied to AdminHD's clipboard; the address is shown in the status bar at the bottom of the display:

2. Then right-click on the destination Port and select Paste:

The DALLIS, including all of its cards and parameters, are pasted into the configuration.

3. Repeat step 2 to paste the same DALLIS configuration to multiple ports.

4. Select Cut (in step 1) to move a DALLIS to a different port.

Note that Paste is only available if you select a valid destination. For example, you can only paste a
RAVENNA DALLIS to another RAVENNA port.
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6.9.8 Port Redundancy

To configure port redundancy, two master boards must be fitted to each DALLIS. Each connects to a different
Nova73 IO port, preferably on a different module.

To support this feature, your system must be fitted with two master boards per DALLIS, plus enough spare IO
ports in the Nova73 to support the connections.

This feature can be selected for devices connected via MADI, RAVENNA Link or RAVENNA Net.

To configure the redundant port:

1. Select Module 4 Port 1 and double-click to open its ‘Parameter Box’.

2. Tick the Is redundant option - a pop-up appears asking you to select the redundant port:

3. Select a port – in our example, Module 6 Port 1 and click OK.
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The ports are now linked as indicated in the ‘Core Browser’:

Note that the ‘Parameter Box’ for Module 4 Port 1 shows the address of the linked port within the
Corresponding port box. This is described as a system address:

4. If you now select the DALLIS and look at its ‘Hardware Panel’, you will see that a redundant master board
has been fitted:

To remove port redundancy, either deselect the Is redundant option in the main port's 'Parameter Box'. Or, right-
click on the redundant master board in the DALLIS 'Hardware Panel' and deselect Available.

You will be asked to confirm if you wish delete the port redundancy, Yes or No.
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6.9.9 DSP Resources

Matrix Resources

On every system fitted with the Router MKII module, you will find eight summing matrices (8x8) which appear in
the System tree as Resources within the Core.

Port Resources

Additionally, for systems fitted with MADI ports, you may find some DSP Resources within the MADI Port.
These appear if you define a MADI Tie-line or DALLIS which is 60-channels or less. The amount of resource is
defined when you configure the MADI port - for example, defining a 52-channel DALLIS leaves 12 free channels to
support one 4x4 plus one 8x8 DSP resource.

Configuring the Resources

Both types of resource can be used for console monitoring, downmix matrices or other customer-specific
summing functions.

1. Right-click on the Resources in the 'Core Browser' to define an option:

· Listen stereo or Listen surround – creates a stereo or surround matrix suitable for console monitoring.

· Matrix (4 * 4) or Matrix (8 * 8) – creates a generic summing matrix.

If you wish, you can name each matrix by giving it an alias name.
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Configuring a Downmix Matrix

To configure a surround downmix matrix:

1. Assign the Matrix (8 * 8) option to one of your 8 x 8 resources (as described on the previous page).

2. From the ‘Core Browser’, double-click on the matrix to open its 'Parameter Box', and tick the Downmix
matrix option:

Once the configuration is uploaded to the system, you will be able to control the surround downmix from the
console GUI's Downmix display.

To access the inputs and outputs of a matrix, the signals must be added to the Signal List configuration
(gui_config.tcl) using the 'Signal List Editor'.
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6.9.10 IP Settings & Device IDs (RAVENNA/AES67)

In a mc2/Nova RAVENNA installation, AdminHD should be used to define the IP settings and Device IDs for the
981/61 streaming ports and their partnering devices.

HD Core Port IP Settings

The 981/61 streaming ports are known as the HD Core ports. To define their IP settings:

1. From the 'Core Browser', double-click on the partnering device which will connect to the 981/61 streaming
port - its 'Parameter Box' opens.

Note that for a Virtual Device, you will need to double-click on Virtual Devices rather than the device itself.

DALLIS Parameters Virtual Devices Parameters

2. Edit the HD Core port IP fields - you must enter a unique IP address and suitable netmask and gateway.

To make it easy to identify the streaming ports within the Web Browser Interface and/or RAVENNA Web UI, it is
a good idea to adopt an IP address numbering convention. For example:

· IP addresses ending in 121 to 124 = IO module slot 2, ports 1 to 4.

· IP addresses ending in 141 to 144 = IO module slot 4, ports 1 to 4, and so on.

IMPORTANT: The IP settings must match those stored locally on the device.

3. The SPS fields, if supported, are used to configure SMPTE 2022-7 compatible streaming.

4. The Disable automatic stream generation option will stop the system creating the automatically-
configured streaming connections. In this instance you will need to configure the streams manually using the
RAVENNA Web UI.
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Device IDs for Partnering Devices

To define the Device ID for each partnering device:

1. From the 'Core Browser', double-click on the partnering device which will connect to the 981/61 streaming
port - its 'Parameter Box' opens.

For a DALLIS, Local IO or Compact IO, this is the same 'Parameter Box' as used to define the HD Core port IP
settings. For a Virtual Device, this is the device's 'Parameter Box' (e.g. A_mic8).

DALLIS Parameters A_mic8 Parameters

The default Device IDs use a format that depends on where the device is connected. For example:

· Device ID = S04P01_D - is a DALLIS connected to Module slot 4, Port 1.

· Device ID = S04P02_I - is either a Compact IO or Local IO connected to Module slot 4, Port 2.

· Device ID = S04P03_V01 - is a Virtual Device connected to Module slot 4, Port 3, Virtual Device Slot 1.

2. Edit the field to customize the Device ID. 

Each Device ID must be unique. Short, descriptive names are recommended. Use only normal characters,
numbers and "_" or "-" without spaces. Up to 31 characters are permitted.

For a Virtual DALLIS port, remember to enter a Device ID for both the first and second DALLIS frames. For a
Virtual Devices port, remember to enter a Device ID for each of the assigned slot positions.

IMPORTANT: The Device ID must match the value stored locally on the device.
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Device IP Settings

For all Virtual Devices, the control system must also know the IP settings of each individual device. Note that this
step is not required for a DALLIS, Local IO or Compact IO, as the combination of the HD Core port IP settings
and Device ID is enough. 

You can view the settings from the front panel display on an A__line device, or via the "settings preconfig activate"
script. To enter the settings into the AdminHD configuration:

1. From the 'Core Browser', double-click on the Virtual device (e.g. A_mic8) - its 'Parameter Box' opens.

A_mic8 Parameters

2. Edit the Device IP fields so that they match the IP address, netmask and gateway stored locally on the
device.

Device IDs for 981/61 IO Modules

Each 981/61 IO module also has a Device ID which is displayed in the RAVENNA Web UI Home page, and so is
useful for identication purposes. To define the Device ID for a 981/61 IO module:

1. From the 'Core Browser', double-click on the module - its 'Parameter Box' opens:

981/61 IO Module Parameters

The default Device ID for the 981/61 IO module use the format "Syy" where yy = the slot number. 

2. Edit the field to customize the Device ID.

The Device ID must be unique. Short, descriptive names are recommended. Use only normal characters, numbers
and "_" or "-" without spaces. Up to 31 characters are permitted.
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6.9.11 Configuring SMPTE 2022-7 (SPS)

In a mc2/Nova RAVENNA installation, AdminHD can be used to configure SMPTE 2022-7 compatible streaming.

1. Add a SMPTE 2022-7 compatible device to the odd numbered port of the 981/61 IO module in the usual
manner. Note that it is important to define the odd numbered port, as opposed to even, otherwise you will not
see the SPS options.

In the current release, you this means either a Tie-Line or Virtual Devices port, and for Virtual Devices, assign
either an A__mic8 or A__dig8.

Note that you will only see the SPS options if you configure a SMPTE 2022-7 compatible device. For example, if
you assign a DALLIS then the SPS fields are not supported.

2. Define the IP settings and Device IDs, as described earlier, to configure the first network path.

3. Then enable the SPS 2022-7 streaming redundancy checkbox - you will see that the [RV] suffix in the
'Core Browser' updates to [SPS] for both the odd numbered port and its even numbered partner.

4. Now use the SPS partner port IP fields to define the IP settings for the second network path.

Tie-Line Parameters

Virtual Devices Parameters
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5. For any Virtual Devices, you must also enter the IP settings for the SPS partner port. 

These should match the IP address, netmask and gateway stored locally on the device. For example:

A_mic8 Parameters



mc²56 MKII Technical ManualVersion: 5.14.0/1164/298

6. Configuration (AdminHD)

6.9.12 Signal Parameters

1. From the ‘Core Browser’, double-click on a signal to open its 'Parameter Box', and select the Signal tab:

The fields include the Signal name and Signal label, which correspond to the Name and user Label which
appear in the console GUI's Signal List display.

mc2 Signal List display

The Signal name is stored only by the Core configuration, and cannot be edited by the user. It should be used to
provide a "fixed" signal name relevant to the installation.

The Signal label is the label which the system resets to after a cold start. Users can change the labels later
from the Signal List display.

Both the Name and Label are limited to a maximum of 8 characters.

Ø  To edit an individual Signal name:

1. Click in the Signal name field, and type in the new name - you can enter up to 8 characters.

2. Press Enter to confirm.

Ø  To copy and paste a Signal name:

Once you have selected the text in the Signal name field, use the PAGE UP or PAGE DOWN keys (on your
computer keyboard) to navigate up or down the system tree while retaining the selected field:

Combine this with CTRL + C / CTRL + V, to copy and paste text between different entries in the list of signals. 
This short cut can be applied to any text field.
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Editing a Range of Signal names

Select Extras -> Parameter Box from the main menus and enable either Comfort text edit mode or Stereo
text edit mode:

Ø  Comfort text edit

You can use this mode to quickly name a range of signals using a numerical suffix - e.g. MIC1, MIC2, MIC3, etc.

1. Name the first signal (e.g. GUEST_01) and leave your cursor in the field you wish to carry forward:

2. Now press CTRL + SHIFT + PAGE DOWN.

AdminHD steps down to the next signal in the system tree, and carries forward the text entry - if there is a
number at the end of the name, then its value is incremented:

3. Continue pressing CTRL + SHIFT + PAGE DOWN to name all the signals in your range.
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Ø  Stereo text edit

This mode is very similar but is designed to quickly name a range of stereo signals - e.g. CD1L, CD1R, CD2L,
CD2R, etc. 

Repeat the steps above but add a L to end to the signal name you wish to carry forward. This time when you
press CTRL + SHIFT + PAGE DOWN, AdminHD increments both the numerical value AND applies an R to the
next signal name field. Continue pressing CTRL + SHIFT + PAGE DOWN to name all the signals in your stereo
range:
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6.9.13 Using Alias Names

For each component you can enter an alias name to help identify components in AdminHD. The names are used
only within AdminHD, and are not transferred to the remote control system.

You can display the alias names in the 'Core Browser' by enabling the Alias button on the toolbar:

Alias off Alias on

The alias names are also used by the 'Signal List Editor' (within the Hardware Tree).

Ø  To enter an alias name:

1. From the ‘Core Browser’, double-click on the component to open its 'Parameter Box', and select the Data
tab:

2. Enter a name into the alias field.

In our example, an alias has been entered for the Core and Module 2:

Core -> Data Module -> Data

If the field is left empty, then a default system name is used to describe each component.



mc²56 MKII Technical ManualVersion: 5.14.0/1168/298

6. Configuration (AdminHD)

6.9.14 Editing the System IP Address

The Core -> Connection parameters can be used to set the TCP/IP address of the mc²56 MKII control system
(i.e. the ETHERNET B IP address):

1. From the ‘Core Browser’, double-click on the Core to open its 'Parameter Box', and select the
Connection tab:

2. If a single Router Module is fitted to the Nova73, then enter the main Remote IP address only.

3. If main and redundant Router Modules are fitted, then also tick Remote IP redundant enable. This
enables the redundant Router Module and automatically sets the Remote IP address redundant - always 1
above the Remote IP address.

We recommend keeping the default IP addresses, where possible, as this will simplify remote maintenance.
However, if your mc²56 MKII is part of a larger network, then it will need a unique IP address.

6.9.15 Defining the Multi-channel Sync Source

The Multichannel Sync Source options (under Core -> Data) set the multi-channel sync source. Two possible
modes are available:

· PTP - to transmit or receive PTP to or from a RAVENNA streaming network.

· Port - to sync to incoming signal arriving on a MADI or RAVENNA Link port.

The options are mutually exclusive; it is not possible to use PTP and Port synchronization at the same time.

1. From the ‘Core Browser’, double-click on the Core to open its 'Parameter Box', and select the Data tab:

2. Use the Multichannel sync source selection menu to choose either PTP or Port. 

The selection "unlocks" the next steps.
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Multichannel Sync = PTP

To configure the system for PTP synchronization:

1. Set the Multichannel sync source selection to PTP.

2. Tick the Enable PTP sync board option and choose a RAVENNA IO module:

Choose a module that will remain connected to the streaming network at all times.

2. Select OK to confirm - the system address of the selected module appears in the PTP sync board field
(for information purposes):

Once the configuration is uploaded, use the Word Clock options in the System Settings display to make
Multichannel sync active.

When operating as a PTP Master, the Core will transmit PTP to the network. When operating as a PTP Slave,
the Core will receive PTP from the network. Note that PTP is transmitted or received on all of the selected
module's RAVENNA Net ports.



mc²56 MKII Technical ManualVersion: 5.14.0/1170/298

6. Configuration (AdminHD)

Multichannel Sync = Port

To configure the system for Port synchronization:

1. Set the Multichannel sync source selection to Port.

2. Tick the Enable sync port 1 option and choose either a MADI or RAVENNA Link Tie-line port:

Choose the port which will receive the synchronization signal. Note that you can select only a Tie-line port, and
not one configured for a DALLIS, Compact IO, etc.

3. Select OK to confirm - the system address of the selected port appears in the Multi-channel sync port
field (for information purposes):

4. Optionally, you can configure a backup sync port by repeating steps 1 and 2 but this time using the
Enable sync port 2 option.

Once the configuration is uploaded, use the Word Clock options in the System Settings display to make
Multichannel sync active.

If signal arriving at sync port 1 is lost, then the system automatically switches to sync port 2 (if port 2 is
configured). If signal arriving at both ports is lost, then the system switches to the next sync signal in the priority
list (according to the Wordclock options in the System Settings display).



mc²56 MKII Technical Manual Version: 5.14.0/1 171/298

6. Configuration (AdminHD)

6.9.16 System Operating Levels & Sample Rate

The Core -> System settings parameters can be used to define the operating levels and internal sampling
frequency which the system will reset to after a cold start.

1. From the ‘Core Browser’, double-click on the Core to open its 'Parameter Box', and select the System
settings tab:

System Operating Levels

There are three level settings which interact to define the internal and analog-to-digital operating levels of the
system:

· Maximum analog Level = Reference Level + Headroom

The system supports a maximum analog level = +24dB, and a minimum analog level = +12dBu.

WARNING: changing the Reference Level or Headroom will move the internal 0dB operating point for the
system, and thereby change the behaviour of level-dependent settings such as dynamics processing and
metering. Therefore, it is NOT advisable to alter these levels once dynamics processing has been set.

For systems fitted with fixed level analog IO cards:

· The Headroom and Reference Level cannot be altered independently. For example, with a +15dBu
fixed analog IO card and +9dB Headroom, the Reference Level must be +6dBu.

· The maximum analog level of the whole system is defined by the DALLIS card with the lowest GDA
(General Device Address) - this is the card with the lowest address fitted to the DALLIS frame connected
to the lowest port number of the first Nova73. (If a different fixed level analog card is fitted elsewhere within
the system, then a warning appears in the log file; however, the card with the lowest GDA still wins.)

To set the levels:

1. Select the Analog full-scale level from the drop-down menu options.

2. Then set the Reference level by clicking on the up and down arrows - the resultant Headroom is
calculated automatically.

Note that users can change the levels later from the console GUI's System Settings display (via the Level
options).

Internal Sampling Rate

1. Select the Sampling frequency from the drop-down menu.

The available options are determined by the maximum sample rate. This was defined earlier when you added the 
Core (or, for micro core systems, created a New configuration).

If your system includes Virtual Devices, such as Lawo's A__line, then the sample rate of these devices must
be changed manually using the RAVENNA Web UI.
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6.9.17 Mapping Tables

Lawo’s Remote MNOPL protocol is a freely available Ethernet (TCP/IP) protocol providing control of virtually any
system parameter from an external device. 

A typical application is to provide third-party matrix control so that crosspoints within the mc²56 MKII’s routing
matrix can be controlled by external control systems such as VSM, Evertz, Quartz, BFE, Pharos and others. (If
your preferred supplier does not support the protocol, then please ask them to contact Lawo for further details):

Within your AdminHD configuration, each signal can be given a mapping address. Up to 16 different mapping
tables can be defined so that different control systems can be supported simultaneously.

Ø  To configure the mapping tables:

1. From the ‘Core Browser’, double-click on the Core to open its 'Parameter Box', and select the Map tab.

2. For your chosen mapping table (01 to 16), enter the signal addresses which will be submitted to the
external control system:

· unknown signal - submitted when an undefined source is connected to a defined destination.

· no signal address - submitted when a signal is disconnected.

Please refer to your external control system’s documentation for details on which addresses to enter. The
example below shows the addresses for a Lawo radio on-air control system.

3. Now select the first signal you wish to map to the controller, and select the Map tab.

4. For your chosen mapping table (01 to 16), assign the Mapping table address.

The format of the address will be specified by your external control system.

Core -> Map Signal In -> Map

5. Repeat for all the signals you wish to control from your external device.
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6. You can get an overview of the assignments by selecting Extras -> Show Mapping Table x from the
main menus:

Extras Menu Mapping Table (example)
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6.10 Editing the Signal List Configuration

The Signal List configuration defines the organization of the console GUI's Signal List display.

The Signal List configuration is edited using the 'Signal List Editor' window. All changes are made offline within the
AdminHD session. Once editing is complete, you must export and upload a new cold start file (gui_config.tcl),
as an online update of the Signal List is not possible. This means that to make changes to the Signal List
configuration, the system requires a cold start.

Signal List Structure

The Signal List supports three levels: directories, subdirectories and signals.

The 'Signal List Editor' can add, remove and rename directories and subdirectories, and organise signals into
subdirectories. You can add a signal to more than one subdirectory if you wish.

Note that there are some default directories which cannot be edited. And, it is not possible to edit signal names
from the 'Signal List Editor' (as these are defined by the Core configuration as described earlier).
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6.10.1 The 'Signal List Editor'

The ‘Signal List Editor’ provides everything required to modify the Signal List configuration. From here you can
download, edit, export and upload the cold start Signal List configuration file (gui_config.tcl). Or, save a copy of
the Signal List as an AdminHD file (.slx).

1. Select Window -> Signal List from the main menus, or click on the  Toolbar icon, or use the
keyboard shortcut (CTRL + SHIFT + S) to show or hide the window.

AdminHD analyses the current Core configuration and then opens the ‘Signal List Editor’. The window can be
positioned anywhere within the central workspace as described earlier.

The ‘Signal List Editor’ is divided into two pages: Source and Destination, each with three columns.

2. Click on the Source and Destination tabs to change between the two pages.

'Signal List Editor' - Source page

The three columns are used to configure the Source (or Destination) Signal List as follows:

Directories &
signals

This is the configured Signal List.

Use the + or – signs to open or close a directory/subdirectory. 

Double-click on the name to edit the name of a directory/subdirectory. 

Right-click to create (or delete) a directory/subdirectory, change the order or add the Selected
signals.

Hardware Tree

This column lists all the available signals defined by the current Core configuration.

The list uses the alias names (if entered). Otherwise, default system names are used to describe
each component. For example, MO4PO1DAL64 indicates:

· MO4 = the Module slot position (e.g. Module 4).

· PO1 = the port on the Module (e.g. Port 1).

· DAL64 = the device on the port (e.g. a DALLIS with 64 audio channels).

Use the + and – signs to open and close the branches of the Hardware Tree.

If you add or remove a component in the Core configuration, then click on the  button (in the
Signal List Toolbar) to update the Hardware Tree.

Selected
signals

This column is used to prepare a list of signals which can then be added to a subdirectory in the 
Directories & signals list.

First, use the Hardware Tree to select the signals. You can click on an individual card or signal. Or,
use SHIFT + click to select a range of signals, or CTRL + click to select non-consecutive signals.
Your selections are added to the Selected signals column. Note that signals in red have already
been assigned to a subdirectory; those in black have not.

Click on the  button to add the Selected signals to the current subdirectory.
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6.10.2 The 'Signal List Editor' Toolbar

At the top of the 'Signal List Editor' is a toolbar which is always visible.

Note that if a button is "greyed out" then it is is not currently available - for example, you cannot Add a new
directory until a valid position is selected in the Directories & signals list.

The first seven icons provide access to data-related functions:

New config - creates a new signal list.

Open config - opens an existing Signal List configuration (.slx).

Attach existing config - 

Save config - saves the current Signal List configuration as a .slx file.

Save config as - saves the current Signal List configuration under a new file name/path.

Export to cold start config - exports the current Signal List configuration as a cold start
gui_config.tcl file.

Download GUI signal list from control system - downloads the online Signal List configuration from
the remote system.

The next seven icons provide editing functions for the Directories & signals column:

Copy node(s) - copies the selected signal or directory to the clipboard.

Cut node(s) - cuts the selected signal or directory (and copies it to the clipboard).

Paste node(s) - pastes the clipboard data to the selected directory.

Move node(s) up or down - moves the position of the selected signal or directory.

Add new directory / subdirectory - adds a new directory or subdirectory.

Delete - deletes the selected signal or directory.

The remaining icons are:

Locate signal - select a signal within the Directories & signals column, and then click this button to
reveal its position within the Hardware Tree.

Generate automatic tree view - use this button to quickly generate a Signal List from your hardware
components. It will automatically add the directories and signals from the Hardware Tree into the
Directories & signals column. The structure uses the alias names (if entered). Otherwise, default
system names are used to describe each component 

Update hardware signal config -  click on this button to update the Hardware Tree if changes have
been made to the Core configuration. For example, if a you add or remove a hardware component.

Duplicate directory structure - click to copy the directory structure from the Directories & signals
column from the Source to Destination page (or vice versa).
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6.10.3 Signal List Configuration: First Steps

The available signals listed in the Hardware Tree are defined by the current Core configuration. Therefore, it is
important to first download or open the correct Core configuration.

Then either download the existing Signal List from the remote system, or open a saved .slx file stored locally on
your computer. 

Alternatively, if you have neither a network connection or an existing .slx file, then you will need to create a new
AdminHD session and build a Signal List from scratch.

6.10.4 Creating a New Signal List

A new ‘empty’ Signal List is created each time you open the ‘Signal List Editor’. However, if you wish to clear
the existing data to start afresh, proceed as follows:

1. Click on the  button from the 'Signal List Editor' toolbar.

2. If changes have been made to the current Signal List, then you are asked if you wish to save before
proceeding:

Select Yes to save the configuration (as a .slx file), or No to continue without saving. (Alternatively, click on the
red/white cross to cancel the dialogue box and the operation.)

A new default list of Directors & signals appears. Note that this includes the system's default directories and
an unnamed entry (New_dir_001 and New subdir_001):
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6.10.5 Opening a Saved Signal List

To open an existing Signal List configuration (.slx file) stored on your computer:

1. Click on the  button from the 'Signal List Editor' toolbar.

2. If changes have been made to the current Signal List, then you are asked if you wish to save before
proceeding:

Select Yes to save the configuration (as a .slx file), or No to continue without saving. (Alternatively, click on the
red/white cross to cancel the dialogue box and the operation.)

3.  A file explorer window now appears - select a file to open and click on Open.

The file opens, with the file path and name at the top of the 'Signal List Editor' window:

If there is a problem opening the file, then check the file type and the AdminHD version:

· The 'Signal List Editor' can only open .slx files (not .tcl or .csv). 

· .slx files saved using a newer release of AdminHD are not backwards compatible.

Also, does the file contain signals which are not supported by the current Core configuration? If so, then some
parts of the Signal List will not load.
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6.10.6 Defining the Directories & Subdirectories

When editing a Signal List, the first step is to define each directory and its subdirectories. 

1. Select an entry in the Directories & signals column and then right-click and select Create new
directory.

A new directory is added below your selection and given a default name.

2. Double-click to edit the name - you can enter up to 16 characters. 

It is best to keep names as short as possible for easy operation from the console GUI.

3. Repeat steps 1 and 2 to create and name each directory and all of its subdirectories. 

Insert new directory Rename directory Directories example

4. Right-click on a directory (or subdirectory) and select Move up or Move down to move the entry up or
down the list.

5. Right-click on a directory (or subdirectory) and select Delete to remove the entry.

Note that you cannot delete, rename or move any of the default directories at the top of the list.

Remember that there are two pages for each side of the Signal List display, and so you will need to repeat the
steps for each page: Source and Destination. Or, use the Duplicate directory structure toolbar function.

Default Directories

For the mc2 mixing consoles, you will see some default Source and Destination directories which cannot be
edited or deleted. These provide access to the console's channel DSP resources (Input/Mon A+ B, Bus Out,
Direct Out, Insert Send/Return), and other options dependent on your Core configuration (mxDSP Signals):

Source Page Destination Page

You can select whether the Input/Mon A + B directory appears from the Extras -> Preferences -> Signal List
Editor options.

You will only see the mxDSP Signals directory if an mxDSP module has been added to the Core configuration. 
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6.10.7 Adding & Removing Signals

Once a subdirectory has been defined, you are ready to add the signals:

1. First, use the Hardware Tree to build up a list of signals in the Selected signals column.

Note that any entries in red have already been assigned somewhere in the Signal List; those in black have not.

· To select all the signals from a card, click on the card name.

· To select a consecutive range of signals, press and hold SHIFT and then select the first and last signal,
or first and last card. 

· To select non-consecutive signals, press and hold CTRL and then click on the signals or cards. 

To remove a signal from the Selected signals list, select it and then click on the  button.

In the example below, we have selected all the mic input signals (from the Compact IO MIC cards):

2. Then click on the  button to add all of the Selected signals to the selected subdirectory.

In our example, this adds all of the Compact IO mic input signals to the MIC subdirectory of Stagebox 1:

Take care when using the  button as it can be selected multiple times!

You can add a signal to more than one subdirectory if you wish.
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3. If you make a mistake and need to remove a signal, then right-click on the signal (in the Directories &
signals column) and select Delete.

You can use SHIFT or CTRL to select multiple signals if you wish:

4. Right-click on a signal, or range of signals, and select Move up or Move down to move the entries up
or down the list.

5. Repeat these steps to add all signals to all of your new subdirectories.

Remember that there are two pages for each side of the Signal List display, and so you will need to repeat the
steps for each page: Source and Destination.

6.10.8 Copy, Cut and Paste

The Copy, Cut and Paste functions provide a quick way to copy and paste signals or directories.

In each case, right-click on an entry in the Directories & signals column and choose Copy, Cut or Paste.

In the example below, the MIC subdirectory has been copied from the directory Stagebox 1 to Compact IO
lower down the list:

Right-click to Copy subdirectory Right-click to Paste Copy & Paste complete
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6.10.9 Duplicating the Directory Structure

This function copies the structure of your Source directories to the Destination page, or vice versa. It can be very
useful if you wish to use similarly named directories and subdirectories in your Source and Destination lists.

1. First, edit either your Source (or Destination) page.

In the example below, the Source page configuration is complete, while the Destination page remains
incomplete.

Source Page (Complete) Destination Page (Incomplete)

2. Select the page you wish to copy from (e.g. Source), and click on the  button from the 'Signal List
Editor' toolbar.

This copies the current page's directory structure to the alternate page.

Take care when using this button as it can be selected multiple times!

3. Now switch to the alternate page (e.g. Destination) to check the results.

The copied directories will be added after any existing directories - in our example, after the empty directory
(New_dir_0001):

Destination Page (Copy Complete)
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6.11 Online Operations

If you switch AdminHD to online mode, it can be used for system diagnostics or to update the online
configuration.

6.11.1 Getting Online

Make sure that you have a valid network connection between your computer and the mc2/Nova control system,
and then:

1. Select Remote -> Online/Offline to remote system from the main menus, or click on the  toolbar
icon.

AdminHD will connect to, and then synchronize with, the remote system. 

If the connection is successful, then the 'Core Browser' and 'Hardware Panel' update to reflect the current
hardware structure of the connected system.

If there is a mismatch between your AdminHD  session and the configuration read from the connected system,
then you will see a summary of the differences. To avoid this, go offline, download the existing Core configuration
from the system (as described earlier), and then switch back to online mode.

You will see the IP address of the connected host in the AdminHD status bar (bottom right):

If the connection fails, then the ‘Remote Log’ reports that the connection has timed out. In this instance:

· Check the network connection and TCP/IP settings of your computer's network interface card. 

· Check that AdminHD is compatible with the mc2/Nova system (the first three digits of the software
versions must match.)

· See also the trouble-shooting tips to resolve the problem.

2. Select the same menu option or toolbar icon to switch offline.

Optionally, you can enable Remote -> Reconnect mode (from the main menus). When enabled, AdminHD
attempts to automatically reconnect to the remote control system if network communication is interrupted.
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6.11.2 System Diagnostics

From an AdminHD computer running online, you can use the 'Core Browser' and 'Hardware Panel' to monitor the
real-time status of all hardware components:

All components are monitored, including the status of the Core and any remote IO devices.

Components which are operating normally are colored green; faulty components are highlighted in red. In our
example above, one of the DALLIS plug-in cards is missing or faulty.

In addition, the 'Remote Log' records all messages generated by AdminHD and the online system. Right-click to
export the contents of the 'Remote Log' as a plain text file:

This can be opened by any common text editor or emailed to Lawo support.

6.11.3 The Messages Log

The mesages logfile is generated and stored by the control system during operation. It can be downloaded from
remote system and saved on your computer using AdminHD.

Note that this is the one of the system logfiles which can also be copied to USB, from the console GUI, using the
File display, or monitored using the Web Browser Interface.
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To download the logfile:

1. Select Remote -> Download file from the main menus and choose System log messages:

2. You are asked to select a folder location and enter a file name:

3. Click Save - AdminHD downloads the file.

The log is stored as a plain text file. It can be opened by any common text editor or emailed to Lawo support.
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6.11.4 Updating the Online Configuration

For temporary changes to the configuration or testing purposes, you can update the online Core configuration. 

This is the current configuration of the system which is stored in temporary memory and saved at shutdown (as
part of the warm start data). This method does not require a cold start and, therefore, can be used for routing
matrix installations where 24 hour continuous operation is required.

Note that only the Core configuration can be modified in this manner; you cannot update the Signal List.

WARNING: Following a cold start the system will always reset to the settings stored in the config.tcl and
gui_config.tcl files. So, for all permanent changes, you should always use the cold start update method.

Ø  To upload your current AdminHD session to the remote system:

1. Enable online mode, by selecting Remote -> Online/Offline to remote system from the main menus,

or clicking on the  toolbar icon.

AdminHD will connect to, and then synchronize with, the remote system. 

In this instance there will be some differences between your AdminHD session and the configuration read from the
connected system - these are listed in the 'Upload summary':

Use the summary to review the changes BEFORE continuing with the upload.

2. Click on Upload to continue or Cancel to abort the operation.

The 'Remote Log' shows the progress of the data transfer. After a successful upload, the system updates
immediately; there is no need to restart.
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6.12 Documenting the Configuration

AdminHD provides two tools to help document the system once you have programmed your configuration: "copy
image/write image to File" and "Export a Component List".

6.12.1 Copy Image / Write Image to File

You can save the graphical images used within AdminHD to help document your system - for example, to save
the front panel configuration of your Nova73 and DALLIS.

1. Open the 'Hardware Panel' and hover your mouse over the frame of the Core or DALLIS - the frame is
outlined in orange.

2. Right-click and select one of the drop-down options:

· copy image to clipboard - saves the graphic to your computer's clipboard. 

· write image to file - saves to graphic as a .png image file. You are asked for a folder location and
filename.

6.12.2 Export a Component List

You can export a component parts list as a .csv file. This can be opened in a 3rd party editor, such as MS Excel.

1. Select File -> Export file -> Component list from the main menus:

2. A File Explorer window appears - select a folder location and enter a filename.

3. Click Save - the component list is stored as a .csv file on your computer.

From Version 5.14, you can use the Export file -> RAVENNA IP List option to export a list of Device IDs and IP
settings for all RAVENNA nodes. This option will by greyed out if no RAVENNA nodes have been configured.
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6.13 More About the Configuration Files

The diagram below illustrates how configuration data is stored on the mc²56 MKII control system, and which files
can be edited and saved on your AdminHD computer:

6.13.1 Cold Start Files (on the Control System)

The following files are stored on the mc2/Nova control system, and are read at boot-up following a cold start.

· config.tcl – defines the Core configuration.

· gui_config.tcl – defines the Signal List configuration.

· custom.tcl – defines customer-specific functions.

· userconfig.tcl – defines the user monitoring functions in the mc2 console series.

· Custom_template_instances – define the custom functions programmed from the Custom Functions
display. Each function is stored as a separate .tcl file.

The table below shows which files can be edited by the customer and which must be factory-configured. Also,
which transfer method can be used to make a backup copy of the file.

System Filename User Configured File Transfer Method Appears in mxGUI as:

config.tcl ü AdminHD mxGUI, AdminHD, FTP Core Configuration

gui_config.tcl ü AdminHD mxGUI, AdminHD, FTP Signal List Configuration

custom.tcl û FTP n/a

userconfig.tcl û FTP n/a

Custom template instances
(folder)

ü Custom Functions display mxGUI, FTP Custom template instances
(folder)

Factory-configured files such as the custom.tcl and userconfig.tcl must be edited by Lawo personnel. If you
wish to modify these aspects of the system, please contact your local Lawo representative or email
support@lawo.com.

mailto:support@lawo.com
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6.13.2 AdminHD Files (on your computer)

The following files can be created by AdminHD and stored locally on your computer:

config.csv

This file is created when you save the Core configuration. This is a .csv file which can be opened by AdminHD or
imported into a 3rd party editor such as MS Excel. 

You can give this file any name as long as it keeps the .csv suffix. It is a good idea to keep "config" in the name
to distinguish it from other .csv files.

signallist.slx

This file is created when you save the Signal List configuration from the ‘Signal List Editor’. This is a .slx file
which can only be opened by AdminHD. 

You can give this file any name as long as it keeps the .slx suffix.

config.tcl and gui_config.tcl

These are the cold start configuration files exported from AdminHD. They are stored locally on your computer, in
preparation for an upload to the system.

DO NOT rename these files, or edit them using an application other than AdminHD. Otherwise, they cannot be
read by the control system! If you wish to keep copies of ‘older’ versions, store them in a sub folder or change the
filename.

systemlist.csv

This file can be exported to produce a parts list for the hardware defined within your configuration. It is a .csv file
which can be opened by a 3rd party editor, such as MS Excel, in order to print or view the data.

config.bfe

This file can be exported for use with a BFE controller system. For more details, please contact your local Lawo
representative or email support@lawo.com.

remote.log

This file is created when you save the contents of the ‘Remote Log’ window as a text file.

system_log_message.log

This file can be downloaded from the mc2/Nova control system to assist with diagnostics.

mailto:support@lawo.com
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6.14 Using AdminHD with mxGUI

mxGUI can run online to remotely control a real system. It emulates the GUI displays of the mc2 consoles,
providing control of virtually any user parameter. For more details on mxGUI, please refer to your Operators
Manual.

Both programs can run offline on your computer. This allows you to prepare a complete system ahead of an event
as follows:

1. Use AdminHD to define the Core configuration (config.tcl) and Signal List (gui_config.tcl) in the usual
manner.

2. Upload the configuration files from AdminHD to the mxGUI local control system on your computer.

You can connect AdminHD to mxGUI by entering mxGUI's virtual IP address (192.168.56.101).

3. Use mxGUI to prepare and save user settings (by saving a production). 

4. Once connected to the final system, you can use mxGUI to transfer both the configuration and
production(s) from your computer to the Lawo control system.
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6.15 Core Configuration Parameters

This section describes all of the Core configuration parameters available in AdminHD. In each case, you should
open the 'Parameter Box' window.

Component and signal parameters are covered according to their hierarchical order within the 'Core Browser'
system tree. For more details on functionality, please consult the relevant data sheets.

6.15.1 System

ID Usually all Lawo projects receive a project ID, made up of 6 integers. You can log your
project ID here; you can be asked for it when servicing your product. The field can be
left blank.

System alias Enter an alias name for the System.

6.15.2 Core -> Connection

These parameters define the TCP/IP address of the mc²56 MKII control system. See Editing the IP Address for
details.
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6.15.3 Core -> Data

Core alias Enter an alias name for the Core.

Router module model
number & type

These fields are for information purposes only and cannot be edited. They show the
serial number and type of Router Module. The type of Router Module is defined
when you add a Core to the System.

Router module This box should always remain ticked, as every Core requires at least one Router
Module.

Red. router module Tick this box to add a redundant Router Module to the Nova73.

Redundant PSU Tick this box to add a redundant PSU to the Nova73.

Black burst synchronized
switching

Tick this box to make matrix cross point switching synchronous to an external
Black Burst sync source.

Internal sync activates
alarm

Tick this box to activate the Global Alarm if the system switches to internal sync.

Enable PTP sync board Relevant IF Multichannel sync source selection = PTP (see below).

PTP sync board This box displays the PTP sync board source as a system address (if Enable
PTP sync board is active).

Multichannel sync source
selection

Use this menu to define the multi-channel sync source - either PTP or Port.

If you select PTP, then tick the Enable PTP sync board option and choose a
RAVENNA IO module from the pop-up window. All RAVENNA IO ports on the
board will TX or RX PTP.

If you select Port, then tick the Enable sync port 1 option and choose the IO port
receiving the incoming sync signal - you can choose any MADI IO port. A main
and backup sync port can be selected.

Enable sync port x Relevant IF Multichannel sync source selection = Port (see above).

Multi-channel sync port x This box displays the multi-channel sync port source as a system address (if 
Enable sync port is active).
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6.15.4 Core -> System Settings

Analog full-scale level
(dBU)

This option sets the analog level which corresponds to digital full scale level
(0dBFS). You can select 12, 15, 18, 21 or 24 dBu.

Reference Level (dBU) This field sets the internal reference level of the system. The maximum reference
level is 24dBu.

Headroom (dB) The resultant headroom is calculated from the first two options. See System
Operating Levels for details.

Sampling Frequency This parameter sets the internal sampling frequency which the system resets to
after a cold start. See Internal Sampling Rate for details.

Disable Global Alarm Tick this box is you wish to disable the Global Alarm.

6.15.5 Core -> Map

These parameters are used if you wish to control matrix crosspoints from an external device. See Mapping
Tables for details.

6.15.6 Core -> External

These parameters are used to connect an external file server to the system. Once configured, the server is
available to users via the console GUI's File Import/Export page.
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6.15.7 Core -> Network

HLSD index This parameter is used if your Core is part of a larger network, in order to keep all
HLSD addresses unique. 

Once you have set the network index, you can use the Replace all default HLSD
classes with new Nework index option (in the Extras menu) to reset the HLSD
classes. For example, if the index = 2, then the resulting default HLSD classes
(in/out) = B2R and B2S.

6.15.8 Core -> Plugin Server

IP Address Plug-in
Server

Enter the IP Address of the MultiRack host PC (if you have the optional Waves
SoundGrid Plug-in Server).

Please see the "Waves Plug-in Server for mc2 User Guide" for details on how to
complete the other options.

Remote Desktop
username, password
and color depth

These parameters configure the Remote Desktop connection to the Plug-in Server
host.

You should enter the username and password which matches the Windows user
name and password entered on the PC host.

For a Waves SoundGrid system, a color depth of 24 Bit is recommended.
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6.15.9 Modules

Parameters for a Module depend on the module type:

IO, & Channel DSP Module Parameters Matrix DSP Module Parameters

Module alias Enter an alias name for the Module.

Slot number

Module model
number

Module type

These fields are for information purposes only and cannot be edited. They show the 
Slot number used in the Core, and the serial number and type of module.

Config-ID On the 983/03_007 mxDSP module, this parameter defines how the matrix DSP is
configured. See mxDSP configuration for details.

Backplane Hardware On the 981/02 and 981/04 AES3 modules, this parameter defines the rear connector
panel (either D-type or BNC).

6.15.10 Ports

Parameters for a Port depend on the port type:

MADI & RAVENNA Port Parameters AES Port Parameters

Port Number

Interface type

These fields are for information purposes only and cannot be edited. They show the
logical port number, which is dependent on the module's slot position in the Core, and
the interface type (MADI, RAVENNA, etc.)

Is redundant Tick this box to enable port redundancy. You will be prompted to select the redundant
port.

Corresponding port Shows the system address of the linked port, if Is redundant is enabled.
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6.15.11 Super-Device

Super-Device is the generic term used to describe the IO port's definition: DALLIS, Compact IO, Tie-Line, etc.
The parameters depend on the device type and its connection.

Tie-Line DALLIS (connected via MADI)

Super-device alias Enter an alias name for the device.

Model number & Type These fields are for information purposes only and cannot be edited. They describe the
serial number (of a DALLIS frame) and the type of Super-device.

Redundant PSU Tick this box to add a redundant PSU to the DALLIS frame.

Audio channels IN left

Audio channels OUT
left

These two boxes cannot be edited and show the number of 'free' audio channels left in
the DALLIS frame. These are channels which could be used by fitting additional plug-
in cards.)

If a device is connected via RAVENNA Net, then there are some additional parameters to configure the
RAVENNA Device ID, IP settings and, if supported, SMPTE 2022-7 Seamless Protection Switching (SPS).

DALLIS (connected via RAVENNA Net) Virtual Devices Port

For more details, please see the separate "RAVENNA for mc2/Nova User Guide".
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6.15.12 Cards

Parameters for the IO Cards depend on the card type. Below are two examples. For details on other
parameters, please refer to the card's data sheet.

DALLIS Mic Card Parameters DALLIS Line Card Parameters

Device alias Enter an alias name for the card.

Model number 

Typename

Slot number

These fields are for information purposes only and cannot be edited. They show the
serial number and type of card, the slot position within the DALLIS frame, and the
interface type.

Monitoring device For 942/02 and 942/12 cards only.

Tick this box to release the card from the system reference level, if the card is to be
used for monitoring.
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6.15.13 Signal In -> Signal

Signal In parameters depend on the type of signal (Mic, Line, AES, SDI, etc.). Below are two examples. For
details on other parameters, please refer to the IO card's data sheet.

Mic Signal In Parameters AES Signal In Parameters (with SRC)

HLSD High Level Signal Definition - this is the Lawo system address for the signal. It
MUST be unique, and normally you should not modify this address from its default
setting.

Signal name This is the system name of the signal. It can only be defined by AdminHD, and should
be used to provide a "fixed" signal name relevant to the installation.

Signal label This is the user label which the system resets to after a cold start. Users can change
labels later, from the console GUI's Signal List display.

Group This is the group name for the signal. It can be used when interfacing to an external
controller. Please refer to your external system’s documentation for details on how to
implement the group name.

SRC For AES cards with SRC only.

Tick this box to enable the sample rate converter. Users can change this parameter
later, from the console GUI's Signal Settings display.

To make a digital path suitable for Dolby E operation, you should turn off the IO DSP for both the input and
output, and disable any sample rate conversion.
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6.15.14 Signal Out -> Signal

Signal Out parameters depend on the type of signal (Line, AES, SDI, etc.). Below are two examples. For
details on other parameters, please refer to the IO card's data sheet.

Line Signal Out Parameters AES Signal Out Parameters (with SRC)

HLSD See Signal In: HLSD.

Signal name See Signal In: Name.

Signal label See Signal In: Label.

Group See Signal In: Group.

Sampling frequency

Word length

SRC

For AES cards with SRC only.

Sets the sample rate and word length for the output.

Note that the SRC field cannot be edited and shows the status of the sample rate
converter. To disable the SRC, you must set the Sampling frequency to System
and Word length to 24-bit. For all other combinations, SRC is always enabled.

Users can change these parameters later, from the console GUI's Signal Settings
display.

AES consumer format For AES cards released after 2006.

Sets the channel status of the AES output to either Consumer or Professional.
Please refer to the AES3 standard definition for details.

To make a digital path suitable for Dolby E operation, you should turn off the IO DSP for both the input and
output, and disable any sample rate conversion.
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6.15.15 Signal In/Out -> DSP

The DSP tab adjusts parameters for the signal's IO DSP and Silence Detect alarms. Note that not all cards
support these parameters.

Signal In DSP Parameters Signal Out DSP Parameters

Signal In Parameters

Gain Compensation Appears for inputs which support IP-SHARE. Tick the box to enable Gain
Compensation. 

Note that if Gain Compensation is enabled, then you cannot enable IO DSP (as it is
this which handles the gain compensation).

General Parameters

IO-DSP Tick this box to enable the IO DSP. Once enabled, the following parameters become
active:

Offset (dB)

Digital gain (dB)

Enter an offset and/or digital gain value in dB. The resultant gain (Offset + Digital
gain) is applied to the signal within the IO card, and therefore affects all destinations.

The two separate parameters (Offset and Digital gain) allow you to apply a
‘permanent’ and a ‘temporary’ gain change. For example, to compensate for a low
level line input, use the Offset parameter to apply a ‘permanent’ gain change. In
addition, for today’s production you can also need to compensate for a badly recorded
signal; for this ‘temporary’ adjustment, use the Digital gain. At the end of the
production, you can easily reset the Digital gain to 0 dB while keeping the Offset
gain intact.

To make a digital path suitable for Dolby E operation, you should turn off the IO DSP for both the input and
output, and disable any sample rate conversion.
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Signal Out Parameters

Mono matrix Tick this box to enable the mono matrix settings and link the output signal to its
odd/even partner.

When the mono matrix is enabled, you can then adjust the following parameters:

Mono matrix mode The mode can be set to:

· Channel mix – sums the left and right inputs and routes the mono sum to both
left and right outputs. 

· Channel swap – routes the left input to the right output and vice versa.

· Left to both – routes the left input to both outputs.

· Right to both – routes the right input to both outputs.

Mono attenuation left
channel (dB)

When working in Channel mix mode, you can set attenuation (e.g. -3dB) to
compensate for the mono sum. This is applied to the left output signal.

Silence Detect Parameters

The Silence Detect parameters can be applied to trigger an alarm state if signals fall below a certain threshold
level. The alarms can be output to an external control system, via Lawo’s Remote MNOPL protocol, or
monitoring using the Web Browser Interface.

Silence detect Tick this box to enable the Silence Detect alarm for the signal.

Stereo link for Silence
Detect

Tick this box to link the left and right sides of a stereo input or output for 'Silence
Detection'. When linked, the alarm is only issued if both signals fall below the 
Threshold level.

Only odd and even adjacent signals can be linked.

Threshold (dBFS) Set the threshold below which the Silence Detect alarm will be triggered. The level
can be adjusted in 0.25dB steps and is referenced to digital full scale level (dBFS).

Attack Time (sec) This sets the length of time for which the signal must fall below the Threshold level
before the Silence Detect alarm is activated. The time is set in steps of 1 second.

Release Time (sec) This sets the length of time for which the signal must remain below the Threshold
level before the Silence Detect alarm is cancelled. The time is set in steps of 1
second.

6.15.16 Signal In/Out -> Map

These parameters set the signal’s address for each of the mapping tables 1 to 16. You should use these
parameters to map a signal to an external controller, see Mapping Tables.
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7.      mxDSP Configuration

This chapter describes how to configure the 983/03-007 or 983/04-007 mxDSP modules.

Topics include:

· Introduction

· Editing the Core Configuration

· Editing the Signal List Configuration

· Updating the Module's Firmware
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7.1 Introduction

An mxDSP module provides a pool of DSP resource which can be applied to signal paths within the routing
matrix. For example, to apply fixed DSP settings to line arrays. 

Physically, each mxDSP module is identical to a normal channel DSP board and occupies one slot within the
Nova73. However, rather than DSP channels, which can be assigned to the console surface, the mxDSP provides
DSP “chains” which can be viewed and controlled from the mxDSP Settings display. 

Several configuration options are supported, providing up to 192 DSP chains plus a 64 x 64 mixing matrix per
module. The DSP chains are configured from various elements including level, mute, delay, EQ, etc. The number
of DSP chains, and their signal flow, is determined by the AdminHD configuration:

To configure a 983/03 or 983/04 DSP board for mxDSP operation, the following steps are required:

1. Edit the Core configuration using AdminHD.

2. Edit the Signal List configuration using AdminHD.

3. Upload new versions of the cold start configuration files in the usual manner.

4. Update the firmware on the mxDSP module.

5. Cold start the system and check the configuration by opening the the console GUI's mxDSP Settings
and Signal List displays.

The rest of this chapter describes steps 1, 2 and 4 in more detail. For more information on operation, please refer
to your Operator's Manual.



mc²56 MKII Technical ManualVersion: 5.14.0/1204/298

7. mxDSP Configuration

7.2 Editing the Core Configuration

1. Open the 'Hardware Panel' for the Core, right-click on the DSP module's slot position and choose the
correct mxDSP option for your DSP module:

2. Open the module's ‘Parameters Box’ and select an option from the Config-ID menu:

You can also enter a Module alias if you wish. The remaining parameter fields are for information purposes only.

7.2.1 Config-ID Options

The Config-ID defines the signal flow of the DSP chains and whether the module supports the 64 x 64 mixing
matrix.

Ø  Standby

Select this option to run the mxDSP module in standby mode. Use this mode to configure a redundant mxDSP
module.

Ø  Playout (no PPM)

This option provides 184 channels of DSP only (no mixing matrix):
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Ø  Universal

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

Ø  Universal (no PPM)

This option provides 154 channels of DSP plus the 64 x 64 mixing matrix:

Ø  Line Control

This option provides 184 channels of DSP plus the 64 x 64 mixing matrix:

Ø  Line Control (no PPM)

This option provides 184 channels of DSP, as above, but with less system resources, similar to Universal (no
PPM).
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7.3 Editing the Signal List Configuration

Having added a new mxDSP module, or changed its operating mode (via the Config-ID), it is necessary to update
the Signal List configuration. Otherwise, the correct signals will not appear in the console GUI's Signal List
display.

To update the Signal List:

1. Open the 'Signal List Editor' and, if you have not already done so, click on  (from the 'Signal List
Editor' toolbar) to download the existing Signal List from the remote system:

2. Then click on  (from the 'Signal List Editor' toolbar) to add the mxDSP signals - the signals are
automatically added to the Directories & signals list in a Directory named mxDSP Signals:

Note that, unlike external signals, the mxDSP Directory and Subdirectories cannot be renamed or repositioned,
and will always appear below the other internal signals: Bus Out, Direct Out and Insert Send.
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Open the mxDSP Signals branch to see the Subdirectory names - these correspond to the Config ID defined in
the Core configuration.

mxDSP Signal List Configuration: Config ID = Playout (no PPM)
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7.4 Updating the Module's Firmware

Before the mxDSP module will operate correctly, its software must be updated as follows. Make sure that you
have uploaded the new cold start configuration files, as described earlier, before continuing as the firmware update
relies on the correct Core configuration (in step 3).

1. Using a computer connected to the Lawo system network, open a telnet session to the mc2/Nova control
system.

2. At the main control system prompt, type mcxsh and press Enter - this opens the mcx shell program.

3. Then type the command mcx_software_auto_update and press Enter.

The software on each card is automatically updated according to the Core configuration:

The mxDSP module is now ready for operation.
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8.      Software Tools & Diagnostics

This chapter describes the software tools available for diagnostics.

Topics include:

· Shutdown & Restart

· Diagnosing System Errors

· Control Surface PSU Alarms

· Other Central GUI Diagnostics

· AdminHD Diagnostics

· Web Browser Interface

· Global Alarm

· DALLIS Local Alarm

· System Logfiles

· Telnet Sessions

· File Transfer via FTP

· Running a PING test
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8.1 Shutdown & Restart

Shutdown

The system should be shut down by powering off the Nova73 (via the mains connections at the front of the unit).
Note that the control system is located on the Router Module MKII within the Nova73. Therefore, it is not
necessary to power off the control surface in order to shut down the control system. However, if you intend to
leave the console for any length of time, then powering off the surface is recommended. 

Following switch-off, power is provided to the control system for a further few seconds. During this time, all
current settings are saved to flash memory; this is known as the warm start data. You will hear several tones
signaling that the shut down has been successfully completed. The system is shut down when the blue LED of
the trackball is off.

You can switch off the power to other components, such as remote IO devices, at any time.

Starting the System (Warm Start)

The system starts automatically when power is supplied to the Nova73. If the control surface is not powered,
then you should also power up the surface.

The control system boots in a few seconds; during this time you will see the boot-up progress on the console's
displays. By default, the warm start data is loaded at the end of boot-up. This means that the system comes
back exactly as it was when you last shut down, ensuring fast recovery of all previous settings following a loss
of power. Once boot-up is complete, the displays refresh to show the Channel Display and Central GUI screens.
The console is now ready for operation.

The following settings are stored in the warm start data, and are recalled following a warm start:

· Core configuration settings changed by an online AdminHD computer.

· Matrix crosspoints and IO parameters (Mic preamp gain, SRC on/off, etc.)

· The DSP configuration and parameters (EQ, Dynamics, Fader levels, etc.)

· All other user settings (fader strip assignments, etc.)

Starting the System (Cold Start)

Alternatively, the system can be set to cold start, following the next reboot, by selecting the Global -> "Prepare
Coldstart" option in the System Settings display. First, enable the option, and then restart the control system
(e.g. power off and on).

A cold start boots without loading any warm start data. You should perform a cold start only if there is a problem
with the warm start data, or if you wish to clear all warm start data from the system.

Following a cold start:

· All configuration files (defined by AdminHD) return to their cold start defaults (config.tcl, gui_config.tcl,
etc.)

· All matrix connections are cleared, unless protected by the factory-configuration.

· All IO parameters are set to factory default values.

· The default DSP configuration is loaded. This can be defined from the Custom Functions display.

· All DSP parameters are set to factory default values.

· All other user settings are cleared (e.g. no fader strip assignments).

The best way to reset the console for a new job or show is to load a production.
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8.2 Diagnosing System Errors

In the event of a component failure, a hazard warning flag appears in the title bar of the console GUI. Hover over
the warning triangle to view the last ten alarm messages. Messages in red indicate active alarms; messages in
yellow are resolved.

To interrogate further:

1. Open the Signal Settings display.

This display monitors all of the components defined in the AdminHD configuration. In the event of a problem, a
red/white cross appears in the System tree.

2. Follow the red warning flags and open each branch of the tree to find the problem – in our example, a
DALLIS card.

3. Open the DALLIS card further, and you will see grey/white crosses beside Signal In 1, Signal In 2,
etc. These show that the AES signals are no longer available:

3. Check and replace the card if necessary. 

Once all components are connected and working correctly, the red/white crosses disappear from the System
Settings display and the hazard warning flag in the title bar is cleared.
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8.3 Control Surface PSU Alarms

The Central GUI offers status monitoring for all PSU blocks fitted to the control surface.

The status of each PSU block is represented by a symbol which appears at the bottom right of every console
display:

The number of symbols relates to the number of PSU blocks within the control surface and whether any
extender bays with their own PSU are fitted. PSU blocks are represented from left to right, and each block
consists of two supplies running in parallel. 

The symbols indicate:

· Green Circle – the PSU block is working fine.

· Yellow triangle with an exclamation mark – the PSU block is working fine, but there was a fault in
the past which has now been cleared. Click on the icon to reset it.

· Red circle with an exclamation mark – there is a fault.

Hover over the symbol to reveal more information:

Our example shows the status for Bay 1 - the first bay on the left of the console.

Note that within the text on the GUI, bays are counted from BAY 1 upwards. However, internally bays are
addressed from 0. This means that BAY 1 on the GUI relates to an internal Bay Server address of 0, BAY 2
to an internal address of 1, and so on.
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8.4 Other Central GUI Diagnostics

Control Surface Connection

If a redundant Router Module is fitted to the Core, you can run two ETHERNET A connections between the Core
and control surface. The operator will then be presented with an error message should the active connection fail,
and decide whether they wish to switch to the redundant connection/module.

Redundant Router Module Takeover

If a redundant Router Module is fitted to the Core, you can force a manual takeover to the redundant module (from
the System Settings display or Nova73).

DSN Connection

From Version 5.4 onwards, if your system is networked to other Lawo systems, then the following icon appears if
the network connection fails:

Bulb Test, Fader Calibrate, OLED Saver Enable

These options, in the System Settings display, can be used to test the control surface illumination, calibrate the
faders or enable the OLED display saver (recommended to prolong their lifespan).
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8.5 AdminHD Diagnostics

From an AdminHD computer running online, you can use the 'Core Browser' and 'Hardware Panel' to monitor the
real-time status of all hardware components:

All components are monitored, including the status of the Core and any remote IO devices.

Components which are operating normally are colored green; faulty components are highlighted in red. In our
example above, one of the DALLIS plug-in cards is missing or faulty.

In addition, the 'Remote Log' records all messages generated by AdminHD and the online system. Right-click to
export the contents of the 'Remote Log' as a plain text file:

This can be opened by any common text editor or emailed to Lawo support.
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8.6 Web Browser Interface

The control system includes an integrated web server. This allows status information to be monitored from a
remote computer, via any normal* web browser.

* To ensure all graphics are correctly displayed, we recommend the following minimum browser requirements:
Internet Explorer 10 or Edge 12; current Versions of Firefox, Safari or Chrome.

1. Connect a service computer to the mc2/Nova control system via the ETHERNET B port and configure the
TCP/IP settings of its network interface card.

2. Open your browser software, and enter the IP address of the Lawo control system into the URL field.

You can check the Lawo system IP address from the console GUI: open the System Settings display and select
Global - the IP Address Primary = the main control system IP address.

3. Then press Enter - the System Overview page should appear:

If the page does not open, then check your computer's network connection and TCP/IP settings, and the IP
address entered in the URL field.

4. To automatically refresh any page turn on the Auto Refresh option at the top right of the screen.

5. Use the menu bar at the top of the page to access the different pages.
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8.6.1 System Overview

The main System Overview provides information on system software versions, Network Configuration (of the
main and redundant Control Systems) and Image Versions for any connected RAVENNA Link ports:

System Overview -> Netlink Usage

Select this page for information about the "netlink" connections in a DSN networked system.
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System Overview -> Network Information

Select this page for more information about the connected RAVENNA Net ports:

The RAVENNA Control Port Address Overview lists all of the Device IDs and Service Network IP settings: i.e.
for the 981/61 IO module SERVICE and DALLIS master board CTRL ports. 

The RAVENNA Port & Partner Network Address Overview lists all of the Streaming Network IP settings as
follows:

Ø  DALLIS, Compact IO or Local IO

For a partnering connection to a DALLIS, Compact IO or Local IO, you will see a single line showing:

· Device Address = the IP settings of the 981/61 streaming port.

· Partner Address = the IP settings of the DALLIS, Compact IO or Local IO streaming port.

Ø  Virtual Devices

For a partnering connection to Virtual Devices, you will see a single line for the Virtual Devices port:

· Device Address = the IP settings of the 981/61 streaming port.

· Partner Address = the IP settings of the second 981/61 streaming port if SPS is enabled.

And then a line for each individual device:

· Device Address = the IP settings of the device's streaming port.

· Partner Address = the IP settings of the device's second streaming port if SPS is enabled.

Ø  RAVENNA Net Tie-Lines

For a Tie-Line port, you will see a single line showing:

· Device Address = the IP settings of the 981/61 streaming port.

· Partner Address = the IP settings of the second 981/61 streaming port if SPS is enabled.
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System Overview -> GPIO States

Select this page for an overview of the High/Low status of GPIOs:
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System Overview -> Legal

Select this page to view a list of all open source licenses and source code patch files used by this product.

Click on the link to open the listings:

8.6.2 Alarm Management

Alarm Management -> System Alarm

This page lists the last 5000 errors which have triggered the Global Alarm. Every error has an explicit ID,
description and time stamp for an easy overview of the alarm events. The errors are stored within the system
logfile: alarm.log.
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Alarm Management -> Alarm Backlog

Select this page to view archived errors (the previous alarm.log file). These errors are stored within the system
logfile: alarm.log.old.
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8.6.3 Device Information

Device Information -> Device Availability

The Device Availability page provides information about system components - for example, the Micro Core, HD
Core or Compact Core. Here you will find detailed information, including feedback on the sync source, alarm
statuses, slot status, etc. 
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Device Information -> Silence Detects

This page lists any silence detect errors generated during operation:

Device Information -> DSP Usage

Select this page to view the DSP card usage of the system:
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8.6.4 System Log Files

This page provides access to all logfiles stored on the control system, allowing you to view system log files
(messages) or alarm log errors. Select an option to view the contents of the file.
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8.7 Global Alarm

By default, the global alarm status monitoring is enabled. It can be disabled by the AdminHD configuration
(under Core -> System Settings).

Conditions

The global alarm is triggered when any of the following conditions are satisfied.

Within the Nova73:

· Malfunction of a Router module.

· High temperature on a Router module – triggered if the temperature exceeds 45° C.

· Voltage is too high or too low on a Router module.

· Malfunction of an IO module.

· Malfunction of a PSU.

· Malfunction of a fan.

· Active ALARM IN control input – triggered from an external device wired to GPI 2.

· Active sync is internal - triggered if the system switches to the internal sync reference. Note that this
trigger must be enabled from the console GUI (using the Wordclock options in the System Settings
display) or in AdminHD (under Core -> Data).

From an IO Port:

· IO port is not supplied with a valid signal.

· Malfunction of a DALLIS master board.

· Malfunction of a DALLIS IO card.

· Malfunction of a DALLIS PSU.

Monitoring the Global Alarm Status

The global alarm triggers the warning flag in the title bar of the console GUI and illuminates the red ALARM LED
on the front of the Nova73 Router Module.

It is also output by the GLOBAL ALARM BNC and GPI 2 D-type connectors on the rear panel. In both cases,
contact closed = the global alarm is active.

It can also be interrogated using the Web Browser Interface.

Historical global alarm errors are also stored on the control system in the alarm.log system logfile.
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8.8 DALLIS Local Alarm

A local alarm for the DALLIS unit can be output by both the ALARM BNC and ALARM FORCE M2 D-type
connectors.

Note that some of the alarm conditions vary for DALLIS fitted with the RAVENNA master board (947/21); the
conditions which vary are highlighted in the tables below.

Local Alarm Output States for DALLIS fitted with 947/03, 947/13, 947/05, 947/07 and 947/15

Condition ALARM (BNC / D-type Pin
7&8)

ALARM Inverted (D-type Pin
5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present open closed

1 card in left slot, error present closed open

2 cards, booting closed open

2 cards, left no error, right no error open closed

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error closed open

Local Alarm Output States for DALLIS fitted with 947/21

Condition ALARM (BNC / D-type Pin
7&8)

ALARM Inverted (D-type Pin
5&13)

No power closed open

1 card in left slot, booting closed open

1 card in left slot, no error present closed open

1 card in left slot, error present open closed

2 cards, booting closed open

2 cards, left no error, right no error closed open

2 cards, left error, right no error closed open

2 cards, left no error, right error closed open

2 cards, left error, right  error open closed
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8.9 System Logfiles

During operation, the system generates and stores logfiles on the control system. This allows you to export the
files to assist Lawo support with fault-finding.

There are four principle logfiles:

· alarm.log - global alarm errors (the last 5000).

· alarm.log.old - archived global alarm errors (the previous alarm.log file).

· messages - messaging errors generated by the control system (the last 5000).

· messages.old - archived messaging errors (the previous messages file).

Logfiles can be copied to USB, from the console GUI, using the File display:

Alternatively, you can monitor the contents of a log file, remotely from your computer, using the Web Browser
Interface.

Ø  Timestamping a logfile

Click on the LAWO logo, from the console GUI's title bar, to create a time stamp in the messages file. This
marks the logfile at a moment in time, and can assist Lawo's service department when diagnosing system
behaviour.

Ø  Change of DSP Configuration

Whenever the DSP configuration changes (by loading a production, changing the DSP configuration or switching
to a redundant DSP card), information about every DSP card is printed in the alarm.log. The information is
formatted as follows:

New DSP card role for {HDCore 0, Slot 14}: active (role index 1)

New DSP card role for {HDCore 0, Slot 12}: active (role index 2)

New DSP card role for {HDCore 0, Slot 10}: active (role index 3)

Ø  Reading a logfile

From V5.0 software onwards, each line within the messages file is formatted in three sections:

<Software Module> <Error Type> <Details>

The <Error Type> indicates the severity of the error as follows:

· DEBUG - information for developers, not usually seen once a release is issued.

· INFO - general information, not a real error. 

· WARNING - an error with low impact.

· ERROR - an error with moderate impact. 

· FATAL - a serious error which could lead to system crashes.

By searching the messages file for the appropriate text - e.g. FATAL - you can quickly identify the relevant
information.

Note that within a logfile, the module slots within the Nova73 are counted from 0 updards. This means that
physical slot 1 = slot 0 in the logfile. 

Note that the logfiles count slots from 0 upwards (e.g. physical slot 1 = slot 0 in the logfile).
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8.10 Telnet Sessions

Many parameters on the mc²56 MKII can be adjusted by opening a telnet session to the device's control system.

WARNING: Adjusting parameters via telnet will make low level changes to your system. Therefore, these
procedures should only be performed by a fully trained member of staff.

To open a telnet session:

1. Install a telnet client on your computer. We recommend using Tera Term Pro Web 3.1.3, a free telnet
client for Windows, which can be downloaded from www.ayera.com/teraterm/

2. Connect your computer to the device, via either the control system network or service port (in the case of
an individual component).

3. Configure the TCP/IP settings on your computer's network interface card.

4. Open the Tera Term Pro Telnet client.

5. Select TCP/IP from the Setup menu, and add the IP address of your control system to the host list:

6. Now open a new Telnet connection using File -> New connection:

http://www.ayera.com/teraterm/
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7. Choose the TCP/IP Host address of your control system:

Default IP Address of mc266 shown:

8. When prompted, enter the login name: root  and the password: hong

The session opens, and you will see the command prompt for the control system:

9. Now follow the specific instructions for the task you wish to perform.

Some parameters are not saved on the main control system, and therefore you can need to remotely login to
another part of the system.

You can reboot the control system from the telnet client by typing reboot and Enter.
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8.10.1 Logging in to a Remote Control System

To remotely login to another control system (for example, the GUI_0 Bay Server):

1. At the main control system prompt, type ipinfo and press Enter - a list of all system IP addresses is
displayed:

Telnet Session to mc256 shown:

For our example, the IP address we require is 192.168.105.100 (thaddeus_GUI_0).

2. Type telnet xxx.xxx.xxx.xx (where xx.. is the IP address of the remote control system) and press
Enter.

3. When prompted, enter the login name: root  and the password: hong - the session opens, and you will
see the command prompt for the remote control system:

4. Now follow the specific instructions for the task you wish to perform.

5. Once you have finished, return to the main control system by typing quit.
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8.11 File Transfer via FTP

All files stored on the control system can be accessed by a suitable FTP client. 

You will need this tool to transfer files, such as system software or factory configuration (.tcl) files, which are
"hidden" from normal console GUI, mxGUI and AdminHD operation.

WARNING: File transfer via FTP will make low level changes to your system. Therefore, these procedures
should only be performed by a fully trained member of staff.

To perform a file transfer:

1. Install a suitable FTP client on your computer. We recommend using Filezilla, a free FTP client for all
platforms, which can be downloaded from www.filezilla-project.org

2. Connect your computer to the control system network and configure the TCP/IP settings on your
computer's network interface card.

3. Open the Filezilla FTP client, and enter the following information: 

· Host = the IP address of your control system

· Username = root

· Password = hong

Default IP address of mc256 shown:

4. Click on Quickconnect to make the connection.

The session opens, and you will see the filing system of the control system on the right (under Remote Site):

http://filezilla-project.org/
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5. BEFORE transferring files, check that the Transfer Type is set to Binary:

WARNING: It is VERY important that file transfers use "Binary" mode, and not "ASCII".

6. You can now transfer files from the control system (Remote site) to your computer (Local site), or vice
versa:

· Use the upper areas to navigate through the filing structure - the contents of the selected folder are
displayed beneath (under Filename).

· Right-click on a filename and select Upload or Download - the file is transferred to/from the selected
folder.

Further information on system files can be found in the relevant technical documentation.
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8.12 Running a PING test

The PING command is a built-in Windows and Mac function, that allows you to test whether you have a valid
network connection to and from any networked device.

1. Make sure that your computer is connected to the correct network port, and that you have configured
the TCP/IP settings of your computer's network interface card.

2. On a Windows 7 PC, type cmd into the "Search programs and files" field under the Start menu and
press Enter.

This opens the DOS command prompt window:

Alternatively, on a Mac, open the Terminal program (found in the Applications -> Utilities folder).

3. On both platforms, perform the ping test as follows:

Type ping xxx.xxx.xxx.xx (where xx.. is the IP address of the device you are trying to connect to) and press
Enter.

Your computer will now try to establish communication...
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Ø  Ping Test Fail

If the ping test fails, then the request will time out, and you will not receive any successful packets:

 

There is something wrong with your network configuration, so check the network connections, and TCP/IP
settings again. Or contact your network administrator.

Ø  Ping Test Success

If the ping test is successful, then the result will show that the Sent packets have been successfully Received:

This confirms that the network communication is working. If you still cannot connect, then something on your
computer is blocking the network connection. Try disabling any firewall and/or antivirus software.
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9.      Service Procedures

This chapter includes service procedures for the hardware components:

· Control Surface

· Nova73

· DALLIS
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9.1 Control Surface Procedures

9.1.1 Restarting a Bay Server

Each TFT display on the mc²56 MKII has its own Ethernet Bay Server which can be restarted from the front panel.
You should perform this procedure, rather than a complete system restart, if:

· the graphics on an individual display freeze or look odd. 

· the controls on a panel are not responding; indicators not updating.

These symptoms can sometimes occur if a Bay Server looses its Ethernet connection to the control system.

1. Using a pointed object, press the recessed button on the top left of the display:

The Bay Server restarts in a few seconds; during this time you will see the boot-up screen on the display. Once
complete, communication with the control system is re-established, and the Channel (or Central GUI) display is
reinstated.
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9.1.2 Replacing a Panel

Each control surface panel is individually hot-pluggable enabling panels to be replaced without affecting the rest of
the system.

Channel bays are fitted with one 16-fader panel per bay. The centre section is fitted with one central panel
connecting to two circuit boards.

Ø  To replace a panel:

1. Remove the panel screws (along the front buffer) using a T20 Torx driver:

You should remove the screws completely and place them carefully to one side, so that they do not fall into the
frame when the panel is lifted. The springs beneath the panel will raise it slightly from the frame.

2. Gently lift the panel using your fingers:

If you are lifting the central panel to gain access to the components beneath, then use the Hood Fastener to
keep the panel in place while you work.
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3. Remove the USB and power connectors taking notes on where each one should be fitted:

Fader panels have one USB and one power connector. From the central panel, there are two USB and two
power connectors.

Channel Bay: Centre Section:

4. Carefully remove the panel by lifting it out of the frame.

5. Check that the rotary switch settings on your replacement panel are correct - they should both be set to
0, irrespective of the frame position. For details, please check the panel's data sheet.

6. Insert and reconnect the replacement panel, and fasten the screws back into place.

 If the control surface is powered, the panel will boot within a couple of seconds.
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9.1.3 Hood Fastener

The Hood Fastener can be used to keep the central panel in place while you work inside the console. This avoids
having to disconnect cables, and remove the panel, when you need access to other components.

1. Follow the previous section's steps to lift the panel - you will see the Hood Fastener, stowed safely along
the front buffer:

Central Panel lifted: Hood Fastener Stowed:

2. Release the fastener from its catch, and position it against the metal plate (to the left of the trackball) as
shown:

3. When you have completed your service procedure, replace the fastener safely back into its catch, before
lowering the central panel.
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9.1.4 Replacing a Fader

An individual fader unit can be replaced by removing the panel from the console. In our example, it is the left-hand
fader with the panel face-up (Fader Number 1), which is being replaced:

Panel Face-up Panel Face-down

1. Remove the panel from the console frame (see Replacing a Panel), and lay it it face-down on a piece of
foam, or similar ESD-proof protective material, away from the console. Take care not to touch the flat foil
cables.

2. Using a small flat-blade screwdriver, release the catches to disconnect the fader unit cables - there are
two cables to release:

3. Turn the panel face-up and remove the fader cap.

4. Remove the two screws holding the fader unit in place (using a T10 Torx driver):
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5. Turn the panel face-down and remove the fader unit. Note that the unit will be loose, and so it helps to
support it from behind as you turn the panel.

You are now ready to fit the replacement.

6. Insert the new fader unit into position.

7. Carefully lift the panel onto its side, supporting the fader from behind, and replace the two front panel
screws:

8. Turn the panel face-down once more and reconnect the two fader unit cables (see step 2).

9. Fit the panel back into the console frame (see Replacing a Panel), and test the functionality - if the
control surface is powered, the panel will boot within a couple of seconds.
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9.1.5 Replacing a TFT Display

Each of the touch-screen displays is individually hot-pluggable, enabling you to replace a display without affecting
any other bay within the console. (Note that you will lose control from panels within the bay, as the Ethernet Bay
Server is mounted behind the TFT display.)

If you need to replace the centre section display, then connect an mxGUI computer so that it can run online
and provide continued access to central GUI operations.

Ø  To replace a display:

1. Unfasten the three screws at the top of the display using a long T20 Torx driver, and gently tilt the unit
forwards:

Warning

The Torx driver shaft MUST be long enough to turn the countersunk screws without scratching the front panel.
If you attempt to use a short driver, or driver attachment, damage can occur.
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2. Lift the display unit out of the frame and lay it carefully face-down on a piece of foam, or similar protective
material, on top of the control surface:

3. Remove the LVDS, USB and power connectors taking notes on where each one should be fitted.

4. Check that the Bay Server's rotary switch settings on your replacement panel are correct.

5. Fit the replacement in the reverse manner.

If the control surface is powered, the display will refresh within a couple of seconds.
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9.1.6 Bay Server Rotary Switch Settings

Each channel bay and centre section is fitted with an Ethernet Bay Server, mounted behind the TFT display. The
Bay Server has a rotary switch with two settings:

· Function - determines whether the Bay Server supports a channel or central GUI bay.

· Address – determines the Bay Server index, counted from left to right across the frame starting at 0. 

You may need to adjust these settings if you are replacing a TFT display or adding an extender. 

The settings also determine how the Bay Server control system is named; this will help locate its IP address
should you need to perform a remote login. 

Bay Server
Location Function

Address Control System Naming

Central GUI 8 0 "nickname"_GUI_0

Channel Bay 0 0, 2, 4, etc. "nickname"_BAY_0, BAY_1, etc.

Note that for channel bays, address 0 is the left-most bay.

The example below shows the settings for a 32+16C+16 frame:

Adding an Extender Bay

If an extender is added to the left of the main frame, then the addresses of each main frame bay must be shifted
upwards. 

If the extender is added to the right, then its address can be counted upwards from the main frame.
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To Adjust a Bay Server's Rotary Switch Settings

1. Remove the TFT display from the bay you wish to adjust. If you lay the display on top of the control
surface panel, you do not need to disconnect any cables.

2. Locate the two rotary switches on the Bay Server control board. This is the board mounted at the top of
the display unit (closest to you in the pictures below):

3. Adjust the Function and/or Address settings.

4. Replace the TFT display.
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9.1.7 Calibrating a Touch-screen

The Channel and Central GUI touch-screen displays can be calibrated as follows:

1. Select the GUI's System Settings menu, GUI topic and Calibrate Touchscreens:

Touch-screen calibration is activated across all displays.

2. Follow the on-screen instructions to calibrate the first display. You will be prompted to touch various
points on the screen. 

When the last point is touched, calibration is complete, and the display reverts to its normal operation.

3. Repeat steps 1 and 2 to calibrate a different touch-screen.
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9.1.8 Replacing a Console Power Supply

The control surface is powered by dual-redundant power supplies which are fitted internally within the frame. 

Depending on the size of the frame, more than one PSU "block" may be required. Please see PSU Block
Locations for details on where the PSUs are located in your frame.  

To replace a PSU you will need to disconnect the PSU block from its distribution board (located beneath the
control surface panel), and remove the TFT display (to access the PSU block).

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors - press the red button
on the IEC connector to release the plug.

WARNING: DO NOT attempt to access the power supply unit without disconnecting the mains supply. You
must remove the MAINS connectors from the frame, rather than from the wall, as the IEC sockets form part
of the PSU module. If you do not, then the PSU module will get stuck during step 7.

2. Lift the control surface panel in the PSU bay, to gain access to the distribution board. In the central bay,
the distribution board is located on the right below the Overbridge:

3. Using a T20 Torx driver, disconnect the PSU block from the distribution board by removing the 4 wires
shown below:

WARNING: Do NOT disconnect any wires other than those shown.

4. Lower the control surface panel back into place, but do not fasten the panel screws as access will be
required again in step 11.
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5. Now remove the TFT display within the PSU bay. If you lay the display on top of the control surface
panel, you will not need to disconnect any cables.

You will see the power supply block mounted at the rear of the frame:

6. Using a 7mm hex socket, remove the two screws holding the power supply block in place, followed by
the single screw attaching the protective earth:

Warning

Take care NOT to drop any nuts or washers into the desk.

7. Remove the PSU block from the frame, taking care to extract the distribution and protective earth cables
along with the unit.

8. Now fit the replacement block (which comes with its own 4-wire distribution and protective earth cabling).
The 4-wire distribution cables should be fed down the distribution board area.

9. Screw the protective earth to the frame, and replace the two securing screws (see step 6).

10. Then replace the TFT display (see step 5).

11. Lift the control surface panel once more, and connect the PSU block to the distribution board (see step
3).

12. Replace the control surface panel, and fasten into place.

13. When everything is back in place, re-connect the rear mains IEC power connectors, and power on.
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9.1.9 Replacing the Local I/O Board

The local IO board is mounted inside the control surface beneath the central panel. It can be replaced as follows.
The instructions apply to both local IO board types - 958/55 (MADI) and 958/50 (RAVENNA).

Ø  To replace the Local IO:

1. Turn off the power to the control surface by disconnecting ALL MAINS connectors on the rear panel of the
console - press the red button on the IEC connector to release the plug.

WARNING: DO NOT attempt to access the local IO board without disconnecting the mains.

2. Lift the central panel, as described earlier, to gain access to the local IO carrier unit (shown below). Use
the Hood Fastener to keep the panel in place while you work.

Central Panel Lifted (no local IO fitted) Local IO Carrier Unit (disconnected)
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3. Remove all of the connectors from the local IO carrier, in the order described below, taking notes on
where each one should be fitted:

Local IO (side view)

a. Disconnect the power connector from the backplane, and open the clamp to release the cable.

b. Disconnect the master connector - either MADI (optical SC) or RAVENNA (CAT5 RJ45). The connector
type depends on the version of your local IO board.

Note that on the 958/55 MADI board, the 9-pin D-type and BNC are unused. On the 958/50 RAVENNA board, the
master cable connects to the left-hand RJ45 socket, while the right hand RJ45, BNC and SFP cage are unused. 

958/55 MADI 958/50 RAVENNA

c. Disconnect all of the IO cables by unlocking and removing each D-type connector. The numbers beside
the connectors correspond to the ribbon cable labelling. The following reference diagram can be found on the
cable duct to the right of the local IO:

Start with the two upper 37-pin D-types (2 & 3); then the two lower 37-pin D-types (1 & 4); then the 50-pin GPIO
D-type (6); the four 15-pin D-types (1, 2, 5 & 3); and finally the 37-pin PHONES D-type (no number, it is the only
rounded connector).
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Some D-types are unlocked by loosening the two connector screws. Others unlock by moving the sliding lock
mechanism (use a small flat-bladed screwdriver to slide the mechanism carefully to the left or right).

D-type Unlocked/Locked by Screws D-type Sliding Lock Mechanism

There are two versions of the IO carrier in the field, using different directions for the sliding lock mechanism. You
can verify the direction by looking at the position of the screws; when open, the screws are not covered by the
sliding part:

Version 1: To open, slide to the right Version 2: To open, slide to the left

4. Once all the cables have been disconnected and carefully stowed, loosen the local IO carrier from the
console frame. There are two nuts, one at the front (near the console arm rest), and one at the rear (below the
Overbridge).

The front nut should be removed completely and placed to one side. The front of the carrier unit can now be lifted
over the bolt, and if the rear nut is loose, the unit will slide forwards.

If the rear nut has been tightened, then you may need to loosen it by opening the Overbridge (see Replacing a
TFT display for how to gain access).

Front Nut Rear Nut
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5. Carefully remove the carrier by sliding it forwards and out of the console frame. Take care that the frame
does not scrape the unit, and that the cables do not get caught:

You are now ready to fit the replacement.

6. Check the replacement unit - all D-type connectors should be in their open position, and the DIP
switches set to ON (to enable remote control of headphone volume):

7. Slide the unit into the console frame (see step 5), taking care not to scratch the unit or get any cables
caught underneath. The unit should slide underneath the rear nut; fit and tighten the front nut to secure (see
step 4).

In mobile installations, such as an OB van or fly-away kit, the rear nut should also be tightened. To access to
the nut, you will need to open the Overbridge (see Replacing a TFT display).

8. Replace the IO, master and power connectors (see step 3), making sure that you lock each of the D-type
connectors.

9. Replace the central panel, and fasten into place (see step 2).

10. If not already connected, replace the Nova73 connection (MADI or RAVENNA) and audio connections on
the rear panel of the console.

11. When everything is back in place, re-connect the rear MAINS IEC power connectors, and power on. Then
check the functionality of the local IO.
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9.2 Nova73 Service Procedures

9.2.1 Replacing a Plug-in Module

All IO and DSP modules are individually hot-pluggable enabling modules to be replaced without affecting the rest
of the system.

Router modules are also individually hot-pluggable. If main and redundant Router Modules are fitted, then you can
replace the redundant module (in STANDBY) without affecting the operation of the system. 

WARNING: If only one Router Module is fitted, then replacing the module will shut down the system!

See Fitting the Nova73 Plug-in Modules for instructions.

9.2.2 Replacing the System or User Data Flashcard

A backup image copy of the System Flashcard and/or Data Flashcard can be created and stored, so that it can
be replaced if necessary.

From Version 5.8.2 software, the CF Card Creator utility can be used to create the image copies. This utility can
be launched from mxGUI (as described in the "mc²56 MKII Operators Manual").

Once you have the new CF card, it can be replaced as follows.

You must power off the Nova73, thereby shutting down the system, in order to replace a CF card.

If main and redundant Router Modules are fitted to the Nova73, then please see the additional instructions on
updating data in a redundant system.

Both CF cards are located on the Router Module MKII (980/33) within the Nova73.

1. Power off the Nova73 (both PSUs if fitted) and remove the Router Module.

You will see the System and Data CF cards slotted into the Control System; each should be clearly labelled:

2. Remove the appropriate card and slide in your replacement.

3. Replace the Router Module and power on.

The control system boots and reads the new data.
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9.2.3 Replacing a Nova73 Power Supply

Each of the PSUs are individually hot pluggable. To operate the Nova73, one PSU is sufficient. Therefore, when
two supplies are fitted, you can replace a PSU without affecting the operation of the system.

WARNING: If only one PSU is operational, then powering off will shutdown the system!

The replacement PSU must be of the same type; you cannot mix PSU types.

1. Switch off the PSU you wish to replace from the front of the frame.

2. Disconnect the mains from either the PSU 1 or PSU 2 IEC mains connector as appropriate.

Nova73 HD Front View Nova73 Compact Front View

3. Unfasten the four screws and, using the handle provided, pull out the PSU:

Nova73 HD PSU Nova73 Compact PSU
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4. Before fitting the replacement PSU make sure that it is switched off.

5. Insert the new PSU and slide it into position until it locks into place.

6. Secure the unit by fastening the four screws.

7. Re-apply the mains to the PSU IEC mains connector and switch on!

WARNING: To ensure the proper airflow, both PSU slots MUST be occupied when the Nova73 is operational:

· Nova73 HD: if only one PSU is installed, cover the empty slot with a blanking plate (980/21). 

· Nova73 Compact: if a PSU is faulty, leave both units in the frame until a replacement can be fitted.
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9.2.4 Replacing the Nova73 Fans

Each of the cooling fans can be replaced individually while the Nova73 is running:

Nova73 HD Rear View

Nova73 Compact Rear View

1. Unplug the 4-pin connector from the rear of the frame as shown above.

2. Loosen the screws and remove the fan from the frame.

3. Insert the replacement and fasten the screws to secure.

4. Plug the 4-pin connector into the coupler of the frame.
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9.3 DALLIS Service Procedures

9.3.1 Replacing a DALLIS Plug-in Card

With the exception of the Phantom Power card, all IO cards are individually hot-pluggable enabling cards to be
replaced without affecting other aspects of the system.

Master boards are also individually hot-pluggable. If main and redundant master boards are fitted, then you can
replace the redundant board without affecting the operation of the DALLIS.

WARNING: If only one master board is fitted, then its replacement will cause an interruption in audio from the
DALLIS unit!

 See Fitting the DALLIS Plug-in Interfaces for instructions.

9.3.2 Replacing the DALLIS Lithium Battery

The DALLIS master board is fitted with a lithium battery. This battery guarantees that user data remains saved
when the system is powered off. As a precaution we recommend that the battery is replaced after about eight
years of operation. Please send the master board to your local Lawo support representative to perform this
procedure.

Only Lawo support staff are permitted to replace batteries.
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9.3.3 Replacing a DALLIS Power Supply

Each of the PSUs are individually hot pluggable. 

To operate the DALLIS, one PSU is sufficient. Therefore, when two supplies are fitted, you can replace a PSU
without affecting the operation.

WARNING: If only one PSU is fitted, then powering off will cause an interruption in audio from the DALLIS
unit!

The replacement PSU must be of the same type; you cannot mix PSU types.

1. On the rear of the DALLIS frame, disconnect the mains from either the PSU 1 or PSU 2 IEC mains
connector as appropriate.

2. Unfasten the two screws on the right hand side of the hinged PSU cage door (marked by the arrows
below). 

3. And pull the door open to access the PSU docking bays:

Unfasten these screws: Pull door open to reveal PSUs:

4. Unfasten the metal catch which holds the PSUs in place by pushing on the catch as shown:

5. Remove the relevant power supply unit and replace with the spare.

6. Fasten the catch back into place.

7. Replace the cage door and fasten the two screws.

8. Re-apply the mains to the PSU IEC mains connector and switch on!
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10.      Updating System Software

This chapter describes how to update the system software.

Topics include:

· Software Versions

· Preparation

· Backup of User Data

· Updating the System

· Creating and Replacing CF Cards

· Using mxUpdater

· Updating Nova73 IO Cards

· Updating DALLIS IO Cards

· Updating RAVENNA-based Nodes

· Final Steps

· System Configuration Modifications
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10.1 Software Versions

Compatibility

All Lawo products use a consistent software release numbering system to indicate compatibility. In each case,
the first three digits of the software versions must match.  This affects mxGUI and AdminHD, as well as other

networked mc2/Nova systems.

Checking the Software Version

You can check the software version of your mc2/Nova system from the System Settings display: select Global ->
System and look at the Product Release Version field.

Software Updates

The latest software for your product is available from the Download-Center at www.lawo.com (after Login).
Information about the software release can be found in the "Release_Notes_X.xx" documentation.

From Version 5.8.2 onwards, the mxUpdater utility (included with mxGUI) should be used to update the system
software. Note that the utility contains only the version which is concurrent with the mxGUI release. Therefore, it
is only possible to update to this version. To update to a different release, or downgrade the system, you will need
to use the "new CF cards" method.

Note that a software update affects only the System Flashcard, and will not alter any of your user data.

Once running Version 5.8 (or later), there can be a mismatch in your configuration if you install an earlier
release than 5.8. Therefore, please contact the Lawo support department if you wish to downgrade your
software version to a release < Version 5.8.

Changing Firmware Revisions

From Version 5.6, all Nova73 IO modules will automatically update to the required firmware (according to their
AdminHD configuration) once they are plugged into the Nova73 frame. This makes it easier than ever to
reconfigure a system, and prevents any mismatch between Control System and IO software revisions.

http://www.lawo.com
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10.2 Preparation

Please read all the topics in this chapter starting from the beginning.

If Compact Flash cards need to be changed, please consider strict ESD protection procedures when touching the
electronic components.

Any loudspeakers and headphones must be disconnected or turned off before starting the update procedure as
noise or other distortion may occur. 

Before updating any mxGUI applications, please refer to the mxGUI chapter of your Operators Manual.

There are some update procedures which are necessary for mc2 systems only. These will be marked with the tag
[mc² series only]. Please skip these instructions when updating a Nova system.

In some instances, there will be a choice of procedures depending on the current and intended versions. These
are explained in each topic.

As a first step, we recommend backing up all user data (including configuration files, productions, snapshots
etc.). This can be done using either mxUpdater (included with mxGUI) or from the File display (via the console
GUI). The mxUpdater method is described next.

After the update, it is mandatory to power cycle all updated components. This means that components cannot be
updated while on-air as there will be a noticeable disruption to audio.
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10.3 Backup of User Data

Prerequisites

To create a backup of the system’s user data, you will need:

· A PC or laptop running Windows or Mac OS.

· A network connection to the Lawo system network (Ethernet). Remember to set up an unused IP address
when connecting the computer to the network.

· Lawo's mxGUI software. The latest mxGUI release can be downloaded from the Lawo website at
www.lawo.com (after Login).

Backup using mxUpdater (included with mxGUI)

The mxUpdater utility can be used to backup and restore all user data on the data CF card. Note that you must
have the mxGUI shared folders configured to use this method.

· Start mxGUI and at the launch window select mxUpdater. The program opens.

· Under "1 - Select Remote System", enter the IP address of the primary control system and click on 
Connect. After a successful connection, you will see some information about the system.

· Under "2 - Backup Data", select Backup. Enter a file name and then start the backup by clicking on
Save.

· Once the backup is complete, you will see the line DETAIL: Backup operation done in the "Log" area.
The backup file is stored on the mxgui computer in the mxgui_config_share -> mxupdater -> backup
folder:

For more details, please see the mxUpdater topic in the mxGUI chapter of your Operators Manual.

http://www.lawo.com
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10.4 System Update Methods

Prerequisites

To update the system, you will need:

· A PC or laptop running Windows or Mac OS.

· A network connection to the Lawo control system (Ethernet). Remember to set up an unused IP address
when connecting the computer to the network.

· Lawo's mxGUI software. The latest mxGUI release can be downloaded from the Lawo website at
www.lawo.com (after Login).

· [optional] - if the current software version is earlier than 5.8.2, then you will need some additional items
to create the CF cards (see below).

Note that the correct system software image files are included in the mxGUI bundle. Therefore, there is no
need to separately download the system software.

Possible Methods

Depending on your current and intended software versions, you will need to use one of the following methods to
update the system:

· mxUpdater (recommended) - from Version 5.8.2 software onwards, the mxUpdater utility can be used
to update the system from an mxGUI computer.

· New CF Cards (< V5.8.2) - if the current version is earlier than 5.8.2, then you MUST update the system
by creating new CF cards. Note that this is not necessary once your system is running V5.8.2 or later.

Each method will now be described in more detail, in reverse order.

http://www.lawo.com
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10.5 Creating and Replacing CF Cards

From Version 5.8.2, all Lawo mc2 and Nova systems run a unified system image, and the system CF card

specifies the type of system (mc256 / mc266 / Nova73 / etc). This means that a new system CF card must be
created from scratch IF the current software version is prior to Version 5.8.2. If your system is already running
Version 5.8.2 or later, then you can skip this section and use the mxUpdater method.

10.5.1 Prerequisites

To create a new CF card, you will need:

· A USB CF card reader.

· New CF cards - please use original Lawo CF cards only.

· A PC or laptop running Windows or Mac OS.

· A virtual machine host for mxGUI (i.e. Oracle VirtualBox).

· The mxGUI virtual appliance (OVA) from the Lawo software bundle.

· A tool to flash the software images to your CF cards. The open source tool ETCHER is recommended. It
is available for Windows, Mac OS and Linux and can be downloaded from https://etcher.io/

10.5.2 Creating New CF Cards

The software upgrade bundle provides an OVA mxGUI image:

· Double click on the OVA file to import it into the VirtualBox environment.

· Connect the CF card reader to the computer.

· Insert the CF card to be created into the CF card reader. Please note that all data on the CF card will be
lost when overwriting the card with the new content.

· Install and boot the mxGUI image.

· Once booted, select Utility Programs and then CFCard Creator. 

· The CFCard Creator will export the requested files into the shared folder “mxgui_config_share”. So, use
the menu options to perform the required transfer:

· When creating a system CF card, the appropriate system type has to be selected. Take care to select
the correct system, as choosing the wrong type will lead to unexpected behaviour!

· When creating a data CF card, the system asks for the IP address configuration. Please enter the
system’s IP address, netmask and gateway (optional). Please note that a data CF card for a redundant
audio router module starts with the same IP settings as the primary module. The necessary IP address
offset (+1 for the right-hand module) will be applied automatically when the system boots.

https://etcher.io/
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10.5.3 Replacing the CF Cards

After creating the new CF cards, they must be inserted into the Router Modules as follows:

· Power down the Nova73 frame.

· Remove the Router Modules MKII and remove the CF cards to be replaced. See Replacing a System or
User Data Flashcard for images.

· Insert the new cards. Please take care when inserting the cards to the corresponding card slots. They will
only fit in one direction. Do not force them in, they should fit smoothly.

· When all cards are installed, the Router Modules MKII can be re-inserted into the Nova73 frame.

· [mc² series only] Power down the console control surface.

· Power up the Nova73 frame.

· [mc² series only] Power up the console control surface.

· The system will cold-start and load a default user configuration. The user data must be restored from the
backup to establish normal system operation (see below).

· [mc² series only] [optional] The console control surface will check for new fader software at the end of
the boot-up. If a change applies, then the software update starts automatically. During this procedure, the
faders and joysticks will move to check the physical boundaries. Please do not obstruct the movement or
touch the faders and joysticks during the calibration.

· Restore your user data by using mxUpdater. The procedure is similar to the backup described earlier,
except for the direction of transfer.

· To read the new configuration (loaded from the user data restore), you must perform another cold start.
Please use mxGUI to set the Prepare Coldstart option in the System Settings display. Or, use the
Prepare Coldstart button on the front of the Router Module (MKII). Then switch the Nova73 frame off and
on.

· As soon as the system has restarted and the configuration has been read correctly, please continue with
the Nova73 IO card update.
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10.6 mxUpdater

If the current software version is already Version 5.8.2 or later, then the system can be updated without replacing
the CF cards.

mxUpdater (included with mxGUI)

From Version 5.8.2 software onwards, the mxUpdater utility can be used to update the system from an mxGUI
computer. 

Note that this utility contains only the software version which is concurrent with the mxGUI release. Therefore, it
is only possible to update to this version. If you wish to update to a different version or downgrade the system,
then you must use the online update method described below.

To perform the update:

· Install the "new" mxGUI version on your computer. (Note that the correct system software image files are
included in the mxGUI bundle.)

· Start mxGUI and at the launch window select mxUpdater. The program opens.

· Under "1 - Select Remote System", enter the IP address of the primary control system and click on 
Connect. After a successful connection, you will see some information about the system.

· Under "3 - Update System", select Update. Confirm the update by clicking on OK. You will now see the
progress of the upload, update and validation steps in the "Log" area. Once the update is complete, a
system reboot is triggered.

· Note that the last few "Log" lines, including ERROR: Could not connect and ERROR: Update failed,
remote aborted, are a result of the reboot. These lines are normal and can be ignored.

· After the reboot, the software update is complete.

· Continue on to the Nova73 IO card update.

For more details, please see the mxUpdater topic in the mxGUI chapter of your Operators Manual.
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10.7 Updating Nova73 IO Cards

From Version 5.6.0 onwards, all Nova73 IO cards will update to the corresponding firmware versions
automatically. Depending on the system configuration, this can take a while (10-15 minutes), and so now might
be good time to have a coffee!

· During the update, the card LEDs will flash quickly. As soon as they return to their normal blink
frequency, the update is finished. 

· [981/61 devices] The automatic update does not apply to RAVENNA-aware IO cards installed before
Version 5.4. See Updating RAVENNA-based nodes.

· Please wait for all Nova73 IO cards to blink synchronously (ACTIVE LED).

· Then continue on to the DALLIS IO update.
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10.8 Updating DALLIS IO Cards

The method which can be used to update a DALLIS depends on its connection type:

RAVENNA DALLIS (Automatic Updates)

From Version 5.6.0.0 onwards, all RAVENNA Net and RAVENNA Link DALLIS will update to the corresponding
firmware versions automatically. 

In this instance, the system checks the installed and "new" firmware versions at start up. If there is a mismatch,
then the update starts automatically. The DALLIS master card is updated first, followed by each IO card. 

Note that the network connections must be made correctly for automatic updates to complete successfully. See 
Automatic Update for details.

MADI DALLIS (Auto Update Script)

For MADI DALLIS (including the 947/22 in MADI mode), then you will need to start the auto update using the
following script:

· In the Nova73 frame, locate the active Router Module MKII (980/33) - if two modules are fitted, then this is
the one with the blinking "ACTIVE" LED; the passive module will have a blinking "STANDBY" LED.

· Open a telnet or ssh connection to the active Router Module's IP address, and login with the username = 
root and password = hong

· In the command line interface, enter mcxsh

· The command line prompt will change to mcxsh> as soon as the connection is established. Note that if
you try to start the mcxsh application on a passive Router Module, then an error message will occur.

· Start a complete update of the DALLIS IO by entering the command mcx_dallis_software_autoupdate
0

· Depending on the system configuration, this can take a while, and so now is a good time for a second
coffee!

· The display will show the progress of any updates and the results will be printed. At the end, you will see
a summary “Automatic update(s) finished” and any errors which have occurred. Please check that there
are 0 errors. If the system has detected any errors, then try starting the update again.

· After the updates are complete, power-cycle each DALLIS frame and make sure that all cards are
blinking synchronously (ACTIVE LED).

· Verify the DALLIS card states using the console GUI's Signal Settings page, AdminHD or the Web
Browser Interface.

Please note:

mcxsh is a command line application interface for the Lawo control system. Only a single instance of this
interface connect to the system, so remember to close the interface with the exit command, or CTRL+C, after the
update.

The "0" at the end of the command line is mandatory and will update all available DALLIS cards in the
configuration starting from the root point. If you wish to narrow the device configuration scan, then addresses can
be appended to the command using their 0-based slot/port numbers - for example: 

· mcx_dallis_software_autoupdate 0 9 will scan all DALLIS ports connected to Nova73 IO Module slot
10.

· mcx_dallis_software_autoupdate 0 9 2 will scan the DALLIS connected to port 3 of Nova73 IO Module
slot 10.

If your system uses both RAVENNA and MADI DALLIS, then wait for the automatic updates to the
RAVENNA DALLIS to complete before starting the auto update script.



mc²56 MKII Technical ManualVersion: 5.14.0/1268/298

10. Updating System Software

10.9 Updating RAVENNA-based Nodes

From Version 5.6.0 onwards, all RAVENNA DALLIS nodes can be configured either as RAVENNA Link or
RAVENNA Net.

Note that a change of configuration from RAVENNA Link to RAVENNA Net will require the installation of
additional hardware (e.g. PTP master clock, RAVENNA-compliant network switch, etc.) as well as a change in
the network topology. This requires proper planning and on-site commissioning, and you should refer to the

"RAVENNA for mc2 User Guide" for more information.

The update method which can be used for RAVENNA-based nodes depends on the currently installed firmware
version. The table below summarises the possibilites:

Original Version

Target Version and Component

5.10 Nova73 RAVENNA Link 5.10 DALLIS + Local IO

(mc56) RAVENNA Link

5.10 Compact IO + Local IO

(mc36)

4.18 – 4.22 manual + barebox manual + barebox N/A

4.24 manual + barebox manual N/A

5.0 manual + barebox manual N/A

5.2 (mc36) automatic manual script based

5.4 automatic manual script based

5.6 automatic automatic automatic

5.8 automatic automatic automatic

· A__line and LCU RAVENNA nodes (supported from 5.8 onwards) will be updated automatically if their
initial version is at least 7.0.0.x.

· Neumann DMI-8 nodes cannot be updated automatically. The minimum required software version is 1-0-
0-0 or later. This software is part of the LAWOs release bundle.

When updating a RAVENNA node to 7.0.0.x or later, any user configuration of PTP settings will be deleted
due to a syntax change in the configuration file. Therefore, you will need to reinstate the appropriate settings
manually via the RAVENNA Web GUI.

The topics which follow describe each method.
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10.9.1 Automatic Update

An automatic update will be started on the startup of each node. In this instance, the system checks the installed
and "new" firmware versions. If there is a mismatch, then the update starts automatically.

Please note, that an automatic update cannot be run in double frequency mode (i.e. 88.2 kHz or 96 kHz). If you
use a double frequency setup, please switch to 44.1 kHz or 48 kHz temporarily to perform the updates.

The figure below shows the network topology required to support automatic updates and RAVENNA Net operation
of the Nova73 IO Modules (shown by the dotted turquoise path). Note that this topology is also required to update
any DALLIS or A__line RAVENNA nodes, as the network path from the Nova73 Router Module, which acts as an
update server, is made via the individual IO Modules (shown by the dotted orange paths).

Network Topology

As you can see in the drawing, the blue and green clouds (Control System and Service Networks) run from the
same Ethernet port of the Nova73 Router Module (ETHERNET B). This means that both networks must connect
to the same Ethernet network switch in order to work properly. 

In the current release, it is not possible to use separate VLANs for the respective networks.
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10.9.2 Script-based Update

Updating the mc236 Local IO or Compact IO devices can require a script-based approach which has to be used
once – after the update to 5.6, all further updates will be automatic. 

For the script-based update please follow the steps below:

· Open a telnet or ssh connection to the mc236 control system IP address, and login with username = root
and password = hong

· In the command line interface, enter updateImxIos LocalIO to update the internal Local IO device.

· If a Compact IO device is attached to one of the external RAVENNA ports,then use the following syntax:

o updateImxIos CompactIO 6 1 if the Compact IO is attached to RAVENNA port 1

o updateImxIos CompactIO 6 2 if the Compact IO is attached to RAVENNA port 2

o updateImxIos CompactIO 6 3 if the Compact IO is attached to RAVENNA port 3
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10.9.3 Manual Update

To perform a manual update, please follow the steps below:

· If the table points out that a manual update is needed, usually the network topology is not yet ready for
automatic updates. If so, please update the components manually first, then change the topology to
prepare for future automatic updates.

· RAVENNA-based nodes usually provide a control port which will be used for the software update of the
RAVENNA subsystem. This control port might already be connected to a network switch in order to
create a service port network. For future use, such a dedicated service port network is not necessary
anymore as the service network will be routed automatically through the Nova73 IO cards. Anyway, it is
still possible to use a dedicated service port network if it is connected to the Router card’s second NIC as
depicted in the Network Topology figure.

· The IP address of the control port is listed in the system’s http service site http://<system IP
address>/content/ networkinfo.shtml

· If the control port is accessible via a separate network, select an appropriate (unused) IP address for your
PC’s network interface, connect the PC to this network, open a telnet connection to the control port’s IP
address, login with username root and password hong

· If the control port is not accessible via network, the PC has to be connected directly to the control port. 

· The software update image can be found in the directory /device_os on the system CF card of the Nova73
Router module. Currently the following variants are available

Card Variant Update Path Subfolder

936/35 LocalIO /device_os/936_35_Local_IO

947/21 RAVENNA Mastercard /device_os/947_21_DALLIS_Mastercard

947/22 RAVENNA & MADI Mastercard /device_os/947_22_DALLIS_Mastercard

981/61 RAVENNA /device_os/981_61_Nova73_RAVENNA_IO_Card

985/50 CompactIO /device_os/985_50_Compact_IO

· Please download the appropriate.tar.gz file for the RAVENNA node to be upgraded

· Please start your FTP client software and connect to the control port’s IP address using username root
and password hong

· Please upload the .tar.gz image file to the /data/update subfolder of the RAVENNA aware device.

· In the telnet command line interface, enter updateSystem

· If multiple software archives are found in /data/update, the system asks for a file to use. Please select the
correct update file and follow the instructions on the screen.

· In the unlikely case of a currently installed software version that is too old to support upgrades with the
provided images, the system will print an error message complaining about a missing ubifs image. Please
contact the Lawo support department in this instance.

· The device will be updated and rebooted automatically.
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10.10 Power Cycle All Updated Components

If you have not already done so, now is the time to power-cycle all updated components to make sure that the
system works correctly after a power-cycle.

· Please load your favourite snapshot or production and check the audio functionality.

· Do a power-cycle and check the audio functionality again.

· Enjoy the new release!
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10.11 System Configuration Modifications

10.11.1 File Structure Changes as of Release 5.4

Due to major changes in the system images to achieve unified system upgrades, some modifications of the file
structure have been necessary. This also implies that former configurations have to be transferred in order to
make them work again. The configuration files at the new locations will be created automatically (if not yet
available) with default settings that are commented out and have to be adjusted appropriately.

NTP Configuration

The NTP server configuration in /data/config/ntp-config has been moved to /data/config/sysconfig/time-config.
Additionally, a TIMEZONE parameter can be specified as of Release 5.4. If there is an NTP configuration for your
system, please edit the server settings in the new location.

SNMP Configuration

The SNMP server configuration in /data/config/snmpd.conf has been moved to /data/config/sysconfig/snmpd.conf.
Please transfer your settings to the new location.

Syslog Configuration

The configuration file for the syslog process in /data/config/logfile has been moved
to /data/config/sysconfig/syslog. As of Release 5.4 it is possible to define a syslog server with the configuration
option LOGSERVER_IP=<IP>.

pre_config.tcl, post_config.tcl

The post_config.tcl file will be created with default (commented out) contents if not already existing. All entries
that were formerly specified in pre_config.tcl can now be moved to post_config.tcl. pre_config.tcl will be
discontinued in future releases.

10.11.2 File Structure Changes as of Release 5.6

Service Network Configuration

The system’s service network which defaults to 192.168.110.0/24 will be configured in /data/config/sysconfig/ip-
address as of Release 5.6. If you open the ip-address file in a text editor, you will find a template for the service
network configuration where the comment marker (#) has to be removed in order to enable the configuration. This
is needed only if the default cannot be used for some reason (e.g. in DSN setups). The former configuration in
post_config.tcl (if any) has to be removed and is not evaluated anymore. 

10.11.3 File Structure Changes as of Release 5.10.2

DSP Presets

From Version 5.10.2, you cannot create sub folders for DSP presets. Therefore, if you have presets stored in a
sub folder from an earlier version, you will need to export them to USB and import them back into a single level
folder structure in the new release. This can be handled from the File display (on the console) or File Transfer
display (on mxGUI).
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11.      Networking Multiple Systems

This chapter describes the options for networking more than one console or router.

Topics include:

· Networking IO Resources

· IP-SHARE
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11.1 Networking IO Resources

The mc²56 MKII is just one member of the mc2/Nova family of products which share the same hardware and
software. The Nova73 and DALLIS system is available in its own right as a stand alone routing matrix. Multiple
systems can be networked to provide sharing of sources and destinations:

In the example above, mics are physically connected, via a DALLIS, to each system. Signals are transferred
between systems via ‘Netlinks’, providing the ability to share any mic input. 

Each ‘Netlink’ is an audio connection which can be MADI, RAVENNA, AES or analog audio, and signals are
dynamically allocated as each operator makes routes from the Signal List display.

Any number of sources can be distributed depending on the physical limitations of your network. Please consult
your system specification for details.

On any system within the network, you can view which sources are distributed from the % column on the

Signal List display:

·  indicates that a source is connected locally to this console, and is ‘Shared’ (made available) to
other consoles within the network.

·  indicates that a source is ‘Imported’. In other words, it is not connected locally to this console.

All Lawo products use a consistent software release numbering system to indicate compatibility. In each
case, the first three digits of the software versions must match. 

So, for example, a mc266 console running version 5.10.0.2 can be networked to another mc2/Nova system

running 5.10.0.x.  You can check the software version of your mc2 system from the Global Options in the
System Settings display.

Note that a warning icon will appear in the Status Bar if the networked connection fails.
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11.2 IP-SHARE

From Version 5.10.0 onwards, all mc2 systems support a feature known as IP-SHARETM. This can be configured
within a RAVENNA (IP Layer 3) network and allows up to eight consoles to set an independent gain value for the
same DALLIS mic/line input. The DALLIS Mastercard communicates with all networked consoles and the IP-

SHARETM algorithm sets the optimum analog gain for all consoles. Furthermore, the algorithm ensures that the
corresponding gain compensation is applied to the digital gain stages of all consoles, when the analog gain of the
preamp is being adjusted:

IP-SHARETM is only available for RAVENNA Net and for DALLIS fitted with 941/53 or 941/55 Mic/Line cards.
(Other Mic/Line cards and IO systems do not support the feature.)

Up to eight consoles can have access to the same gain parameter (using their own "virtual" gain values).

Each console MUST use a separate RAVENNA Service IP Network range.

Only the "master" console can access the DALLIS outputs (and any inputs which are not shared).

When using RAVENNA port redundancy with a Gain Compensation DALLIS, there is no automatic
redundancy takeover. Instead, you will need to switch to the redundant RAVENNA port "manually" (e.g via a
Central User Button or external control system).

Gain compensation is enabled for qualifying inputs using AdminHD. Once gain compensation is enabled, the
input cannot be switched from mic to line, and will operate permanently in mic mode.

Once configured, each console can request an input gain value. The DALLIS receives all the requested gains,
selects the most suitable and adjusts the analog gain stage accordingly (usually to the smallest requested value).
This is then compensated by the digital gain stage of the DALLIS (back to 0dB). Each console then adds its own
gain, automatically, to return to the originally requested gain value. Note that this is handled by the IO DSP which
means that IO DSP cannot be used for other applications when Gain Compensation is enabled.

For more details on configuration, please see the "RAVENNA for mc2/Nova User Guide".
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12.      Installing a Mirror Desk

This chapter describes how to install a mirror desk.

Topics include:

· Prerequisites

· Installation & Wiring
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12.1 Prerequisites

From Version 5.4 onwards, two identical control surfaces can connect to the same Nova73 in order to mirror each
other. For example, you can install one surface in an auditorium and the other in a separate control room to
facilitate mixing from two different locations.

Note that:

· The two control surfaces MUST be from the same console family, so either 2 x mc256 OR 2 x mc266 OR

2 x mc296.

· Different frame sizes are possible, but the position of the "main faders" must be identical in both surfaces.

· The Bay Server Rotary Switches for the Channel and Central GUI of the "mirror" desk must be properly
configured - see next page.

· The SCREEN CONTROL panel soft keys will not work on the "mirror" desk.

· Windows Remote Desktop connections will only appear on the main desk. Therefore, it is recommended
to use a VNC remote connection instead.
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12.2 Installation & Wiring

The two control surfaces should be installed in the usual manner. 

To cable the surfaces, connect the main desk to the ETHERNET A port(s) of the Nova73 Router Module.

Then connect the main desk to the mirror desk using the Extension port as shown below:

Bay Server Rotary Switches 

Each channel and central GUI bay is supported by an Ethernet Bay Server. The Bay Server has a rotary switch
with two settings:

· Function - determines whether the Bay Server supports a channel or central GUI bay.

· Address – determines the Bay Server index, counted from left to right across the frame starting at 0. 

On the mirror desk, the Function must be increased by a value of 4, and so you should set the switches as
follows:

Bay Server Location Function (Main Desk) Function (Mirror Desk) Address

Central GUI 8 C 0

Channel Bay 0 4 0, 2, 4, etc.

Note that for channel bays, address 0 is the left-most bay.

For details on how to change the settings, please see Adjusting the Bay Server Rotary Switches.
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13.      Trouble-shooting

This chapter includes a series of typical problems and tips to help you fault find the system. 

Topics include:

· Boot-up Issues

· Control Surface Issues

· Network Communication Issues

· mxGUI Issues

For further assistance, please contact your local Lawo representative or email support@lawo.com.

mailto:support@lawo.com
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13.1 Boot-up Issues

13.1.1 The system will not boot or does not boot correctly

1. Power off the Nova73 and wait for the system to shutdown.

The system has completed its shutdown when the blue LED of the trackball is off.

2. Power on to try a warm start.

3. If this is unsuccessful perform a cold start.

If the system now boots correctly, then your warm start user data is corrupt. Check your production data by
loading a production. If this is the cause of the problem, perform another cold start and try a different production. If
there is a problem with all production data, then you may need to replace the User Data Flashcard.

4. If this is still unsuccessful, then you should try replacing the System Data Flashcard with a backup copy.

13.1.2 The system boots up but I have no audio

1. Check the System Settings display to see if there any reported errors.

If an IO module or remote IO device/card is shown in red, then there is a problem with the connection or the
hardware.

2. Check the connections to the remote IO device/card.

Are the fibres reversed?

3. Check the indicators on the Nova73 and remote IO device/card.

The ACTIVE LEDs on all Nova73 modules and DALLIS cards should blink in time with each other at around 1Hz.
This shows that the card is synchronous to the rest of the system. If an LED is out of sync, then check that the
card is fitted correctly. If the symptom persists, replace the plug-in card.

4. If everything still looks ok, try reloading the DSP configuration from the DSP Configurations display.
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13.2 Control Surface Issues

13.2.1 The complete control surface is not responding

1. Check the Ethernet A connections between the control surface and Nova73 Router Module.

2. If main and redundant Router Modules are fitted to the Nova73, try forcing a manual takeover to the
redundant module.

3. If not, power off the Nova73 and wait for the system to shutdown. And power on to try a warm start.

13.2.2 One of the control surface panels is not working

1. Try restarting the Ethernet Bay Server.

2. Carefully remove the panel, and check the connections.

3. Try disconnecting and reconnecting the USB and power connectors to the panel.

Try this a few times to see if the panel will boot. If not, then the panel may be faulty.

13.2.3 The graphics on the console displays appear to freeze

This can occur if the load on the CPU exceeds 95% - for example, during a production load. Audio processing is
unaffected, and therefore the behaviour should be ignored. Once the production has loaded, and the CPU returns
to normal levels of operation, the problem should resolve.

13.2.4 The graphics on one of the console displays freezes or looks odd

This can occur if a Bay Server looses its Ethernet connection to the Control System. 

1. Try restarting the Ethernet Bay Server.

If the problem persists, then the display or Bay Server may be faulty.

13.2.5 The USB ports are not working

The USB ports in the control surface have a ganged short circuit protection. This means that a short circuit at one
of the ports will shut down all ports together.

To reset the short circuit protection:

1. Power the control surface off and on in order to power cycle the internal USB hub.

If the problem persists, then the USB hub may be faulty.

13.2.6 The console keyboard or trackball are not working

This can occur if the USB short circuit protection has been triggered (as if one of the USB ports has a short
circuit, then all ports will shut down together).

1. First, check that the keyboard is installed correctly.

2. Then check if the other USB ports are powered.

3. If not, power the control surface off and on in order to power cycle the internal USB hub.

If the problem persists, then the USB hub may be faulty.
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13.3 Network Communication Issues

13.3.1 The network connection to the control system is not working

If you cannot establish network communication with the mc2/Nova control system:

1. Check the network connections from your device to the Lawo network, and from the Lawo network to the

mc2/Nova system.

2. Check the TCP/IP settings on the connecting device's Network Interface Card.

3. If applicable, check that the software you are running is compatible with the mc2 system. When
connecting from mxGUI or AdminHD, the first three digits of the software versions must match.

4. Try running a PING test:

· If the ping test fails, then there is something wrong with your network configuration.

· If the ping test is successful, then the network communication is working. If you still cannot connect to

the mc2/Nova system, then something may be blocking the connection. Try disabling any firewall and/or
antivirus software on the connecting device.



mc²56 MKII Technical ManualVersion: 5.14.0/1284/298

13. Trouble-shooting

13.4 mxGUI Issues

13.4.1 mxGUI is not booting up

If, when you start mxGUI, you see only a black screen and not the trackball shown below, then you should
check the BIOS setup of your PC.

1. Enter the BIOS system of your computer - the exact method varies depending on the PC manufacturer,
so please refer to your computer's manual for details.

2. Search for a checkbox called "VTX" or "Virtual Technology" - on most computers, it can be found under
security or something similar. This option MUST be enabled.

3. Then restart mxGUI, and you should see the blue trackball screen appear:
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14.      Appendices

This chapter includes further information which you may find useful.

Topics include:

· Part Numbers

· Control System Locations

· Default TCP/IP Settings

· GNU Public License

· DALLIS IO Card Compatibility

· Local I/O Wiring

· Connector Pin-Outs
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14.1 Part Numbers

System Component Part Number

mc256 MKII Frame 16C 959/09

16 + 16C 959/10

16 + 16C + 16 959/11

32 + 16C + 16 959/12

32 + 16C + 32 959/13

Extender (16-fader) 959/22

Script Tray 959/41

Control Surface Modules Fader Panel 958/10

Fader Panel (dual faders) 958/11

Fader Panel 4FC (extra Free Controls) 958/12

Central Panel 958/20

Channel Display                   958/13

Nova73 Nova73 HD Frame (10RU) 980/02

Nova73 HD PSUs (1000W, Blanking Plate) 980/25, 980/21

Nova73 HD AES3 Rear Connector Panels
(D-type, BNC)

980/14, 980/15

Nova73 Compact Frame (7RU) 980/06

Nova73 Compact PSUs (500W) 980/27

for Router, DSP & IO modules, see Nova73 Plug-in Modules

DALLIS IO Frame 3RU 940/30

Frame 6RU 940/60

for master boards & IO cards, see DALLIS Interfaces

Compact IO Stagebox Compact IO 5RU (fully fitted) 985/50

14.1.1 Data Sheets

Further technical information can be found in the product data sheets. The system part numbers will help you
locate the data sheets for the main system components.

All documentation is available from the Download-Center at www.lawo.com (after Login).

http://www.lawo.com
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14.2 Control System Locations

The table below shows the location of the control system for different mc2 and Nova products. 

Note that the Router Module MKII (980/33) control system provides two network ports: ETHERNET A connects

to the mc2 control surface; ETHERNET B connects to the Lawo system network.

System Router Module Control System Location System Network Port

mc² 36 980/33 Intel Control Surface ETHERNET B

mc² 56 MKII 980/33 Intel Nova73 ETHERNET B

mc² 66 MKII 980/33 Intel Nova73 ETHERNET B

mc² 96 980/33 Intel Nova73 ETHERNET B

Nova73 HD MKII 980/33 Intel Nova73 ETHERNET B

Nova73 Compact MKII 980/33 Intel Nova73 Compact ETHERNET B

mc² Micro Core 980/33 Intel Micro Core ETHERNET B

Nova37 980/33 Intel Nova37 ETHERNET B
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14.3 Default TCP/IP Settings

Default IP Addresses

The default IP addresses, for different Lawo product control systems, are:

· mc236 = 192.168.102.36

· mc256 = 192.168.102.56

· mc266 = 192.168.102.65

· mc296 = 192.168.102.96

· Nova73 (HD & Compact) = 192.168.102.1

· mc2 Micro Core = 192.168.102.136

· Nova37 = 192.168.102.137

· mxGUI (local control system) = 192.168.56.101

You can check the IP address of your control system from the System Settings display under Global ->
System -> IP Address Primary.

Subnet Mask

For all products, the default Subnet Mask = 255.255.255.0

Other IP Addresses

The table below lists the other IP addresses used within a mc²56 MKII installation:

Device Port IP Address Notes

Router Module 980/33 Slot
A

ETHERNET A
(internal network)

192.168.105.1 Fixed address.

Router Module 980/33 Slot
A

ETHERNET B
(external network)

192.168.102.xxx Default address of the control system
(as listed above).

Router Module 980/33 Slot
B (optional)

ETHERNET A
(internal network)

192.168.106.1 Fixed address.

Router Module 980/33 Slot
B (optional)

ETHERNET B
(external network)

192.168.102.xxx This address is always one digit
higher than that of the main control
system.

Ethernet Switch (optional) - 192.168.102.250 Default address.

ISDN Dialup Router
(optional)

- 192.168.102.200 Default address.

We recommend keeping the default IP addresses, where possible, as this will simplify remote maintenance.

The control system address (ETHERNET B) can be changed in a file called "ip-address" located on the data
card (in the /data/config folder).
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14.4 GNU Public License

The GPL source code contained in this product is available from the Lawo support department. If you would like a
copy of the GPL source code in this product on a CD, please send €9,90 to Lawo for the cost of preparing and
mailing the CD to you.

The Web Browser Interface can be used to view a list of all open source licenses and source code patch files
used in this product.
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14.5 DALLIS IO Card Compatibility

The following table shows which DALLIS IO Cards are supported by the 947/21 and 947/22 DALLIS master
boards.

Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_941_02 // Analog in 4 Mono traf.sym. SubD

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_04 // Analog in 4 Mono traf.sym. SubD

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_06 // Analog in 4 Mono traf.sym. SubD

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_12 // Analog in 4 Mono traf.sym. XLR 

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_14 // Analog in 4 Mono traf.sym. XLR 

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_16 // Analog in 4 Mono traf.sym. XLR 

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_941_51 // MicLine in 8 Mono elec.sym. SubD

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_52 // MicLine in 4 Mono traf.sym. SubD

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_53 // MicLine in 8 Mono traf.sym. SubD

variabel

x x x x x

DALLISSLOTTYPE_941_55 // new  941_51 MicLine in 8 Mono

elec.sym. SubD 15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_62 // MicLine in 4 Mono elec.sym. XLR 

15dBu->0dB FS

x x x x x

DALLISSLOTTYPE_941_83 // Analog in/out 2*8 Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_941_84 // Analog in/--- 1*8 Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_941_85 // Analog in/out 2*8Mono elec.sym.

SubD variable, Replacement for 941_83

x x x x x

DALLISSLOTTYPE_941_86 // Analog in/--- 1*8Mono elec.sym.

SubD variable, Replacement for 941_84

x x x x x

DALLISSLOTTYPE_942_02 // Analog out 4 Mono traf.sym. SubD

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_04 // Analog out 4 Mono traf.sym. SubD

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_06 // Analog out 4 Mono traf.sym. SubD

18dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_12 // Analog out 4 Mono traf.sym. XLR 

15dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_14 // Analog out 4 Mono traf.sym. XLR 

24dBu->0dB FS

x - x x -

DALLISSLOTTYPE_942_16 // Analog out 4 Mono traf.sym. XLR 

18dBu->0dB FS

x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_942_61 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA

x x x x x

DALLISSLOTTYPE_942_61_Ext // Monitor out 4 Stereo asym.SubD

HeadphoneAmp. w ith Extender

x x x x x

DALLISSLOTTYPE_942_84 // Analog --/out 1*8Mono elec.sym.

SubD variable

x - x x -

DALLISSLOTTYPE_942_86 // Analog --/out 1*8Mono elec.sym.

SubD variable, Replacement for 942_84

x x x x x

DALLISSLOTTYPE_943_01 // AES  in 4 Stereo in SRC SubD

HighZ/Thru, Replacement for 943_84

- - - - -

DALLISSLOTTYPE_943_02 // AES in 4 Stereo in SRC SubD - - - - -

DALLISSLOTTYPE_943_03 // AES in 4 Stereo in SRC SubD,

Replacement for 943_02

x x x x x

DALLISSLOTTYPE_943_12 // AES in 4 Stereo in SRC XLR - - - - -

DALLISSLOTTYPE_943_13 // AES in 4 Stereo in SRC XLR,

Replacement for 943_12

x - x x -

DALLISSLOTTYPE_943_52 // AES in/out 4 Stereo only In SRC SubD - x - - x

DALLISSLOTTYPE_943_53 // AES in/out 4 Stereo only In SRC

SubD, Replacement for 943_52

x x x x x

DALLISSLOTTYPE_943_54 // AES in/out 4 Stereo in/out SRC

44.1/48/96 kHz SubD

- x - - x

DALLISSLOTTYPE_943_55 // AES in/out 4 Stereo in/out SRC

SubD, Replacement for 943_54

x x x x x

DALLISSLOTTYPE_943_72 // AES in/out 4 Stereo in SRC BNC - - - - -

DALLISSLOTTYPE_943_73 // AES in/out 4 Stereo in SRC BNC,

Replacement for 943_72

x x x x x

DALLISSLOTTYPE_943_74 // AES in/out 4 Stereo in/out SRC BNC - - - - -

DALLISSLOTTYPE_943_75 // AES in/out 4 Stereo in/out SRC BNC,

Replacement for 943_74

x x x x x

DALLISSLOTTYPE_943_81 // DALLIS_INTERCOM, no SRC x x x x x

DALLISSLOTTYPE_943_82 // DALLIS_INTERCOM, no SRC,

Replacement for 943_81

x x x x x

DALLISSLOTTYPE_943_84 // AES  in 4 Stereo in SRC SubD

HighZ/Thru

- - - - -

DALLISSLOTTYPE_943_85 // AES  in 4 Stereo in SRC SubD

HighZ/Thru, Replacement for 943_84

x - x x -

DALLISSLOTTYPE_944_01 // AES out 4 Stereo no SRC SubD - - - - -

DALLISSLOTTYPE_944_02 // AES out 4 Stereo no SRC SubD,

Replacement for 944_01

x x x x x

DALLISSLOTTYPE_944_11 // AES out 4 Stereo no SRC XLR - - - - -

DALLISSLOTTYPE_944_12 // AES out 4 Stereo no SRC XLR,

Replacement for 944_11

x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_945_01 // GPIO InOptos OutRelais SubD x x x x x

DALLISSLOTTYPE_945_05 // GPIO InOptos OutOptos VCA SubD x x x x x

DALLISSLOTTYPE_945_05_Ext // GPIO InOptos OutOptos VCA

SubD m w ith Extender

x x x x x

DALLISSLOTTYPE_945_21 // Serial Routing 4*RS422 RJ45 - - - - -

DALLISSLOTTYPE_945_22 // Serial Routing x x x x x

DALLISSLOTTYPE_945_61 // Opto-Sw itch / BNC-Converter x x x x x

DALLISSLOTTYPE_946_01 // SDI SD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_02 // SDI SD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_03 // SDI SD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_04 // SDI SD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (non-existing, w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_05 // SDI HD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_06 // SDI HD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_07 // SDI HD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_08 // SDI HD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ithout Video Generator)

- - - - -

DALLISSLOTTYPE_946_09 // SDI SD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_10 // SDI SD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_11 // SDI SD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_12 // SDI SD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ith    Video Generator)

- - - - -

DALLISSLOTTYPE_946_13 // SDI HD Embedder/De-Embedder 4

Stereo In 4 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_14 // SDI HD Embedder/De-Embedder 2

Stereo In 2 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_15 // SDI HD Embedder/De-Embedder 4

Stereo In 0 Stereo Out (w ith Video Generator)

- - - - -

DALLISSLOTTYPE_946_16 // SDI HD Embedder/De-Embedder 0

Stereo In 4 Stereo Out (w ith Video Generator)

x - x x -

DALLISSLOTTYPE_946_17 // 946/17 3G SDI Inserter (16 channels) x - x x -

DALLISSLOTTYPE_946_18 // 946/17 3G SDI Inserter (8 channels) x - x x -
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

DALLISSLOTTYPE_946_19 // 946/17 3G SDI De-Embedder (16

channels)

x - x x -

DALLISSLOTTYPE_946_20 // 946/17 3G SDI De-Embedder (8

channels)

x - x x -

DALLISSLOTTYPE_946_21 // 946/17 3G SDI Embedder (16

channels)

x - x x -

DALLISSLOTTYPE_946_22 // 946/17 3G SDI Embedder (8

channels)

x - x x -

DALLISSLOTTYPE_946_31_8_8 // ADAT De-/Encoder  8 In, 8 Out x - x x -

DALLISSLOTTYPE_946_31_4_4 // ADAT De-/Encoder  4 In, 4 Out x - x x -

DALLISSLOTTYPE_946_41 // 946/41 Ravenna Evalboard (8

channels)

x x x x x

DALLISSLOTTYPE_946_42 // 946/42 Ravenna (64 channels) x x x x x

DALLISSLOTTYPE_947_10 // Phantom Pow er card x x x x x

DALLISSLOTTYPE_947_41 // SumMx fixed - - - - -

DALLISSLOTTYPE_947_42 // SumMx Matrix - - - - -

DALLISSLOTTYPE_947_42G // Sum Matrix, 6 SumOutputs und 2

Generators

- - - - -

DALLISMASTERTYPE_947_05 // Mastercard MADI f ibre - - - -

DALLISMASTERTYPE_947_07 // Mastercard MADI f ibre +

redundant f ibre

- - - -

DALLISMASTERTYPE_947_15 // Mastercard MADI SMF - - - -

DALLISMASTERTYPE_947_21 // Mastercard Ravenna x x x -

DALLISMASTERTYPE_947_22 // Mastercard MADI, based on

947_21

- - x x

LOCALIOMASTERTYPE_958_68 // Mastercard RAVENNA (Identical

to 947_21)

x x - - -

LOCALIOMASTERTYPE_958_67 MADI // Mastercard MADI f ibre

(Identical to 947_22)

- - x - -

LOCALIOMASTERTYPE_958_67 RA-Link // Mastercard MADI f ibre

(Identical to 947_22)

- - - x -

LOCALIOMASTERTYPE_958_67 RAV-net // Mastercard MADI f ibre

(Identical to 947_22)

- - - - x

LOCALIOSLOTTYPE_958_60 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA (Identical to 941_85)

x x x x x
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Card Type 947/21 

RA-Link

947/21 

RAV-net

947/22 

MADI

947/22 

RA-Link

947/22 

RAV-net

LOCALIOSLOTTYPE_958_60B // Monitor out 4 Stereo asym.  XLR 

HeadphoneAmp. integrated VCA (Identical to 941_85)

x x x x x

LOCALIOSLOTTYPE_958_61 // AES in/out 4 Stereo only InSRC

44.1/48/96 kHz SubD (Identical to 943_53)

x x x x x

LOCALIOSLOTTYPE_958_61B // AES in/out 4 Stereo only InSRC

44.1/48/96 kHz XLR (Identical to 943_53)

x x x x x

LOCALIOSLOTTYPE_958_62 // Monitor out 4 Stereo asym.  SubD

HeadphoneAmp. integrated VCA (Identical to 942_61)

x x x x x

LOCALIOSLOTTYPE_958_63 // GPIO InOptos OutRelais SubD

(Identical to 945_01)

x x x x x
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14.6 Local IO Wiring

Double-click on the following links to open the wiring information for the local IO board (as a pdf):

· Audio & GPIO Overview

· Connector Locations & Pin-outs

· Analogue Audio Wiring

· AES3 & GPIO Wiring

14.6.1 Local IO Jumper Switch Positions

There are four jumper switches on the local IO connector board, which control two settings:

· JP 3,4 - set the connection to the Line input 16 A-D converter. This can be taken from:

o an "internal talkback mic preamp" (set by JP 1,2).

o the LINE IN 16 connection from the rear panel. 

· JP 1,2 - set the "internal talkback mic preamp" to:

o the integrated talkback mic preamp (fitted as standard).

o the talkback mic preamp fitted to the optional 962/16 INTERCOM user panel.

Note that the JP 1,2 switch positions affect both the connection to the Line input 16 A-D converter, and the line
level talkback output available via the TBK connector.

The factory default positions, shown above, support talkback via the integrated talkback mic preamp. For more
details on the 962/16 INTERCOM user panel, please refer to the panel's data sheet.

You will need to adjust the jumper switches if:

· the 962/16 INTERCOM user panel is fitted. Move JP 1,2 to connect talkback from the INTERCOM panel's
talkback mic preamp.

· you are using an external talkback source, and wish to "free up" Line input 16 for another application.
Move JP 3,4 to connect Line input 16 from the LINE IN 9-16 connector.






959_09 to 13 Audio and GPIO.pdf






959_09 to 13_Audio wiring_Page1.pdf






959_09 to 13_Audio wiring_Page2.pdf






959_09 to 13_Audio wiring_Page3.pdf
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14.6.2 Adjusting the Local IO Jumper Switch Positions

To adjust the Local IO jumper switch positions:

1. Remove the Central GUI's TFT display, as described earlier, to gain access to the local IO connector
board:

The following reference diagram can be found on the cable duct to the right of the local IO board (beneath the
central panel):

2. Locate the correct pair of jumper switches: either 3 & 4 (JP 3,4) or 1 & 2 (JP 1,2) - the locations and
default positions are shown above and below:

Jumpers 3 & 4 (adjust Line In 16) Jumpers 1 & 2 (adjust the TBK source)

3. In each case, take care to move BOTH jumpers to change a setting:

· Jumpers 3 & 4 = position 1, 2: Line input 16 comes the LINE IN 9-16 connector.

· Jumpers 3 & 4 = position 2, 3: Line input 16 comes from the talkback source (the default setting).

· Jumpers 1 & 2 = position 1, 2: Internal talkback comes from the optional 962/16 talkback mic preamp.

· Jumpers 1 & 2 = position 2, 3: Internal talkback comes from the standard talkback mic preamp. 
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14.7 Connector Pin-Outs

14.7.1 Nova73 AES3 Rear Connector Panels

The Nova73 HD supports two types of AES3 rear connector panel: the 980/14 (D-type) and 980/15 (BNC). Pin-
outs for the Nova73 Compact AES3 rear connectors are identical to the 980/14.

980/14 Connector Panel D-type

· Outputs: 4 plugs D-type 25-pin, each with 8 balanced contacts 110 Ω

· Inputs: 4 plug sockets D-type 25-pin, each with 8 balanced contacts 110 Ω
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980/15 Connector Panel BNC

· Outputs: 32 BNC connector, unbalanced contacts 75 Ω

· Inputs: 32 BNC connector, unbalanced contacts 75 Ω
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